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Tutorials 
 

I - Basic Vision Operations 
 

A - Overview 
 

Please note that many of the Figures throughout these tutorials may appear slightly differ-
ent from the windows that appear to you within Vision as you proceed through the tutorial. 
The software that you are working with changes rapidly and the help files often lag behind 
these changes. The help files will be updated as quickly and frequently as possible. In the 
meantime, differences between figures and actual windows will not be significant enough to 
affect your use of the tutorial. 
  
A.1: Discussion  
 
This tutorial will take you through a variety of basic Vision functions. The training covers Qui-
kLook measurements, simple DataSet operations, data plotting and exporting, Customized Tests, 
program control, Filter Tasks and many of the Task-specific features and operations. More ad-
vanced Task control and Test Definition design are covered in Tutorial II and beyond. During the 
progress of this tutorial, you will be creating and working with DataSets and Customized Tests. 
As you create and modify these, you will be duplicating entities provided with Vision that are 
available for your review as training proceeds. 
 
The help pages are in a constant process of being extended and updated to the latest release of 
the program. These tutorials are updated under Vision version 5.12.10. Note that, as you will find 
as you work through these tutorials, Vision is a framework that provides services to semi-
independent programs, loaded by Vision at run time, and known as Tasks. Each Task will always 
take on the first and second Vision program version number. However, as independent entities, 
the Tasks will each have their own version number. 5.12.4 for one Task and 5.12.6 for another, 
for example. Note, too, that as the figures in the tutorials are updated, newer versions of both Vi-
sion and the Tasks will be released. As you proceed, some later figures may be much older than 
5.12.x and the version of Vision that you are running may be much later. 
 
Throughout these tutorials measurements on the internal reference test elements are specified. 
Most Precision testers are equipped three high-precision test elements: a 1.0 nF capacitor, a 2.5 
M-Ω resistor and an RTI 4/20/80 PNZT ferroelectric sample pair. (The Precision SC and RT66B 
testers offer no internal reference elements. The original Precision LC does not have an internal 
reference ferroelectric.) These samples can be switched into the signal path, in software, in paral-
lel with the testers external DRIVE and RETURN ports. Any enabled internal elements will be 
measured in parallel with any attached samples and their responses will be additive components 
in the overall response. The tutorials use the internal elements to allow demonstrations that will 
be consistent over all tester installations. However, in some figures and/or DataSets, the sample 
data may be take on a 2700 Å, 100 µm X 100 µm 4/20/80 PNZT sample measured at up to 15.0-
Volts. (Such samples are available from Radiant Technologies, Inc.) The user should feel free to 
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substitute his or her own samples in place of the internal reference component(s). If the internal 
components are used during training, no sample should be connected to the tester front or rear 
panel DRIVE and RETURN ports. If the customer's sample is to be used, connect the sample to 
the tester DRIVE and RETURN ports and ensure that the internal test elements are disabled in 
software when measuring. 
 
A.2: Connecting your Sample  
 
Should you wish to apply the lessons of these tutorials to your own, externally, connected sam-
ple, Figure A.2.1 shows a simple connection to a linear capacitor sample using the minigrabbers 
provided with the tester. The DRIVE BNC provides a stimulus voltage through the center pin. 
The RETURN BNC integrates charge from the sample, captured at zero volts, through its center 
pins. The center pins are connected to the RED minigrabber leads. These, in turn, are attached to 
opposite electrodes of the sample under test. The outer sheaths of the BNC connectors are at the 
same electrical potential as the tester ground. These are connected to the BLACK leads of the 
minigrabbers. To help strengthen the ground, these connectors are hooked together. In providing 
any other cabling, ensure that the center pins are used to provide the signal path. If you are con-
necting your own sample to DRIVE and RETURN you would not normally enable any internal 
reference elements. 

 

  
Figure A.2.1 - Connecting a Linear Capacitor Using Minigrabbers.  

 
Good luck in your training and your research. Please do not hesitate to contact Radiant Technol-
ogies with any questions, difficulties or suggestions. 
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B - QuikLook 
 
B.1: Discussion  
 
Vision is equipped with a sophisticated system of custom experiment design, execution, re-
execution, data archiving and recovery, data plotting and exporting and data analysis tools. Vi-
sion is intended to normally operate in a configuration that makes all of this capability available. 
However, to make use of these features requires careful attention to experiment design and sys-
tem configuration that may involve considerable work. Vision also provides a mechanism, called 
"QuikLook", to allow immediate measurement of samples as soon as the program is started. This 
is a simple trade-off between speed and simplicity and advanced capabilities.  
 
Note that we have found that many users limit themselves to QuikLook measurements. 
This is extremely restrictive, using, perhaps, three percent of the capabilities of the Vision 
program. QuikLook is an important tool. But the user who uses QuikLook exclusively is 
doing much more work for much less production than those who build Test Definitions and 
take data in DataSets.  
 
Experimentation is performed by Vision by executing small sub-programs known as Tasks. 
Tasks are semi-independent program elements that perform specific functions. There is a large 
variety of Tasks that range from very simple (ex: pause experiment execution) to very complex 
(ex: perform a complete Fatigue characterization on a sample). Tasks that stimulate the sample 
with voltages provided by the Precision hardware are know as Hardware Tasks. (Some hardware 
Tasks address Radiant Technologies, Inc. accessories or even instruments from other manufac-
turers.) The subset of Hardware Tasks that read the sample response to the stimulus are known as 
Measurement Tasks. The QuikLook mechanism groups a subset of the Hardware and Measure-
ment Tasks, along with a few additional utilities, into a menu that is directly accessed through 
the main Vision menu system. A QuikLook Task is accessed, configured and executed. In the 
case of Measurement Tasks, the sample response is presented immediately to the user.  
 
Note that QuikLook is intended to be used at reduced functionality. Its primary purpose is to 
provide a quick let's-see-what-we've-got review of a sample. It is not intended to save data. 
However, there are several mechanisms to allow a QuikLook measurement to save its data. 
These are presented in the Advanced Operations tutorial.  
 
Note that some Measurement Tasks do not appear in the QuikLook menu. These are Tasks 
whose execution may take place over an extended duration and that make take a large amount of 
data. Such Tasks would not be executed without the intention of saving data. Since QuikLook is 
not intended to save data, Long-Duration Tasks do not appear. These include Fatigue, Resist, Re-
tain, etc.  
 
QuikLook Tasks may be configured and executed directly from the TASK LIBRARY window 
by double-clicking them or right-clicking and selecting "QuikLook Execute" from the popup 
menu. Tasks that are available for QuikLook execution will be labeled with " (QL)" appended to 
their Task name in the Library. Tasks may also still be accessed in the QuikLook menu.  
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B.2: QuikLook Operation.  
 
In this initial training operation you will perform a QuikLook Hysteresis measurement on the 
4/28/80 PNZT Internal Reference Ferroelectric A Capacitor that is built into the Precision tester. 
Once you have proceeded through this session, you will be fully familiar with QuikLook se-
quencing. You can then experiment with other QuikLook Tasks and with measurements on your 
own samples.  
 
Step 1 - Ensure that no connections are made to the Precision Tester DRIVE or RETURN 
ports on the front or rear panels of the tester.  
 

This tutorial will switch the Radiant Technologies, Inc. 4//20/80 PNZT Internal Reference 
Ferroelectric Capacitor into the signal path. When any of the internal reference elements - in-
cluding the 1.0 nF Linear Internal Reference Capacitor and./or the 2.5 MΩ Internal Refer-
ence Resistor and/or the 4/20/80 PNZT Internal Reference Ferroelectric A and/or B capaci-
tors - the behavior of the measurement depends on the vintage of the tester: 

 
•  For testers older than 2014, the enabled Internal Reference Test Elements will be 

measured in parallel with the external sample connected to the tester DRIVE and 
RETURN ports. 

•  For testers released in 2014 or later, the external sample connected to the tester 
DRIVE and RETURN port is switched out of measurement when any of the Internal 
Reference Elements is/are switched in. 
 

In either case, when measuring a sample it is critical that you ensure that none of the internal 
reference elements are switched into the signal path. Throughout these tutorials, please feel 
free to substitute an actual sample or the internal reference resistor or ferroelectric sample. If 
it is not how your sample is to be connected, please refer to Connecting Your Sample.   

 
Step 2 - From the Vision main menu select QuikLook->Hysteresis. Alternatively, find the 
Task in the TASK LIBRARY under Hardware->Measurement->Hysteresis->Hysteresis  
 

The QuikLook menu is shown in Figure 1.  
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Figure 1 - Select the Hysteresis Task from the QuikLook Menu 

or Task Library.  
Step 3 - Configure The Hysteresis Task.  
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The Hysteresis Task configuration dialog will appear as in Figure 2 .  

 

  
Figure 2 - The Hysteresis Task QuikLook Configuration Dialog.  

 
Configure the Task as follows:  

 
Hysteresis Task 
Name:  

"9.0-Volt/10.0 ms Hysteresis  - RTI 4/20/80 PNZT Ferroelectric" 
NOTE: Vision is a heavily self-documenting program. In particular, all Tasks 
offer a 60-character Task Name parameter. Setting this parameter is less criti-
cal in QuikLook. However, as instruction into the Vision program proceeds, 
this parameter will become more critical as Tasks are permanently archived 
under the Task Name. Future review of the archived data will be simplified if 
the Task is given a meaningful name. This will be true of QuikLook measure-
ments as well as instruction proceeds. 

Max Voltage:  9.0 
Enable 
Reference 
Ferroelectric:  

Checked (Enabled) 

Cap A Enable: Checked (Enabled) 
All Other Fields:  Default 

 
Click on Set Sample Info. A subdialog appears (Figure 3). 
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Figure 3 - Sample Information Configuration.  

 
Add the information as follows: 
 

Sample Name:  "Int. Ref. Ferroelectric" 
Lot ID  "N/A" 
Wafer ID  "N/A" 

 
Step 4 - Click Profile Preview to Validate the Measurement Configuration.  
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Figure 4 - Review the Profile Preview. 

 
Step 5 - Configure The Hysteresis Data Plot.  

 
Click on the QuikLook Plot Setup tab. The Hysteresis Task plot configuration dialog will ap-
pear as in Figure 5. (Note that in this example, the documentation fields are fully utilized. It 
is highly encouraged that careful documentation of the Tasks, Test Definitions and DataSets 
be maintained. However, very often for QuikLook execution, such care may be excessive.)  
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Figure 5 - Hysteresis Task Plot Configuration Dialog.  

 
Add the information as follows: 

 
Plot Title:  "9.0-Volt/10.0 ms Hysteresis for Main Vision Tutorials" 
Plot Subtitle: "4/20/80 PNZT Internal Reference Ferroelectric A Capacitor" 
Plot X Axis Label: "Voltage" 
Plot Y Axis Label:  "Polarization (µC/cm2)" 
User Self-Prompt:  "4/20/80 PNZT Sample PMax (µC/cm2): " 
Parameter to Append to Prompt: "Hysteresis: PMax" 
Comments:  As Appropriate 

 
Note that the configuration of the Hysteresis output, as well as the sample information as 
shown in Figure 3, is for demonstration purposes only. A theme throughout these tutorials 
and help pages is the importance of careful and complete documentation. One of the features 
of Vision is the extensive self-documentation of the program. However, since QuikLook 
normally is not used to save data, it is unlikely that such complete and careful configuration 
will often occur when using QuikLook. 

 
Step 6 - Make the Measurement.  

 
Click OK. The configuration dialog will close and the measurement will start. The measure-
ment will be indicated by the extinguishing of the green LED on the tester front panel and by 
"Hysteresis Test:9.0-Volt/10.0 ms Hysteresis - RTI 4/20/80 PNZT Ferroelectri" appearing on 
the Vision status bar at the lower-left portion of the main Vision window (Figure 6). A Stop 
Hysteresis Measurement? button will appear with all measurements as in Figure 7. The but-
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ton can be used to prematurely halt any measurement that is in execution. Note that the ter-
mination may not be immediate.  

 

  
Figure 6 - Vision Status Bar During Hysteresis Execution.  

 

  
Figure 7 - Measurement STOP Button.  

 
Once the hardware has finished making the measurement, the data will be presented on the 
Hysteresis QuikLook Results dialog as in Figure 8. The dialog is specific to Hysteresis and 
includes both configuration and measured parameters. The controls on the response dialog 
will be discussed in the advanced tutorial session.  
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Figure 8 - Hysteresis QuikLook Response Dialog.  

 
Step 7 - Show Tabbed View  

 
On the data display dialog click Tabbed View. The data will be redisplayed in a reduced-
sized tabbed format with the data, error report and some controls displayed on the main tab 
(Figure 8). The secondary tab will show the configuration and measured parameters (Figure 
9). This allows an easier display of data on a reduced-resolution monitor such as a laptop. All 
Tasks that provide data display dialogs have a Tabbed View option on their full display dia-
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log. However, once the tabbed view is displayed it is persistent from Task to Task and be-
tween instances of the Vision program. In order to return to the full view display, the Display 
Tabbed option must be unchecked in the Task's plot configuration dialog as in Figure 10 .  

 

  
Figure 9 - Main Tabbed Display - Data and Error Report are 

Shown.  
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Figure 10 - Secondary Tabbed Display - Configuration and 

Measured Parameters are Shown.  
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Figure 11 - Switch Back to Full View in Task Plot Configura-
tion.  

 
Step 8 - Display Admin Info  

 
From either the full view or the tabbed view click the Admin Info button. A subdialog will 
appear that displays pertinent information regarding the environment under which the meas-
urement was made (Figure 12). This includes Vision version, Driver version and tester in-
formation. In the case of questions regarding the measurement or errors that are occurring, it 
is useful to provide this information to Radiant Technologies.  

 

  
Figure 12 - Accessing Admin Information.  

 
Step 9 - Repeat the Measurement.  

 
Pressing <Ctrl-R>, or selecting QuikLook->Repeat Last Task, will reopen the configuration 
dialog for the last-executed QuikLook Task. The Task will be completely configured exactly 
as it was for the previous execution. (The configuration parameters are persistent). This pro-
vides a quick tool for repeated identical measurements. (Note <Ctrl-R> will not operate if the 
Task QuikLook operation was accessed through the Task Library.)  

 
Step 10 - Repeat and STOP the Measurement  
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Press <Ctrl-R> and set the Hyst Period control to 10000 ms (10 seconds). This allows suffi-
cient time to access the STOP button. Click OK , then click the Stop Hysteresis Measure-
ment? button. Note that the image refresh on the button is very low priority. The button may 
not appear to have been clicked. Note, too, that it may take several seconds for the measure-
ment to actually stop. The Hysteresis Results dialog will appear with uninitialized X- and Y-
axis data. An error summary ("Manual STOP by User") will appear in red in the error field. 
The Error Details button (previously hidden) will appear, along with a prompt (""Error Re-
port" for Details-->") in red. Clicking Error Details will open a subdialog (Figure 14) that 
gives more error detail and recommends remedial action. In cases in which the error cannot 
be remedied, the error number should be reported to Radiant Technologies, Inc. In this case, 
the dialog is very sparse.  

 

  
Figure 13 - Hysteresis QuikLook Error Response Dialog.  
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Figure 14 - Error Report Subdialog.  

 
B.3: Tutorial I-B Lessons Learned.  
 

In this tutorial you:  
 
1.  Were introduced to the program elements known as Tasks.  
2.  Were introduced to Hardware and Measurement Tasks.  
3.  Were introduced to the QuikLook menu as an immediate way to access Hardware and 

Measurement Tasks.  
4.  Were introduced to the RTI 4/20/80 PNZT ferroelectric Internal Reference Capacitor  
5.  Configured and made a 9.0-Volt Hysteresis measurement of the Internal Ferroelectric 

Reference Capacitor  
6.  Were introduced to tabbed and full view data displays.  
7.  Were introduced to the Admin Info subdialog.  
8.  Were introduced to the Stop Hysteresis Measurement? button.  
9.  Were introduced error detail access.  
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C - Create a DataSet 
 
C.1: Discussion  
The QuikLook operations conducted in Tutorial I-B are very limited. In particular, a QuikLook 
measurement, by philosophy, is not intended to save measured data. While tools exist to over-
come this limitation, they are not automatic. To fully realize the capabilities of Vision, measure-
ments must be made within a DataSet. After Tasks, a DataSet is the second most-fundamental 
entity within Vision. It consists primarily of a user-designed experiment - known as a Test Defi-
nition - that is fully configured and ready to execute and an Archive that contains a complete 
record of all previously executed Test Definitions. The immediate experiment is called the Cur-
rent Test Definition (CTD) and experiments stored in the Archive are known as Executed Test 
Definitions (ETDs). 
 
This portion of the tutorial will take you through the process of creating a simple DataSet and 
introduce the various operations that Vision can perform on DataSets. (Actions external to the 
DataSets.) Throughout the tutorial you will be constructing a DataSet named Tutorial #1b. Each 
step of the construction is mirrored in a tutorial DataSet named Tutorial #1a that is provided with 
the Vision program and is found in the DataSet Explorer. To open the Tutorial #1a DataSet, dou-
ble-click on its icon with the left mouse button (Figure 1). An Explorer tab page and a Log win-
dow will open showing the DataSet (Figure 2). You will proceed, step-by-step, to build a clone 
of the Tutorial #1a DataSet. 

 

  
 

Figure 1 - Tutorial #1a in the DataSet Explorer. Double-Click to 
Open.  
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Figure 2 - Tutorial #1a DataSet Explorer Tab Page and Log Win-

dow.  
 

C.2: Tutorial Operations  
 
Step 0 – Register the Template DataSet, If Required  

 
The tutorial DataSets should have been registered into Vision as part of the installation pro-
cess. If they have not, you will need to load them. In the main Vision menu, go to Explorer-> 
Register DataSet..., or Click the "Reg DS" icon on the Vision toolbar. Browse to C:\DataSets 
and select "tutorial #1a.dst". Click Open. The DataSet will appear at the top of the DataSet 
Explorer window in Vision.  
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Figure 3 - Register Tutorial #1a DataSet with Vision.  

 
Step 1 – Create the DataSet  

 
To create the DataSet, first select main menu option File> New DataSet, or click the page 
icon on the toolbar as in Figure 4 (or press <Ctrl-N>). 
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Figure 4 - Initiate a New DataSet.  

 
A dialog will appear as in Figure 5. Perform the following actions: 

 
1.  Type "Tutorial #1b" for the DataSet name. 
2.  The DataSet Path will be automatically set to "C:\DataSets\Tutorial #1b". Illegal file 

name characters in DataSet Name will be replaced with '.'. Once the DataSet Name is ful-
ly set, the DataSet Path may be adjusted, or the automatic value used. Note that the file 
name does not have to have the *.dst extension, but other functions in Vision look for this 
extension for DataSets. The *.dst extension is added automatically to the DataSet name. 
Note that DataSets may be placed anywhere on a writable disk of sufficient size. The de-
fault path is C:\DataSets. If the path is adjusted, the new path will become the default. 
Click Browse to open the Windows File Browser. 

 

  
Figure 5 - Set the DataSet Name and Browse to the Location.  

 
3.  The Windows Browser should be showing the C:\DataSets folder. Create a new folder in 

that location and name it "Tutorials". Click into C:\DataSets\Tutorials. Click Open to 
close the Browser and update the New DataSet dialog. 
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Figure 6 - Locate the DataSet File.  

 
4.  Enter your initials. This provides a reference identity for the DataSet. Any other person 

using the DataSet will know who the designer was. This field is required. 
5.  Type any comments that you’d like. This field is optional. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 25 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 7 - Configure the New DataSet.  

 
6.  Click OK. The new DataSet will be registered to the Vision DataSet Explorer. The Da-

taSet will be opened in its own tab in the DataSet Explorer. (Any number of DataSets 
may be opened the in DataSet Explorer. The Current Test Definition (CTD) will be 
named "New DataSet". This is the experiment that is ready to run. A General Information 
Task will be written to the CTD and Named "GI New DataSet Created". This serves as a 
place holder until the user overwrites the CTD with a user-constructed Test Definition. 

 

  
Figure 8 - Tutorial 1b DataSet Explorer Tab and Log Window.  

 
Step 2 – Close the DataSet  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 26 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
To close the DataSet, simply click on the Close ("X") button of the DataSet Log window. 

 

  
Figure 9 - Close Tutorial 1b.  

 
A dialog will appear to validate that you want to close the DataSet. Click Yes to close. This 
dialog may be disabled by unchecking Show This Dialog. It may be reenabled through the 
"View->Show Prompt Dialogs" menu option. 

 

  
Figure 10 - Verify Close Tutorial 1b.  

 
Step 3 – Unregister the DataSet  

 
DataSets may be removed from the Vision program without removing them from the hard 
disk drive. A DataSet that is installed in Vision is "registered". To remove a DataSet, it must 
be unregistered. The utility of unregistering a DataSet is to retire data that are no longer be-
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ing used and to clean up the DataSet Explorer without losing data. Note that the Vision 
program must be closed and restarted for the change to take effect.  

 
To unregister a DataSet, select "Explorer> Unregister Dataset ...", or click the Remove Da-
taSet icon on the Vision toolbar. A dialog will appear from which a single DataSet may be 
selected to be unregistered. Select "Tutorial #1b". The DataSet must be closed before un-
registering. Click OK. A prompt dialog will appear indicating that Vision must be stopped 
and restarted for the change to take effect. The sequence is reviewed in Figure 11. 

 

  
Figure 11 - Unregister Tutorial 1b.  

 
Stop and restart the Vision program. The DataSet Explorer will appear without the "Tutorial 
#1b" DataSet. The DataSet has been unregistered and is unavailable for use within Vision. 
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Figure 12 - The DataSet Explorer without Tutorial #1b.  

 
Step 4 – Reregister the DataSet  

 
An unregistered DataSet is not lost for use by Vision. If the DataSet has not been deleted 
from the hard disk drive, it can be reregistered for immediate use. Select "Explorer> Register 
DataSet ..." or click the "REG DS" Vision toolbar icon. A File Open (browser) dialog will 
appear. Browse to the C:\DataSets\Tutorials directory and select the "Tutorial #1b.dst" file. 
Note that the browser is automatically set to look for files with the *.dst extension and points, 
by default to C:\DataSets. Click Open. The DataSet will reappear in the DataSet Explorer. 
The sequence is seen in Figure 13. Any DataSet not already registered with Vision must be 
registered before it may be used. Previously retired DataSets and DataSets received from 
other users or moved from other computers must be registered. If a registered DataSet is to 
have its file location changed on the tester or tester host, it must first be unregistered, then 
moved, then reregistered in its new location. 
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Figure 13- Reregister Tutorial #1b - The DataSet Explorer Again 

Shows Tutorial #1b.  
 

Step 5 – Reopen the DataSet  
 

To Reopen the "Tutorial #1b" DataSet, double-click on the icon in the DataSet Explorer with 
the left mouse button. Note that the "Tutorial #1b" tab page appears in the DataSet Explorer 
and that the Log window opens. The Log window records the two events "000:Archive Data-
base open" and "General Information Task Added to CTD". The General Information Task is 
a place-holder Task automatically added to a new DataSet to give it a Current Test Definition 
(CTD). 
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Figure 14 - Reopened Tutorial DataSet Explorer Window and Log.  

 
Note that the operations performed in Step 2 through Step 5 served no other purpose than to 
introduce the various procedures involved in closing, opening, unregistering and reregistering 
DataSets. The condition of the Vision program now is the same as that at the end of Step 1. 

 
Step 6 – Sort the DataSet  

 
As with any Windows tree structure, the list can be sorted, or resorted, by name, creation date 
or date of most-recent change. Select "Explorer->Sort Explorer->By Name", or right-click 
the DataSet Explorer root folder (here, "DataSets") and select "Sort by Name <F5>". The Da-
taSet Explorer tree in the DataSet Explorer window will be resorted by name, alphabetically 
in ascending order, top-to-bottom. If "Sort by Name" is selected again, the list will reverse 
into descending order, top-to-bottom. The DataSet Explorer cannot be sorted if a DataSet is 
open. 
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Figure 15 - Sort the DataSet Explorer Window.  

 
Step 7 – Rename the DataSet  

 
Vision elements including DataSets, Tasks and Test Definitions (the latter two introduced 
later) are permanently stored in Vision under user-specified names. It is important that these 
elements are assigned unique and meaningful names. In some case, duplicate names are per-
mitted. DataSets are not permitted duplicate names. For this reason, along with any number 
of others, a DataSet name can be permanently changed. With the DataSet closed, select the 
DataSet to be renamed. Go to "Explorer->Rename Selected DataSet" or right-click the Da-
taSet and select "Rename Selected DataSet". A small text dialog appears. Assign a new Da-
taSet Name - "Tutorial #1b - RENAMED" in the example. Click OK to close the text dialog 
and set the new DataSet Name. (The DataSet Explorer tree will close as the Explorer is re-
freshed.)  
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Figure 16 - Rename the DataSet.  

 
For the purposes of these tutorials, repeat the process and restore the DataSet to its original 
name. 

 
Step 8 – Search for a DataSet  

 
As Vision is used over time it can become cluttered with DataSets. Unregistering unused Da-
taSets can help reduce the clutter. However, spring cleaning occurs only periodically. If the 
DataSet Name, or part of the DataSet name is known, the DataSet Explorer can be searched 
to locate the first instance of the search text among DataSet Names. With no DataSet selected 
in the DataSet Explorer select "Explorer->Search Explorer->By Name <F3>, or …right-click 
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"DataSets" and select "Search by Name <F3>” or Press <F3>. A dialog will open. Enter "5" 
in DataSet Name Text. Click OK. The DataSet Explorer tree will expand if it is closed. The 
Task with the first instance of the search text in its name - in this case "Tutorial #5a" -  will 
be selected and its information will be expanded. You can also search by the date that the Da-
taSet was created or the date that it was last updated. 

 

  
Figure 17 - Search for a DataSet.  

 
C .3: Tutorial I-C Lessons Learned.  
 

In Tutorial I-C you:  
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1.  Were introduced to the Vision entity called a DataSet and learned of its primary parts and 

its purpose.  
2.  Created the Tutorial #1b DataSet.  
3.  Closed, reopened, unregistered, reregistered, sorted, renamed and searched for the Da-

taSet.  
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D - Create a Test Definition 
 
D.1: Discussion  
 
An experiment in Vision is known as a "Test Definition". A Test Definition consists of a serial 
sequence of Tasks. Both the sequence and the specific configuration of the Tasks that comprise 
the Test Definition are specified by the user. Vision is, in effect, a simple visual programming 
language. The Test Definition is constructed in the EDITOR whose window is normally at the 
upper-right corner of the main Vision window. Tasks are added to the Test Definition by moving 
them into the EDITOR from the TASK LIBRARY, whose window is normally shown centered 
at the right edge of the main Vision window. In this stage of the tutorial you will create a simple 
Test Definition composed of a single Hysteresis Task. 
 
The design and construction of Test Definitions is a matter for careful consideration. With the 
tools available to Vision - many of them discussed in more advanced tutorials - there is almost 
no experimental need that cannot be met by creative test design. A very important set of tools in 
Vision includes the self-documentation capability. This is found both in Tasks that are dedicated 
solely to documentation and in features common to all or many Tasks - features such as Com-
ments fields and plot labeling. Since Task configuration parameters are stored and recalled on 
execution, the very act of configuring the Tasks is a form of documentation. Throughout the tu-
torials, Tasks and Test Definitions will be documented in great detail. This is an important habit. 
Work spent in initial design and documentation will result in less work in the future and better 
understanding of the data achieved.  
 
D.2: Create the Test Definition  
 
You will now begin to slowly build up a practical experiment to execute in the DataSet. The re-
sulting data will be stored in the DataSet. Begin with a single Hysteresis loop. Follow these 
steps...  
 
Step 1 – Locate the Hysteresis Task in the Library.  

 
In the TASK LIBRARY window, expand the "Hardware" folder, then Expand the "Meas-
urement" folder. Finally, open the "Hysteresis" folder.  

 
Step 2 – Move the Hysteresis Task to the Editor.  

 
With the left mouse button, click on the "Hysteresis" Task icon. While holding the mouse 
button down, move the cursor into the Editor window. Note that the "Hysteresis" label moves 
with the cursor. Ensure that it is the "Hysteresis" Task that is being moved. It is easy to select 
the wrong Task. When the cursor is in the Editor window, release the mouse button. This is 
known as "Drag-and-Drop". It will be familiar to anyone that has moved files from folder-to-
folder within the Windows Explorer program. Another option is to right-click on the Hyste-
resis Task in the Task Library and select "To Editor" from the popup menu.  
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Figure 1 - Drag and Drop the Hysteresis Task from the TASK LI-

BRARY to the EDITOR.  
 

Step 3 – Configure the Hysteresis Task.  
 

Note that the Task configurations in the figures of these tutorial help pages match the config-
urations specified in the tables and discussion. Measurements are configured to be made on  
a 100 µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample manufac-
tured by Radiant Technologies, Inc. This is the sample that is inserted as the internal refer-
ence ferroelectric in all modern Precision tester models, when shipped. It is detailed here. A 
2.5 MΩ reference resistor a 1.0 nF linear reference capacitor are also used and may be 
switched into the signal path. Or the user's own sample may be connected to the tester's 
DRIVE and RETURN ports.  
 
The configuration dialog for the Hysteresis Task will appear. Configure the Task as follows:  

 
Task Name:  "3.0-Volt/10.0 ms Hysteresis - 1.0 nF Int. Ref. Cap." 
Max. Voltage:  3.0 
Hysteresis Period (ms):  10 
Enable Reference Ferroelectric:  Checked (Enabled) 
Cap A Enable (or Cap B Enable): Checked 
Comments:  Enter appropriate comments 
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Click on Set Sample Info and add the information as follows.  
 

Sample Name:  "Int. Ref. Ferroelectric" 
Lot ID:  "N/A" 
Wafer ID : "N/A" 

 
Then click OK to return to the main dialog.  
 
This configuration switches a 1.0 nF internal reference capacitor into the test signal path. 
That capacitor becomes the device under test. You may prefer to attach your own sample 
immediately to the DRIVE and RETURN BNCs on the front of the Precision tester. In that 
case, ensure that the reference capacitor is disabled. It would then be a good idea to label the 
Sample Name, Lot ID and Wafer ID.  
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Figure 2 - Hysteresis Configuration Dialog and Sample Information 

Subdialog.  
 

To review details on the Hysteresis Task theory, configuration and execution, click Click For 
Task Instructions. A formatted help project will open, specific to the Hysteresis Task, that 
provides complete detail of the Task's purpose and use. Every control on the configuration 
dialog is discussed in detail in the Configuration section.  
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Figure 3 - Hysteresis Task-Specific Help.  

 
To review the exact voltages that will be applied, click Preview Profile. A subdialog will 
open that displays the voltage profile in a graphic. The main plot shows the voltage profile 
shape (standard bipolar), voltage range (±3.0 Volts), offset (0.0 V) and period (10.0 ms). As 
your review the Task details you will find that a large variety of variations on the profile 
shape, magnitude and duration are available. Above the main plot is a graphic that shows the 
possible sequence of actual voltage signals that may be applied. In Figure 4a, the unmeas-
ured polarization presetting (Preset) waveform is enabled. This is shown as a "Preset" pro-
filed, followed by a "Preset Delay" before the measurement. Furthermore, the Task is config-
ured to adjust RETURN signal amplification level automatically. The sequence of voltage 
waveforms may be repeated several times until the actual amplification level is settled on. 
(More details regarding RETURN signal amplification level can be found in the Task help.) 
The repeated signals are shown as vertically-duplicated sets of the Preset->Preset Delay-
>Measure waveforms. Please see the Hysteresis Task Instructions for complete details re-
garding these signals and options. 
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Figure 4a - Profile Preview - Preset and Auto Amplification are En-

abled.  
 

Figure 4b shows the graphic with Auto Amplification and Preset disabled, Fixed Amp and 
Preset Enabled and Fixed Amp and Preset Disabled, as suggested by the title of each graphic.  
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Figure 4b - Profile Preview - Various Preset and Auto Amplification 

Combinations.  
 

Close the profile profile dialog and click OK to add the Hysteresis Task to the Test Definition 
in the Editor. The single Task in the Editor represents a fully-configured Test Definition.  

 

  
Figure 5 - The Hysteresis Task as a Test Definition in the Editor.  

 
Step 4 – Open the Hysteresis Task to Review and Reconfigure.  

 
Once in the Editor window, any configured Task can be reopened for review and reconfigu-
ration. Double-click the Task in the Editor. The configuration dialog will open as in Figure 
2. Any number of changes can be made. Cancel or Cancel/Plot will return the Task to the 
Editor without saving changes. OK will return the changed Task to the Editor.  
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Step 5 – Save the Test Definition to the Library as a Customized Test.  

 
Any complete Test Definition can be saved back to the Library where it will appear as a sin-
gle Task within the Customized Tests folder. It is stored there fully configured so that the ef-
fort that went into the original Test Definition configuration does not need to be duplicated. 
Go to "Editor->Test Definition to Customized Tests Folder... ", or right-click in the Editor 
window and select "Test Definition to Customized Tests Folder... " from the popup menu.  

 

  
Figure 6 - Initiating a New Customized Test from the Existing Test 

Definition.  
 

A dialog will appear allowing the Customized Test to be named. Note that a "Customized 
Test" was originally called a "User-Defined Test". The acronym UDT may persist on dialogs 
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and in messages. Assign the name "Tutorial #1b1" and Click OK . The process can also be 
Cancel ed at this time.  

 

  
Figure 7 - Name the Customized Test.  

 

  
Figure 8 - New Task Appears in the "Customized Tests" Folder.  

 
Step 6 – Clear the Editor.  

 
Remove the 3.0-Volt Hysteresis Task from the Editor. Select " Editor-> Clear All", right-
click in the Editor window and select " Clear All" from the popup menu or press <Ctrl-A>. 
The Editor will be emptied of all Tasks (in this case one Task) and will have no Test Defini-
tion in it.  

 
Step 7 – Recall the Customized Test.  

 
Drag-and-Drop the Tutorial #1b1 Task from the Customized Tests folder in the Library into 
the Editor. The configured Test Definition will reappear in the Editor. 
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Figure 9 - Recall the Customized Test.  

 
Step 8 – Repeat Recall the Customized Test.  

 
Drag-and-Drop the "Tutorial #1b1 Task" from the Customized Tests folder in the Library in-
to the Editor a second time. The configured Test Definition will be appended to the first Test 
Definition already in the Editor. Note that in this case the two appended Test Definitions 
form a single Test Definition with two Tasks of identical name. While this is legal within Vi-
sion, it is very poor design and can cause unexpected operations in some cases. One of the 
Tasks in such a Test Definition should be immediately reconfigured and renamed. Continued 
recall from the Library will continue to append stored Test Definitions to the Test Definition 
under construction in the Library. 

 

  
Figure 10 - Recall the Customized Test Again.  

 
Step 9 – Remove the Last-Added Task.  

 
Rather than reconfiguring the second Task in the Test Definition, remove it. The functions 
that can be performed on the Editor include clearing it entirely, appending one Task at a time 
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to the existing Test Definition, appending a Test Definition from the Customized Tests folder 
in the Library (or elsewhere as shall be seen later) and removing the single Task from the 
bottom of the Test Definition Task list. Completely general Test Definition editing would in-
clude being able to remove a Task from any position in the list or moving a Task up or down 
in the list. However, because of complex interdependencies between certain Tasks such a 
completely general Editor is not possible. By allowing the Editor to remove the last-added 
Task, the process of adjusting the Task sequencing in a Test Definition has been simplified 
from the extreme option of removing all Tasks and starting over. 

 
Select "Editor->Remove Last Task", right-click in the Editor window and select "Remove 
Last Task" or simple press <Ctrl-L>. The list of Tasks will be reduced by one, with the Task 
at the bottom of the list removed. 

 

  
Figure 11 - Remove the Last-Added Task from the Test Definition in 

the Editor.  
 

D .3: Tutorial I-D Lessons Learned.  
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In I-D you:  
 

1.  Learned that an experiment in Vision is called a "Test Definition" and consists of a linear 
series of Tasks to be executed sequentially.  

2.  Learned that using Vision consists of building custom Test Definitions, making Vision a 
programming environment and you an experimental programmer.  

3.  Learned that care must be taken in designing the program and that the Vision documenta-
tion tools should be used in detail.  

4.  Built a simple Test Definition consisting of a single Hysteresis Task.  
5.  Learned to reopen a Task in a Test Definition to verify and/or reconfigure.  
6.  Stored the Test Definition in the Library as a Customized Test.  
7.  Recalled the Test Definition from the Library.  
8.  Learned to clear the Editor of all Tasks.  
9.  Learned to remove the last-added Task from the Test Definition.  
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E - Run the Test Definition 
 
E.1: Discussion  
 
The experiment represented by the Test Definition in the Editor is executed by moving it into a 
DataSet as the Current Test Definition (CTD), then running the DataSet. In this section of the 
tutorial you will move the Test Definition to the DataSet, run the experiment and recall the data.  
 
E.2: Run the Test Definition  
 
Step 1 – Open the DataSet.  

 
If you have proceeded to this point continuously from Tutorial IC, the DataSet that you cre-
ated in that help page (Tutorial #1b) will be open. If it is not, double-click on "Tutorial #1b" 
in the DataSet Explorer. The DataSet will open. A tab window representing Tutorial #1b will 
appear in the DataSet Explorer. The DataSet log window will open.  

 
Step 2 – Move the Editor Test Definition into the DataSet as the CTD.  

 
The Task in the Editor represents a complete Test Definition. Move it into the DataSet as the 
Current Test Definition by:  

 
1.  Drag-and-Drop the Editor icon into the DataSet Explorer tab page for the Tutorial #1b 

DataSet. Or...  
2.  Click the right mouse button in the Editor window. From the popup menu select "Test 

Definition to Current DataSet". Or...  
3.  In the main menu select "Editor>Test Definition to Current DataSet"  
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Figure 1a - Moving the Test Definition from the Editor to the CTD 

of the DataSet.  
 

More than one DataSet may be open in the DataSet Explorer. If multiple DataSets are open 
and if one of the two last options for moving the Editor Test Definition into the DataSet is se-
lected then a DataSet Selection dialog will open. The dialog is used to select the target Da-
taSet. 
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Figure 1b - Select the DataSet to Update. 

 
Step 3 – Name the CTD.  

 
A dialog will appear to allow you to rename the Current Test Definition. Name the CTD "Tu-
torial #1b – Run 1 - 3.0-Volt/10.0 ms Hysteresis"  

 

  
Figure 2 - CTD Renaming Dialog.  

 
Click OK to close the Rename CTD dialog. The DataSet Explorer Tab Page will be updated 
to reflect the new CTD, including the CTD name and the list of Tasks that make up the ex-
periment. The DataSet Log window will reflect the new activity.  
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Figure 3 - Updated DataSet with CTD.  

 
Step 4 – Run the CTD.  

 
Execute the experiment. Select "Dataset->Execute Current Test Definition (CTD) (F1)" from 
the main menu,  select the CTD name in the DataSet, right-click and select "Execute Current 

Test Definition (CTD) (F1)", click on the toolbar or simply press <F1> to run the ex-
periment.  

 

  
Figure 4 - Execute the CTD.  
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During execution the measurement will be indicated by the fact that the green LED on the 
Precision tester front panel is extinguished and by "Hysteresis Test: 3.0-Volt Hysteresis - 1.0 
nF Int. Ref. Cap." appearing on the Vision status bar at the lower-left corner of the main pro-
gram window. A STOP Hysteresis Measurement? button will also appear during the meas-
urement.  

 

  
Figure 5 - Vision Status Bar Indicating the Measurement.  

 

  
Figure 6 - Measurement STOP Button.  

 
Step 5 – Review the Program Status.  

 
The first thing that you will notice is that there is no representation of the measured Hystere-
sis data presented. No plot appears. The indications that the measurement is completed is that 
the tester's green LED is once again illuminated, program status bar indicates "Ready" and 
the STOP button is no longer shown. There are design reasons for this apparent flaw in the 
program. These will be discussed in the next help page, where the "flaw" will be corrected. In 
the meantime, the data just measured are recoverable, as will be shown below.  
 
Expand all of the folders in the Tutorial #1b DataSet. The current status of the Vision pro-
gram screen is as shown in Figure 7. The log file will reflect the measurement including ex-
ecution time, VMax and measured parameters. The DataSet Explorer Tab Page will have its 
Archive updated. The tree is now expandable. A folder representing the Executed Test Defi-
nition appears named "Tutorial #1b – Run 1:0". That folder expands into two subfolders la-
beled "Experiment Design" and "Experiment Data". Both folders hold a copy of the Hystere-
sis Task. The first folder holds the Task as a copy of the CTD that was executed. The Task 
contains configuration information, but no data. This folder is of little concern to the user. It 
serves as a template for Vision to use when copying the Test Definition to other locations 
within Vision. The second folder holds the executed Task. The Task includes both configura-
tion information and measured data. The First Task in the "Experiment Data" folder is named 
"Auto ETD Summary: 1". This is a General Information Task added automatically each time 
the Current Test Definition (CTD) is executed. It contains a complete list of the Tasks being 
executed along with a description of their configuration. This is an automatic documentation 
tool. 
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Figure 7 - DataSet Archive and Log File after the First Execution.  

 
Step 6 – Review the Task Configuration and Measured Data.  

 
Before the Hysteresis Task Vision has added a General Information Task as the first Task in 
the Test Definition. This is an automatic documentation feature. The Task is always named 
"Auto ETD Summary". It contains a formatted description of the configuration of all Tasks 
in the Test Definition. Double-click the Task in the "Experiment Data" folder to review its 
contents.  
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Figure 8 - Vision-Generated General Information Task Describing 

the Test Definition.  
 

With the left mouse button, double-click the Hysteresis Task in the "Experiment Data Fold-
er". A configuration dialog will appear that reflects the Hysteresis Task original configura-
tion. Since the Task has been executed and stored, it cannot be reconfigured. This dialog has 
most of its controls disabled. Buttons that open subdialogs are enabled, though the controls 
on the subdialogs will be disabled or read-only. The Click For Task Instructions button still 
works. So does the button labeled Cancel/Plot. For the Hysteresis Task, and most other 
Measurement Tasks, a second dialog (Figure 10) will appear that allows the data plot to be 
configured. When this second dialog is closed, a new dialog opens that shows the measured 
data (Figure 11).  
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Figure 9 - Disabled Hysteresis Configuration Review Dialog Re-

called from the DataSet Archive.  
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Figure 10 - Hysteresis Regraph Plot Setup Dialog.  
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Figure 11 - Full-View Regraphed Plot of Archived Hysteresis Data.  
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Figure 11B - Tabbed Plot of 3.0-Volt Hysteresis Data.  
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Figure 11C - Tabbed Configuration and Measured Parameters.  

 
Clicking Tabbed View on the dialog of Figure 11 re-displays the data in a two-tab dialog 
with the plotted data shown on the first tab (Figure 11B) and the configuration and measured 
parameters on the second (Figure 11C). This option is intended to allow the data to be better 
displayed on a laptop or other small-display device. Once this option is selected, it is "Per-
manent" until a Task is configured with the Display Tabbed control of Figure 10 unchecked. 
Although this option may help with some Vision data display dialogs, many configuration 
dialogs will still be too large to present on a small display. Displays of less than 19" are not 
recommended. 

 
Note that a 3.0-Volt measurement on the internal reference capacitor, as specified in the con-
figuration text and tables of this tutorial, will produce a linear response from -30.0 µC/cm2 at 
-3.0 Volts to +30.0 µC/cm2 at +3.0 Volts. The ±30.0 µC/cm2 response depends on the sample 
area being left at the default value of 0.0001 cm2.  
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Step 7 – Repeat the Measurement.  
 

Select DataSet->Execute CTD, or press <F1>. The Log window and DataSet Archive will be 
updated. A new Executed Test Definition will be added to the DataSet Archive, named "Tu-
torial #1b – Run 1:1". This differs from the original ETD name by the appended ":1". A seri-
ally incrementing value is appended to the ETD name to distinguish ETDs of the same root 
name. The "Experiment Design" and "Experiment Data" folders hold new copies of the Hys-
teresis Task.  

 

  
Figure 12 - DataSet with Second CTD Execution in the Archive.    

 
Step 8 – Repeat the Measurement and Review Data as Desired.  

 
E .3: Tutorial I-E Lessons Learned.  
 

In tutorial I-E you:  
 

1.  Moved the Test Definition from the Editor to the DataSet where it became the Current 
Test Definition (CTD).  

2.  Executed the Test Definition in the DataSet.  
3.  Reviewed changes to the DataSet Log window and Archive that occurred as a result of 

the CTD execution.  
4.  Examined the naming and contents of the Executed Test Definition (ETD).  
5.  Recalled the 3.0-Volt Hysteresis Task from the ETD in the DataSet Archive.  
6.  Reviewed the configuration of the Hysteresis and learned of the reduced set of enabled 

controls on the configuration dialog.  
7.  Configured the labels and controls for the plot to display the data recalled from the Ar-

chive.  
8.  Reviewed the plotted data recalled from the DataSet Archive. 
9.  Repeated the measurement as desired.  
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F - Add a Filter Task 
 
F.1: Discussion  
 
In the previous help page a Hysteresis Task was executed in the DataSet. However, no data ap-
peared until the Task was recalled from the DataSet Archive after the Test Definition execution 
completed. This apparent design flaw is intentional. As Test Definitions become more elaborate, 
the possibility of many executions of a variety of Measurement Tasks becomes likely. If each 
execution of these Tasks produced a data plot, then the User Area of the Vision program would 
soon fill with data that are impossible to sort out. In general, therefore, Measurements are not 
permitted to show data at run time. (Exceptions to this include Long-Duration Tasks that must 
present data over their duration to indicate progress.) Measurement data may be displayed to the 
user at run time by associating the Measurement Task (or Tasks) with a representative of a class 
of Tasks called Filters.  
 
The subject of Filter Tasks is very elaborate and discussion changes from Filter Task to Filter 
Task. A detailed study should include a close review of the Task-specific Task Instructions. 
However, this brief introduction applies to Filters in general.  
 
In general, a Filter Task performs four functions:  
 

1.  Accumulate Data from one or more preceding measurement Tasks or from other Filter 
Tasks.  

2.  Perform operations on the data, altering their value.  
3.  Store the accumulated, altered data  
4.  Optionally plot the accumulated, altered data.  

 
This step will use the Collect/Plot Filter as an introduction. This Filter does not perform any al-
teration on data, but simply passes the unaltered accumulated data into storage.  
 
F.2: Add and Run the Filter Task  
 
Step 1 – Add a Filter to the Test Definition.  

 
In the TASK LIBRARY window expand the Filters folder. Move the Collect/Plot Filter Task 
to the EDITOR Window.  
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Figure 1 - Move the Collect/Plot Filter to the Editor.  

 
Step 2 – Configure the Task.  
 

Task Name:  "Tutorial 3.0 V Hysteresis Data"  
Data Type:  Hysteresis  

  
Task Selector:  "3.0-Volt/10.0 ms Hysteresis - 1.0 nF Int Ref. Cap."  

  
Click Add Task. Note that the Task Selector 
indicates the selected Task with an appended 
"(X)"    
Comments:  As appropriate  
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Figure 2 - Configure the Collect/Plot Filter.  

 
Step 3 – Configure the Plot.  

 
Click on the Collect/Plot Plot Setup tab, then click Plot These Data to uncheck the control.  
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Figure 3 - Configure the Data Plot.  

 
Click OK to add the Task to the Test Definition in the Editor.  

 
Step 4 – Save the Test Definition as a Customized Test.  

 
Right-click in the EDITOR window and select "Test Definition to Customized Tests Folder... 
" or select "Editor ->Test Definition to Customized Tests Folder... ".  
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Figure 4 - Initiate the Addition of the Test Definition to the Library.  

 
Name the Customized Test "Tutorial #1b2".  

 

  
Figure 5 - Name the Customized Test "Tutorial #1b2".  

 
The new Customized Test now appears as a Task in the Library. The Task can be recalled at 
any time by Drag-and-Drop, or right-click->"To Editor" into the EDITOR. There the Test 
Definition that it represents will be appended to the existing Test Definition in the Editor.  
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Figure 6 - Recover the "Tutorial #1b2" Customized Test.  

 
If you experimented with recalling the Customized Test into the Editor, press <Ctrl-L> twice 
to remove the last-added Tasks and return the Editor Test Definition to that of Figure 4.  

 
Step 5 – Move the Test Definition to the DataSet.  

 
Open the DataSet if it is closed. Right-click in the Editor window and select "Test Definition 
to Current DataSet" or select Editor-> Test Definition to Current DataSet.  
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Figure 7 - Editor Popup Menu.  

 
Do not rename the CTD. Just click OK or Cancel in the Rename CTD dialog.  

 

  
Figure 8 - Do Not Rename the CTD.  

 
Step 6 – Rename the CTD.  

 
Double-click on the CTD icon in the DataSet Explorer Tab Page. In the dialog that appears 
rename the CTD to "Tutorial #1b – Run 2". The purpose of this extra step is to show you 
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how to rename a CTD at any time.  
 

  
Figure 9 - Renaming the Existing CTD.  

 
Step 7 – Run the CTD.  

 
Press <F1>. Observe the update to the Archive. The Executed Test Definition "Tutorial #1a – 
Run2:0" has been added. The Log window also reflects the new activity.  
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Figure 10 - DataSet after Execution with the Collect/Plot Filter.  

 
Step 8 – Review the Data.  

 
As in the previous help page, no data appears during the execution of the CTD. The plotting 
capability of the Filter was disabled during configuration. The purpose was to demonstrate 
the Task at reduced capabilities, then incrementally broaden the tutorial (below).  
 
With the DataSet Archive open as in Figure 10 , the Hysteresis Task data may be reex-
amined as in the previous help page. The Filter Task may also be reexamined by double-
clicking its icon in the "Experiment Data" folder of the ETD.  
 
First, the unreconfigurable Filter setup dialog will appear...  
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Figure 11 - Disabled Collect/Plot Filter Archive Regraph Configura-

tion Dialog.  
 

Note that the Task Selector control is empty and does not show the associated Hysteresis 
Task. This is because recalling the Task from the DataSet Archive does not rebuild the Test 
Definition in memory. As a result, there is no Hysteresis Task to associate with in this repre-
sentation. Note that the "Collect/Plot Plot Setup " tab of the Collect/Plot Filter configuration 
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dialog remains active so that the display of the data that are recalled from the Archive may be 
adjusted.  

 

  
Figure 12 - Collect/Plot Filter Plot Configuration Dialog is Active 

during Regraph.  
 

Once the configuration dialogs are closed, a window will appear showing the plotted Filter 
data and a text field that shows sample information, Hysteresis configuration and measure-
ment results.  
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Figure 13 - Collect/Plot Filter Data Recalled from the DataSet Ar-

chive.  
 

Repeat the experiment if desired.  
 

Step 9 – Plot During Execution.  
 

In this step you will modify the existing Test Definition to allow data to be plotted during the 
experiment execution. This is done by modifying the Filter Task setup. In the Editor window, 
double-click on the Filter Task icon with the left mouse button. This reopens the configura-
tion dialog. Click on the Collect/Plot Plot Setup tab in the dialog and configure the plot as 
follows:  

 
Plot These Data:  Check (Enabled)  
Plot Title:  "3.0-Volt/10.0 ms Internal Reference Ferroelectric Hyst. Data"  
Plot Subtitle:  "Tutorial #1b Demonstration for the Vision Help Pages"  
Plot X-Axis Label:  "Voltage"  
Plot Y-Axis Label:  "Polarization (µC/cm2)" Note: to type a "µ" character, hold the 

"Alt" key down and type 0181.  
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Figure 14 - Configure the Collect/Plot Filter Plot in the Test Defini-

tion.  
 

Send the Test Definition to the DataSet as the Current Test Definition. Rename the CTD 
"Tutorial #1b2 - Run 3 - 3.0-Volt/10.0 ms Hyst. + Plot Filter".  
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Figure 15 - Update the CTD.  

 
Execute the CTD. As usual, the "Tutorial #1b – Run 3:0 - 3.0-Volt/10.0 ms Hysteresis + Fil-
ter.0" ETD is added to the DataSet Archive. The Archive contains both the Hysteresis and 
Filter Tasks and these may be recalled as described above to review their configuration and 
measurement value. However, during the execution of the program, a plot appeared, created 
by the Filter Task, that reflects the Hysteresis data. The plot is accompanied by a text field 
that describes the Hysteresis measurement configuration and results.  
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Figure 16 - Plot Appears During CTD Execution.  

 
Review the stored data if desired by recalling Tasks from the ETD.  
 
Rerun the experiment. Notice that the execution plot remains visible after the experiment is 
run. This plot has the "focus". That means that it is the active window. In order to re-execute 
the experiment, the DataSet must have the focus. In this case, the Log window is the active 
window. To re-execute, first click in the log window, then rerun the experiment. Notice that 
now, the plots from both executions are available.  
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Figure 17 - Give the DataSet the Focus to Re-Execute.  

 
F .3: Tutorial I-F Lessons Learned.  
 

In the tutorial you:  
 
1.  Learned why Measurement Tasks do not display their data on execution when run in a 

DataSet.  
2.  Learned that certain long-duration Measurements do show their data during execution.  
3.  Were given a general introduction into a class of Tasks known as Filters.  
4.  Learned that Filters take data as input from other Filters or from Measurement Tasks.  
5.  Learned that Filters can plot data when they are executed.  
6.  Added a Collect/Plot Filter to the Test Definition in the Editor and associated it with the 

3.0-Volt Hysteresis Task.  
7.  Saved the new Test Definition to the Library as a Customized Test.  
8.  Moved the Test Definition into the DataSet as the CTD.  
9.  Executed the CTD with the Filter.  
10.  Recalled the Filter configuration and data from the DataSet Archive.  
11.  Reconfigured the Filter to display data on execution.  
12.  Moved the Test Definition to the CTD and executed it.  
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13.  Observed the runtime display of data.  
14.  Learned that the DataSet must have the focus, by having its Log window as the top win-

dow in the user area, in order to execute.  
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G - Add a 2nd Hysteresis/Filter Pair 
 
G.1: Discussion  
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision testers, when 
shipped. It is detailed here. A 2.5 MΩ Internal Reference Resistor and/or a 1.0 nF Linear Inter-
nal Reference Capacitor may also be switched into the signal path. Or the user's own sample 
may be connected to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelec-
tric capacitor pair is available on all testers except the Precision RT66B and the original Preci-
sion LC. The Precision RT66B offers no internal reference elements. Both of these tester models 
have been discontinued.  
 
This tutorial expands the existing Test Definition by adding a second Hysteresis Task and asso-
ciating it with a second Collect/Plot Filter. The new measurement will be at 4.0-Volts, but is oth-
erwise identical to the existing Hysteresis/Filter pair.  
 
G.2: Add a Second Hysteresis/Filter Pair to the Test Definition and Run.  
 
Step 1 – Add a second Hysteresis Task.  

 
Move a Hysteresis Task from the TASK LIBRARY into the EDITOR. Configure as follows:  

 
Task Name:  "4.0-Volt/10.0 ms Hysteresis - 1.0 nF Int. Ref. Cap."  
Max. Voltage:  4.0  
Hysteresis Period (ms):  10.0  
Comments:  Enter appropriate comments.  

 
Note that items that are consistent from Task to Task such as Sample Name or Enable Ref. 
Cap . are already set. Vision maintains these value and updates them so that they are persis-
tent from Task to Task.  
 
Click OK to add the Task to the Test Definition in the Editor.  
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Figure 1 - 4.0-Volt Hysteresis Task Configuration.  

 
Step 2 – Add a second Collect/Plot Filter Task.  

 
Move a Collect/Plot Hysteresis Task from the TASK LIBRARY into the EDITOR. Config-
ure as follows:  

 
1.  Collect/Plot Filter Setup Tab:  

 
Task Name:  "4.0-Volt Hysteresis Data"  
Data Type:  Hysteresis  
Task Selector:  4.0-Volt/10.0 ms Hysteresis  
Click Add Task  Note that the Task Selector indicates the selected Task with an appended "(X)"  
Comments:  As appropriate  
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Figure 2 - 4.0-Volt Collect/Plot Filter Task Configuration.  

 
2.  Collect/Plot Plot Setup Tab  

 
Plot These Data:  Check (Enabled)  
Plot Title:  "4.0-Volt/10.0 ms Internal Reference Capacitor Hyst. Data"  
Plot Subtitle:  "Tutorial #1b Demonstration for the Vision Help Pages"  
Plot X-Axis Label:  "Voltage"  
Plot Y-Axis Label:  "Polarization (µC/cm2)" Note: to type a "µ" character, hold the "Alt" 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 80 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

key down and type 0181.  
 
 

  
Figure 3 - 4.0-Volt Collect/Plot Filter Task Plot Configuration.  

 
Click OK to record the changes into the Task in the Test Definition.  
 

Step 3 – Save the Test Definition to the Library.  
 

Right-click in the Editor and select "Test Definition to Customized Tests Folder " or select 
"Editor- >Test Definition to Customized Tests Folder". Name the Customized Test "Tutorial 
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#1b3". Experiment with recalling the Customized Test into the Editor. As a final step, clear 
the Editor of all Tasks and recall the Customized Test one last time to return to a Test Defini-
tion consisting of four Tasks, two Hysteresis/Filter pairs.  

 

 
Figure 4 - Editor Test Definition to Task Library Customized Tests.  

 
Step 4 – Move the Test Definition into the DataSet.  

 
Right-click in the Editor and select "Test Definition to Current DataSet " or select "Editor-> 
Test Definition to Current DataSet " or Drag-and-Drop the Editor into the DataSet. Name the 
CTD "Tutorial #1b - Run 4 - 3 & 4-/10.0 ms Hysteresis + Filters".  
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Figure 5 - Run 4 Test Definition to the DataSet.  

 
Step 5 – Execute the CTD.  

 
Two Plots will appear - one for each of the Hysteresis measurements.  
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Figure 6 - 4.0-Volt Hysteresis Execution Data.  

 
Step 6 – Repeat the Measurement as Desired.  

 
Repeat the Measurement as desired. Remember that execution will be disabled unless the Da-
taSet is brought into the focus by moving its Log window into view above any of the data 
plot windows. This can also be accomplished by closing all of the data plot windows. Select 
"View-> Remove All Plot Windows" or press <Ctrl-W> to close all open plot windows in a 
single action.  
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Step 7 – Review the Archived Data as desired.    

 
G .3: Tutorial I-F Lessons Learned.  
 

In the tutorial you:  
 

1.  Added a second, 4.0-Volt, Hysteresis Task and associated Collect/Plot Filter to the Test 
Definition.  

2.  Saved the Test Definition as a Customized Test to the Library.  
3.  Moved the Test Definition into the DataSet CTD and executed it.  
4.  Reviewed the data.  
5.  Learned to close all open plot windows.  
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H - Add a 3rd Hysteresis/Filter Pair 
 
H.1: Discussion  
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision testers, when 
shipped. It is detailed here. A 2.5 MΩ Internal Reference Resistor and/or a 1.0 nF Linear Inter-
nal Reference Capacitor may also be switched into the signal path. Or the user's own sample 
may be connected to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelec-
tric capacitor pair is available on all testers except the Precision RT66B and the original Preci-
sion LC. The Precision RT66B offers no internal reference elements. Both of these tester models 
have been discontinued.  
 
In this tutorial a final 5.0-Volt Hysteresis/Filter pair is appended to the existing Test Definition in 
the Editor. The update Test Definition is saved to the Library, moved into the CTD of the Da-
taSet and executed. As there is little new in this process the tutorial is very short with only a sin-
gle figure showing the measured data.  
 
H.2: Add a Third Hysteresis/Filter Pair to the Test Definition and Run.  
 
Step 1 – Drag-and-Drop the Hysteresis Task from the Library to the Editor.  

 
 Configure as follows:  

 
Task Name:  "5.0-Volt/10.0 ms Hysteresis - 1.0 nF Int. Ref. Cap."  
Max Voltage:  5.0  
Sample Name:  "Internal Reference Cap."  
Lot ID:  "N/A"  
Wafer ID:  "N/A"  
Enable Ref. Cap.:  Checked (Enabled)  
Comments:  Enter appropriate comments.  

 
Click OK to add the Task to the Test Definition in the Editor.  

 
Step 2 – Drag-and-Drop the Collect/Plot Filter Task from the Library to the Editor.  

 
Configure as follows:  

 
1.  Collect/Plot Filter Setup Tab:  

 
Task Name:  "5.0-Volt Hysteresis Data"  
Data Type:  Hysteresis  
Task Selector:  5.0-Volt Hysteresis  
Click Add Task  Note that the Task Selector indicates the selected task with an ap-
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pended "(X)"  
Comments:  As appropriate  

 
2.  Collect/Plot Plot Setup Tab  

 
Plot These Data:  Checked (Enabled)  
Plot Title:  "5.0-Volt/10.0 ms Internal Reference Capacitor Hyst. Data"  
Plot Subtitle:  "Tutorial #1b - Simple DataSet operations"  
Plot X-Axis Label:  "Voltage"  
Plot Y-Axis Label:  "Polarization (µC/cm2)" Note: to type a "µ" character, hold the "Alt" 

key down and type 0181. 
 

Click OK to record the changes into the Task in the Test Definition.  
 

Step 3 – Save the Test Definition to the Library.  
 

Right-click in the Editor and select "Test Definition to Customized Tests Folder " or select 
"Editor-> Test Definition to Customized Tests Folder ". Name the Customized Test "Tutorial 
#1b4". Experiment with recalling the Customized Test into the Editor. As a final step, clear 
the Editor of all Tasks and recall the Customized Test one last time to return to a Test Defini-
tion consisting of six Tasks, three Hysteresis/Filter pairs.  

 
Step 4 – Move the Test Definition into the DataSet CTD.  

 
Rename the CTD "Tutorial #1b - Run 5 - 3, 4 & 5-V/10.0 ms Hysteresis+Filters".  

 
Step 5 – Execute the CTD.  

 
Three Plots will appear - one for each of the Hysteresis measurements. The 5.0-Volt meas-
urement should show ~50.0 µC/cm 2 polarization.  
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Figure 1 - 5.0-Volt Hysteresis Execution Data.  

 
Step 6 – Repeat the Measurement as Desired.  

 
Review the Archived Data as desired.  
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I - Add a Composite Filter 
 
I.1: Discussion  
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision testers, when 
shipped. It is detailed here. A 2.5 MΩ Internal Reference Resistor and/or a 1.0 nF Linear Inter-
nal Reference Capacitor may also be switched into the signal path. Or the user's own sample 
may be connected to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelec-
tric capacitor pair is available on all testers except the Precision RT66B and the original Preci-
sion LC. The Precision RT66B offers no internal reference elements. Both of these tester models 
have been discontinued.  
 
This tutorial adds a fourth Collect/Plot Filter to the Test Definition that is under construction in 
the Editor and being studied in the DataSet. This Filter takes its input from all three preceding 
Hysteresis Tasks. The composite data are stored together under the Filter in the DataSet Archive 
and are displayed together on the plot that is presented on execution or when the Filter is recalled 
from the Archive. Many of the steps discussed in earlier tutorials are presented briefly and with-
out figures.  
 
I.2: Add the Composite Filter.  
 
Step 1 – Move a Collect/Plot Filter Task from the TASK LIBRARY to the EDITOR.  

 
Configure as follows:  

 
1.  Collect/Plot Filter Setup Tab:  

 
Task Name:  "Tutorial Composite Hysteresis Data"  
Data Type:  Hysteresis  
Task Selector:  3.0-Volt, 4.0-Volt and 5.0-Volt Hysteresis. To select multiple consecutive Tasks, 

select the first Task, then hold the <Shift> key down and select the last Task. To 
select multiple, non-consecutive Tasks, select the first Task, then hold the <Ctrl> 
key down and select the other Tasks, one-by-one.  

Click Add Task:  Note that the Task Selector indicates the selected Task with an appended "(X)"  
Comments:  As appropriate  
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Figure 1 - 3.0, 4.0 and 5.0-Volt Hysteresis Data Filter.  

 
2.  Collect/Plot Plot Setup Tab  

 
Plot These Data:  Checked (Enabled)  
Plot Title:  "Composite Hysteresis – 3.0-Volt, 4.0-Volt and 5.0-Volt Data"  
Plot Subtitle:  "Tutorial #1b Demonstration for the Vision Help Pages"  
Plot X-Axis Label:  "Voltage"  
Plot Y-Axis Label:  "Polarization (µC/cm2)" Note: to type a "µ" character, hold the "Alt" 

key down and type 0181.  
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Figure 2 - Plot Configuration.  

 
Click OK to record the changes into the Task in the Test Definition.  

 
Step 2 – Save the Test Definition to the Library.  

 
Right-click in the Editor and select "Test Definition to Customized Tests Folder " or select 
"Editor-> Test Definition to Customized Tests Folder". Name the Customized Test "Tutorial 
#1b5". Experiment with recalling the Customized Test into the Editor. As a final step, clear 
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the Editor of all Tasks and recall the Customized Test one last time to return to a Test Defini-
tion consisting of seven Tasks, three Hysteresis/Filter pairs and the composite Filter Task.  

 
Step 3 – Move the Editor Test Definition to the DataSet CTD.  

 
Rename the CTD "Tutorial #1b - Run 6 - Multi-Volt Composite Data".  

 
Step 4 – Run the Experiment.  

 
Note that some of the plot windows may need to be closed, minimized, resized or moved in 
order to locate the DataSet Log window and give the DataSet focus to enable execution. Four 
plots will now appear. The first three will be the same as described in Tutorials I-F, I-G and 
I-H. The fourth plot will contain a copy of all three measurements. Since these are straight-
line plots, they will overlay. However, they are plotted in different colors, so all three traces 
should be visible.  

 

  
Figure 3 - 3.0, 4.0 and 5.0-Volt Hysteresis Data.  

 
Step 5 – Rerun the Experiment as Desired.  

 
Recall Archived data as desired.    

 
I .3: Tutorial I-I Lessons Learned.  
 

In the tutorial you:  
 

1.  Learned to associate the Filter Task with more than one input data source.  
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J - Add a Filter-Sourced Filter 
 
J.1: Discussion  
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision testers, when 
shipped. It is detailed here. A 2.5 MΩ Internal Reference Resistor and/or a 1.0 nF Linear Inter-
nal Reference Capacitor may also be switched into the signal path. Or the user's own sample 
may be connected to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelec-
tric capacitor pair is available on all testers except the Precision RT66B and the original Preci-
sion LC. The Precision RT66B offers no internal reference elements. Both of these tester models 
have been discontinued.  
 
Tutorial I-J adds a final Task to the experimental Test Definition that has been investigated 
throughout the Tutorial I series. This is another Collect/Plot Filter. This Filter collects no new 
data, but demonstrates that the input data source for a Filter can be another Filter. This Filter 
takes its input data from the composite-source Filter added in Tutorial I-I.  
 
J.2: Add and Exercise the Filter-Sourced Collect/Plot Filter.  
 
Step 1 – Drag-and-Drop the Collect/Plot Filter Task from the Library to the Editor.  

 
Configure as follows:  

 
1.  Collect/Plot Filter Setup Tab:  

 
Task Name:  "Filter-Sourced Multi-Volt Hysteresis Data"  
Data Type:  Collect/Plot Filter  
Task Selector:  Tutorial Composite Hysteresis Data  
Click Add Task:  Note that the Task Selector indicates the selected Task with an appended "(X)"  
Comments:  As appropriate  
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Figure 1 - Filter Data Source Filter Configuration.  

 
2.  Collect/Plot Plot Setup Tab  

 
Plot These Data:  Checked (Enabled)  
Plot Title:  "Composite Hysteresis – Filter Data Source"  
Plot Subtitle:  "Tutorial #1b Demonstration for the Vision Help Pages"  
Plot X-Axis Label:  "Voltage"  
Plot Y-Axis Label:  "Polarization (µC/cm2)" Note: to type a "µ" character, hold 

the "Alt" key down and type 0181.  
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Click OK to record the changes into the Task in the Test Definition.  

 
Step 2 – Save the Test Definition to the Library.  

 
Right-click in the Editor and select "Test Definition to Customized Tests Folder " or select 
"Editor-> Test Definition to Customized Tests Folder". Name the Customized Test "Tutorial 
#1b6". Experiment with recalling the Customized Test into the Editor. As a final step, clear 
the Editor of all Tasks and recall the Customized Test one last time to return to a Test Defini-
tion consisting of eight Tasks, three Hysteresis/Filter pairs and the composite and Filter-
sourced Filter Tasks. 

 
Step 3 – Move the Editor Test Definition to the DataSet CTD.  

 
Rename the CTD "Tutorial #1b - Run 7 - Filter-Sourced Filter Data".  

 
Step 4 – Run the CTD.  

 
Note that some of the plot windows may need to be closed, minimized, resized or moved in 
order to locate the DataSet Log window and give the DataSet focus to enable execution. 
Clicking <Ctrl-W> will close all open plots. On execution, five plots will appear. The first 
four will be the same as described in steps I-F, I-G, I-H and I-I. The fifth plot will contain a 
copy of all three measurements, just as the fourth plot. However, the data source for this plot 
will be the preceding Filter and not (directly) a measurement Task or Tasks. Since these are 
straight-line plots, they will overlay. However, they are plotted in different colors, so all three 
traces should be visible.  
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Figure 2 - Filter Data Source Filter Data.  

 
Step 5 – Rerun the Experiment as Desired.  

 
Recall Archived data as desired.    

 
J .3: Tutorial I-J Lessons Learned.  
 

In the tutorial you:  
 

1.  Learned to associate the Filter Task a preceding Filter Task as the input data source.  
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K - Add an ETD Note 
 
K .1: Discussion  
 
To this point in the discussion of Vision, all documentation related to Tasks, DataSets and Test 
Definitions is configured and fixed prior to CTD (or QuikLook) execution and archiving. No tool 
has been presented that allows documentation after the fact. This capability, however, is espe-
cially important since, once CTDs are executed, a DataSet's Archive becomes fixed. New ETDs 
may be appended. But there is no way to remove an ETD, or move it up or down in the Archive. 
If a Task or Test Definition is misconfigured or a CTD executed in error, it still becomes a part 
of the permanent record.  
 
A tool is provided that will allow the user to annotate an ETD after it is established in the Da-
taSet Archive. Any ETD may have a single ETD Note associated with it. The note includes an 
automatic date, a brief title and up to 2000 characters of Rich Text formatted text. The note is not 
stored in the DataSet Archive, but is composed of two files (*.txt and *.rtf) located in 
C:\Program Files\Radiant Technologies\Vision\System\Notes. The two file names are derived 
from both the DataSet Name and the ETD name, including the incremental index. A note's files 
will normally be named uniquely, so that the ETD can determine if the file pair exists. As exter-
nal files, these may be edited or removed independent of Vision, though it is highly recommend-
ed that the Vision interface be used to maintain the various Notes. (Note that changing a Note's 
file names will disassociate the file from the ETD.)  
 
Any time a DataSet Archive is refreshed - by opening the DataSet, executing a Test Definition or 
adding an ETD Note - each ETD searches the location for an appropriately named file pair. If the 
files are not found, a note may be added. If the files are found, the ETD changes its icon from 
green to blue, with a superscripted 'n' and the note may be reviewed, edited (appended to or 
overwritten) or deleted.  
 
K.2: Add an ETD Note  
 
Step 1 – Initiate the Note.  

 
Open the DataSet Archive and select any of the Executed Test Definitions (ETDs). Right-
Click and select "Add Note" from the popup menu.  
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Figure 1 - Select "Add Note" in the Popup Menu.  

 
Step 2 – Edit the Note.  

 
The ETD Note dialog of Figure 2 appears. The dialog has a read-only unlabeled date/time 
field. The field is automatically initialized. Two blank edit fields are available and used for 
the Note title and the main text. The title should be limited to a brief description. The main 
text field is limited to 2000 characters. It is a Rich Text control that allows the text to be for-
matted. It does not allow OLE objects to be embedded. Add a title and text to the notes. For-
mat the text using the menu options as desired.  
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Figure 2 - Create the Note.  

 
Step 3 – Add the Note to the ETD.  

 
Click OK to close the ETD Note dialog. The DataSet Archive will close as it is refreshed. 
Open the Archive. The ETD icon will show as blue with a superscripted "n", indicating that 
the ETD has found the appropriate files and a Note is available.  
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Figure 3 - Refreshed DataSet Archive.  

 
Step 4 – Prepend Text to the Note.  

 
Select the ETD with the Note, right-click and select "Edit Note" from the popup menu.  
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Figure 4 - Select "Edit Note" in the Popup Menu.  

 
The Note Edit dialog will appear. Two check boxes will appear labeled Append and Over-
write. The Date/Time control will show the current date and time. The Title control will be 
blank. Ensure that Append is checked. With Append checked, the text field in the dialog will 
be written with the existing note. Prepended to that text will be the original date, followed by 
the original file. Checking Overwrite , will completely clear the text field. Reselecting Ap-
pend will, once again, fill the field with the text and the prepended date/time and title. To 
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work properly, new text should be prepended to the top of the control, before the inserted 
date/time. However, there is no constraint on the control (other than the 2000 character lim-
it). Existing text may be edited in any way. (Editing existing text may be practical if a note is 
edited many times and begins to approach the 2000 character limit.) A new title should also 
be provided. Click OK to update the Note.  

  

   
Figure 5 - Edit Existing Note in Append Mode.  

 
Reopen the Note in Edit, Append mode. The updated note will appear with the second 
date/time and title prepended. In this way, a chronological series of annotations may be in-
corporated into the note, with the most recent addition at the top. (Note that a vertical scroll 
bar appears automatically when the note extends below the control field.) Close the note us-
ing the Cancel button.  
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Figure 6 - Reopen Note in Edit/Append Mode.  

 
Step 5 – Review the Note.  

 
Select the ETD with the Note, right-click and select "View Note" from the popup menu.  
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Figure 7 - Select "View Note" in the Popup Menu.  

 
The Note Edit dialog appears with the Append and Overwrite controls again hidden. The 
Date/Time control displays the date/time of the most recent update. The Title control will 
display the title read-only mode. The main text is updated to the main control. That control is 
also read-only, although it appears with white background. Note that the reviewed note of 
Figure 8 does not include the prepended date/time and title of Figure 6 in the main text field. 
These values are displayed in the Date/Time and Title controls. If the dialog of Figure 6 had 
been closed using the OK button, these values would also appear in the main text since they 
would have been stored integrally with that text.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 104 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

   
Figure 8 - Review an Existing Note.  

 
Step 6 – Print and Export the Note.  

 
With the Note dialog open, select File->Export and File->Print. The export option will open 
a standard Windows browser dialog. User the dialog to navigate to an appropriate location 
and assign an appropriate file name. The path and file name will be used to write a text-only 
(no font formatting) copy of the date/time, title and main text to a text file. If an existing file 
is selected, it will be appended to. The print option will send the text-only values to the print-
er, opening a standard Windows printer configuration dialog first. The printout will use val-
ues configured in Task exporting for left margin, line spacing and tab spacing.  

 
J .3: Tutorial I-J Lessons Learned.  
 

In the tutorial you:  
 

1.  Learned to add an ETD Note to any ETD in the DataSet Archive.  
2.  Learned to prepend text to an existing note.  
3.  Leaned to review an existing note.  
4.  Exported the Note to a new text file and to a printer.  
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L - Adjust ETD Markers 
 
L.1 - Discussion 
 
Most Executed Test Definitions (ETDs) are stored under the DataSet Archive with the  icon. 
As shown in the previous section, ETDs that have an ETD Note associated with them are flagged 
by the  icon. In future sections this document will show that ETDs that result from Data Min-
ing, ETD Transfer, Immediate General Information and Immediate Hyperlink also have unique 
DataSet Archive icons to set them apart. 
 
The user also has three optional icons available that may be associated with any ETD to custom-
ize and flag its appearance. These are, by name: 
 

•  : Error 
•  : Important 
•  : Special Attention 
 

The names are strictly labels for the three icons and the user may assign any meaning that is pre-
ferred.  
 
L.2 - Set an Error Marker 
 

Right-click on "Tutorial #1b - Run 7" and select "Add Marker->Error" from the popup menu. 
The ETD will refresh (the Archive folder will close). When the Archive folder is reopened, 
the selected ETD will show the  icon. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 106 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
Figure 1 - Select the Error Icon for "Tutorial #1b - Run 7" 
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Figure 2 - "Tutorial #1b - Run 7" Marked with the Error Icon . 

 
Experiment with the Important and Special Attention icons. When finished, select "Add 
Marker->Reset" to clear the icons if desired. 
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M - Append a General Information Task 
 
M .1: Discussion  
A key mandate in the Vision program is that it be immediately, completely and automatically 
self-documenting. Task Names, ETD/CTD Names, Task Comments and Plot Labels provide 
permanent archived documentation of a Test Definition (experiment) and its component Tasks. 
Additional documentation tools include The General Information Task, the Hyperlink Task and 
the Runtime Label/Timed Runtime Label Tasks. In particular, the General Information Task al-
lows for extensive documentation of the purpose and construction of an experiment. 
 
All of these tools are incorporated into the experiment design, either in constructing or in naming 
the Test Definition. All presume foreknowledge of the procedures and, perhaps, outcomes of the 
experiment. Or, in the case of the Runtime Label Task, the need for runtime documentation is 
predicted. However, it is clear that there will be times in which documentation may need to be 
applied to a Test Definition after it has executed, especially if some unforeseen result occurs. 
The ETD Note and user-selected ETD Icons (ETD Markers) already discussed are just such post-
execution documentation tools. Another option would be to configure more documentation - 
such as a General Information and/or Hyperlink Task(s) - into a Test Definition to be executed 
immediately following the ETD that is to be documented. 
 
Vision offers shortcuts to configuring and executing General Information and Hyperlink Tasks in 
new Test Definitions. In this section, you will take the shortcut to append a General Information 
Task. 
 
M .2: Append the Task in an ETD  
 
Step 1 – Initiate the Action.  

 
Open the DataSet Archive and select any of the Executed Test Definitions (ETDs). Right-
click and select "Append General Info" from the popup menu.  
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Figure 1 - Select "Append General Info" in the Popup.  
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Step 2 – Configure the Task.  
 

The General Information Task configuration dialog open. Configure the Task as appropriate. 
 

  
Figure 2 - Configure the General Information Task.  

 
Step 3 – Append the Task in an ETD.  

 
Click OK to append the Task. Click Cancel to abort the operation. If the action is allowed to 
proceed the Archive will be updated with an ETD appended to the list. The ETD will have a 

 icon and be named "Appended General Info:x". It contains the configured General Infor-
mation Task as its only entry. 
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Figure 3 - Appended General Information Task ETD.  

 
Step 4 – Review the Task.  

 
As usual, double-click the Task to review. 
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Figure 4 - Recovered Immediate General Information Task. 
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N - Append a Hyperlink Task 
 
N .1: Discussion  
 
Most of the discussion of the General Information Task in the previous tutorial applies to the 
Hyperlink Task. The Hyperlink Task provides an execution-time tool to permanently store links 
to local or networked files and/or to reference URLs. As with the General Information Task, a 
Hyperlink Task can be appended to provide immediate documentation to the DataSet Archive. 
The Task will appear in an ETD without the need to configure it in the Editor or executed it in 
the CTD.  
 
N .2: Append the Task in an ETD  
 
Step 1 – Initiate the Action.  

 
Open the DataSet Archive and select any of the Executed Test Definitions (ETDs). Right-
Click and select "Append Hyperlink(s)" from the popup menu.  
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Figure 1 - Select "Append Hyperlink(s)" in the Popup.  

 
Step 2 – Configure the Task.  

 
The Hyperlink Task configuration dialog open. Configure the Task as appropriate. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 115 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 2 - Configure the Hyperlink Task.  

 
Step 3 – Run the Task.  

 
Click OK to execute the Task. Click Cancel to abort the operation. If the action is allowed to 
proceed the runtime Task execution dialog will appear. Copy and paste browser links and/or 
use the Browse button to add file paths to local documents to Link to Add. Click Add Link to 
insert the link from Link to Add into the unlabeled list of Hyperlinks. Added hyperlinks can 
be clear entirely by clicking Clear List. Any number of selected hyperlinks can be cleared by 
clicking Deleted Select Link. Branch Loop Abort has no application in this use of the Task. 
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Figure 3 - Appended Hyperlink Task ETD.  

 
Step 4 – Update the Archive.  

 
Click OK to close the Task and append it, in its own ETD, to the DataSet.. The appended 
ETD will have the  icon to distinguish it from standard ETDs. 
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Figure 4 - The Hyperlink Task in an ETD Appended to the Archive.  

 
Step 5 – Exercise the Hyperlink Task.  

 
Double-click the Hyperlink Task in the "Experiment Data" folder of the ETD. The configura-
tion dialog will open for review and to allow the Task to be exported. Click OK to close the 
configuration dialog and open the execution dialog. Select any hyper link in the unlabeled 
list. Click Go To/Open Selected Link to go to the selected web page or open the selected doc-
ument.  
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Figure 5 - Exercise the Hyperlink.  
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O - Investigating Plotting Options 
 

O.1: Discussion  
 
In this tutorial, data are recalled from the Tutorial #1b DataSet and presented in a plot window. 
The plot is then altered in various ways to demonstrate the tools available.  
 
O.2: Investigate Plotting Tools  
 
Step 1 – Recall the Filter-Sourced Task data plot.  

 
Open Tutorial #1b Archive. Open Executed Test Definition Tutorial #1b – Run 7 - Filter-
Sourced Filter Data:0. Open the "Experiment Data" folder. Open the "Filter-Sourced Multi-
Volt Hysteresis Data:1" Task by double-clicking it.  

 

  
Figure 1 - Regraph the Filter Data Source Filter Data.  

 
Because of a mismatch between archive input and output in an older version of Vision, it is 
possible that the data recovered from the archive are corrupt. Only a limited distribution in-
cluded this error, but it must be accounted for. For this reason the Corrupt Data Recover dia-
log will appear. In almost all cases, simply click "Yes" to recall the data. The Collect/Plot 
Filter Task configuration dialog will then appear for configuration review. 
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Figures 2 and 3 - Corrupt Data Recovery Dialog and Collect/Plot 

Filter Configuration Dialog.  
 

Close the configuration dialog by clicking Plot. The dialog will close and the data plot will 
appear. Note that the data represented below now come from the 4.0-Volt, 5.0-Volt and 
6.0-Volt measurement of a 100 µm X 100 µm 4/20/80 PNZT sample.  
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Figure 4 - Filter Data Source Filter Data.  

 
Step 2 – Adjust the Grid Lines.  

 
With the cursor in the plot window, click the right mouse button. A menu will appear that 
shows the options for manipulating and customizing the plot.  
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Figure 5 - Right-Clicking on the Plot Surface Produces a Popup 

Menu.  
 

First select "Grid Options>Show X and Y Axes Grid Lines". Grid lines will appear on the 
plot.  
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Figure 6 - Add Grids to the Plot.  

 
Step 3 – Adjust the Plotting Method.  

 
Next select "Plotting Method>Points". Points will be displayed and the plot will "fatten" up.  
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Figure 7 - Set Plotting Method to "Point".  

 
Step 4 – Zoom in on the data.  

 
Now, zoom in on your data. Place the cursor in the upper left corner of an imaginary box that 
will contain only the data of interest. Click and hold the left mouse button. Drag the cursor 
down and right until the data of interest is enclosed in the box. Release the mouse button. 
The area enclosed by the box will be enlarged to fit the viewing field. Zoom in again on a 
subset of the zoomed data.  
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Figure 8 - "Rubber Band" a Region of Interest to Zoom in on Using 

the Left Mouse Button.  
 

  
Figure 9 - Zoomed Data.  

 
Zoom in again...  
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Figure 10 - Re-Select Region of Interest.  

 

  
Figure 11 - Rezoomed Data.  

 
Step 5 – Show Data Points and Labels.  
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With closely zoomed data, right-click and select Mark Data Points , then right-click and se-
lect Include Data Labels. Individual points will appear as dots and their values will be la-
beled to three decimal places.  

 

  
Figure 12 - Add Data Labels to the Plot.  

 
Step 6 – Maximize the Plot.  

 
For a better view, right-click and select Maximize.... The plot will be expanded to fill the en-
tire screen. To return to normal, click in the blue field at the top of the plot or press "Esc".  
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Figure 13 - Maximized Plot View.  

 
Step 7 – Unzoom the Data.  

 
To return to an unzoomed view, right-click and select "Undo Zoom". Data points and labels 
become very obscured, so right-click and select those options again to disable them.  

 
Step 8 – Customization Dialog.  

 
Multiple plotting attributes can be altered at once by right clicking and selecting "Customiza-
tion Dialog…". A dialog with several tabbed pages appears that allows wholesale plot chang-
ing. Some of the options that can be changed include:  
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Figure 14 - The Customization Dialog.  

 
1.  Relabeling plot title and subtitle  
2.  Changing font size  
3.  Adding or removing grids in both X and Y directions  
4.  Changing numeric precision of data  
5.  Changing plot type (line, point, etc.)  
6.  Marking or unmarking data points  
7.  Enabling data shadows  
8.  Changing axis scaling – Automatic or manual, linear or log for X and Y axis inde-

pendently.  
9.  Changing color of certain plot regions.  
10.  Changing color, line type and point type of plotted data.  
 

Please exercise any or all of these options on your tutorial DataSet.    

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 131 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

P - Plot Annotations 
 

P.1- Discussion 
Vision offers the ability to add annotations to any data plotted in a data dialog. (Data, such those 
recalled from Filter Tasks plotted in a plot window cannot have annotations added. This is be-
cause plot windows cannot have menus associated directly with them.) Annotations may be of 
the form:  
 

1.  Line - Solid, dashed or dotted.  
2.  Rectangle - Solid, dashed or dotted.  
3.  Ellipse - Solid, dashed or dotted.  
4.  Text - Tiny, small, medium, large, very large.  
5.  Symbol with Text - Open or filled versions of dot, square, diamond, triangle up, triangle 

down. Also a plus (+) or a cross (X). The user will be offered the opportunity to type text 
to associate with the symbol.  

6.  Symbol without Text - Same as Symbol with Text except no text will be added.  
 
Any of the annotation types may have their colors independently adjusted. Black, blue, red, 
green and yellow are immediately available. Custom colors can also be configured. For most an-
notations, the selection of type and/or color must be made before the annotation is applied. For 
example if a blue dashed line is configured, subsequent lines will be blue and dashed until the 
configuration is changed. The type and color of an existing annotation cannot be changed. One 
exception is text size. If the text size selection is changed, all visible text will have its size 
changed.  
 
Annotations also may not be moved, once placed on the plot. Individual annotations cannot be 
removed. However, a Reset option will remove all annotations from a plot.  
 
Annotations may be placed on data displayed either from a QuikLook measurement or as a result 
of data recall from a DataSet Archive. When annotations are written to a Task that is recalled 
from a DataSet Archive, the annotations will be written to a file located in 
C:\DataSet\Annotations. The file will have a name that is particular to the DataSet, Executed 
Test Definition (ETD) and Task, once the dialog is closed. In that way, the annotations are per-
sistent and will reappear the next time the Task is recalled from the Archive. Removing the file 
will clear the annotations from the plotted data. It is for reasons such as these that Task names, 
CTD names and DataSet names should be unique and descriptive. It is possible that duplicate 
names can cause an annotation file to be associated with the wrong Task. CTD names and/or 
Task names that contain characters that are illegal in file paths and names may cause the annota-
tions to fail to be saved. 
 
Note that the annotations capabilities are offered as a convenience for the Vision user. The limi-
tations specified above show that Vision is not intended to be a general purpose graphical pro-
gram.  

 
P.2 - Configure and Add Annotations 
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All annotation configuration and insertion happens within a dialog that is displaying measured 
data. 
 
Step 1 - Recall Data from any of the Hysteresis Tasks in the DataSet.  

 
Locate and double-click the selected Task in the DataSet Archive.  

 

  
Figure 1 - Locate and Open the Task for Data Review.  

 
Review and close the Task configuration dialog.  
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Figure 2 - Close the Recalled Configuration Dialog.  

 
Configure and close the Plot Setup dialog. Ensure that the Display Tabbed option is un-
checked. Annotations (and cursors) are not yet available from the tabbed data display.  
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Figure 3 - Configure the Plot Type and Labels and Close the Dialog.  

 
The data display dialog appears.  

 
Step 2 - Configure the line type.  

 
In the dialogs menu, go to Configure Annotations->Configure Lines->Line Type->Dotted.  

 

  
Figure 4a - Select the "Dotted" Line Type.  

 
The dialog Annotation indicator will change from "<<Ready>>" to "Line Type Set to Dot-
ted".  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 135 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 4b - The Dialog Annotation Indicator.  

 
Step 3 - Configure the line color.  

 
In the dialogs menu, go to Configure Annotations->Configure Lines->Line Color->Custom.  

 

  
Figure 5 - Select the "Custom" Line Color.  

 
A standard Windows color selection dialog will appear. Use the dialog to select any color. 
Then click OK. 

 

  
Figure 6a - Windows Custom Color Dialog.  

 
The dialog Annotation indicator will change from "Line Type Set to Dotted " to "Custom 
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Line Color Set: Red = rr - Green = gg - Blue = bb". In the example rr = 53, gg = 187 and bb 
= 67.  

 

  
Figure 6b - The Dialog Annotation Indicator Change.  

 
Step 4 - Insert an Ellipse  

 
In the dialog menu, select Add Annotation->Add Ellipse.  

 

  
Figure 7a - Initiate Ellipse Insertion.  

 
The dialog Annotation indicator will change from "Custom Line Color Set: Red = rr 
- Green = gg - Blue = bb" to "Adding and Ellipse Annotation - Left-Click First End 
Point".  

 

  
Figure 7b - The Dialog Annotation Indicator Change.  

 
With the left mouse button, click anywhere on the plot surface. This first click does not de-
fine an annotation limit, but just initiates the plot selection. This additional first click should 
only need to be performed once. There will be no change in the Annotation indicator. Posi-
tion the mouse at one corner of an imaginary rectangle that will define the boundaries of the 
ellipse. Click the left mouse button.  
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Figure 8 - On First Button Click The Dialog Annotation Indicator 

Changes.  
 

The dialog Annotation indicator will change from "Adding and Ellipse Annotation - Left-
Click First End Point" to "Adding and Ellipse Annotation - Left-Click Second End Point". 
Position the mouse at the desired location of the opposite corner of the defining rectangle and 
left-click. The ellipse appears within the rectangular boundaries defined by the two mouse 
clicks. The Annotation indicator is reset to "<<Ready>>".  
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Figure 9 - The Ellipse Appears.  

 
Step 5 - Reconfigure the Line Type  

 
In the dialogs menu, go to Configure Annotations->Configure Lines->Line Type->Thick Sol-
id.  
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Figure 10 - Line Type to Thick Solid.  
 

Step 6 - Reconfigure the Line Color  
 

In the dialogs menu, go to Configure Annotations->Configure Lines->Line Color->Red.  
 

  
Figure 11 - Line Color to Red.  

 
Step 7 - Insert a Line  

 
In the dialog menu, select Add Annotation->Add Line. The Annotation will change to "Add-
ing a Line Annotation - Left-Click the First End Point".  

 

  
Figure 12 - Initiate Line Insertion.  

 
Position the mouse at one end of the desired line and left-click. The Annotation will change 
to "Adding a Line Annotation - Left-Click the Second End Point".  
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Figure 13 - Location of First Line End Point.  

 
Position the cursor at the desired location of the opposite line end point and left-click. The 
line appears in the configured type and color and the Annotation indicator is reset to 
"<<Ready>>".  
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Figure 14 - Line is Inserted.  

 
Step 8 - Configure Text Color  

 
Go to Configure Annotations->Configure Text->Text Color->Blue. The change is indicated 
in Annotation.  
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Figure 15 - Set Text Color to Blue.  

 
Step 9 - Add Text  

 
Go to Add Annotation->Add Text  

 

  
Figure 16 - Initiate Text Insertion.  

 
Annotation will indicate "Adding a Text Annotation - Left-Click Text Location". Position the 
cursor to the position at which the text is to start. Text will be written to the right of that loca-
tion. Click the left mouse button.  
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Figure 17 - Indicate the Position of the Left-Most Character.  

 
A dialog will appear in which up to 48 Characters may be written. Set the insertion text and 
click OK. Note that many Hysteresis PE loops will show a gap between the first and last 
measured points. In the data represented here, the gap is inconsequential. The annotations are 
used for tutorial purposes only. 

 

  
Figure 18 - Write the Text to be Inserted (48 Characters Maximum).  

 
The text will appear. From Figure 19 it is apparent that proper positioning of text will take 
some practice. Note, once again, that Vision is not a drawing program. It makes use of some 
of the tools that are available in the plotting library to offer annotations. The positioning of 
the annotations in these example figures is highly inexact. 
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Figure 19 - Inserted Text.  

 
Step 10 - Set the Symbol Type  

 
Go to Configure Annotations->Configure Symbols->Symbol Type->Solid Triangle Up (or 
other symbol type as desired).  
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Figure 20 - Set Symbol Type to Solid Triangle Up.  

 
Step 11 - Set the Symbol Color  

 
Go to Configure Annotations->Configure Symbols->Symbol Color->Custom and select an 
appropriate color.  
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Figure 21 - Set Symbol Color to a Custom Value.  

 
  Step 12 - Add a Symbol with Text  

 
Go to Add Annotations->Add Symbol (With Text).  

 

  
Figure 22 - Initiate Symbol with Text Insertion.  

 
Position the mouse cursor at the location the symbol is to be inserted. Text will appear to the 
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right of the symbol. Left-Click the mouse.  
 

  
Figure 23 - Specify the Symbol Location.  

 
A text input dialog will appear that allows up to 48 characters, that will accompany the sym-
bol, to be specified.  

 

  
Figure 24 - Specify the Text to Accompany the Symbol.  

 
Specify the Text to be associated with the symbol and click OK . The dialog will close and 
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the symbol and text will appear at the location indicated. Once again, practice is needed to 
properly locate the text.  

 

  
Figure 25 - Symbol with Text.  

 
Step 13 - Recover the Annotations.  

 
Close the dialog. Open a Windows Explorer and examine c:\DataSets\Annotations. A file 
will appear at that location that records the annotations for the particular Task in the particu-
lar DataSet and at a particular date.  
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Figure 26 - Symbol Record File in C:\DataSets\Annotations.  

 
Reopen the Task from the DataSet Archive. Close the configuration dialog. Edit and 
close the plot configuration dialog. When the data appears, the annotations will be 
restored as in Figure 27.  
 

 
Figure 27 - Hysteresis Task Annotations Recovered from Stored Ar-

chive. 
 
P.3 - Tabbed View Annotation Control 
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On the Data Presentation dialog, click Tabbed View. A reduced-sized data presentation appears. 
This consists of two tabs. The first shows the plotted data and the second the configuration and 
measured parameters. The reduced view is intended for laptop presentation and other small dis-
plays. Once selected, the reduced view is permanent until Plot Tab is unchecked in the plot con-
figuration dialog of a Measurement Task. 
 

 
Figure 27 - Tabbed Data Presentation.  

  
The tabbed view does not offer menus. Instead annotation control is assigned to the Add Line, 
Add Text, Add Rectangle, Add Symbol, Add Ellipse, Add Symbol W/Text, Reset and Format An-
notations buttons. Exercise these buttons as desired. 
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Figure 28 - Tabbed View Annotation Control Buttons and Format 

Subdialog.  
 

P.4 - Final Note 
This is a preliminary set of annotation tools. Future development is expected to allow specific 
annotations to be selected. Once selected any particular annotation should be able to be moved, 
reconfigured or removed without adjusting other annotations. For now, the option Add Annota-
tion->Reset will completely remove all existing annotations.  
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Q - Cursors 
 
Q,1 - Discussion 
 
As with annotations, the plotting library used by Vision offers Vision the ability to add cursors to 
plotted data. As with annotations, cursors are available on Data Presentation dialogs. Filter and 
Long-Duration Task data plots do not offer cursors. Finally, as with annotations, the use of cur-
sors in Vision is not a full-featured option. All cursors begin at the first measured data point and 
can only be positioned by moving them, a point at a time, using the arrow keys. 
 
There are four types of cursors: 
 

•  Mouse Display (default): the position of the mouse, anywhere on the plot surface, may be 
displayed in the upper-left corner of the plot. 

•  Vertical Only: A vertical line traces the horizontal position of the cursor. The upper-left 
corner may display the coordinates of the plotted point that the line is associated with. In 
plots such as a Hysteresis PE (or PV) loop, in which there are multiple vertical points at a 
single horizontal position, the line does not indicate which point it is associated with. 

•  Crosshairs: A vertical and horizontal line intersect at the plotted point at which the cursor 
is currently positioned. The coordinates of that point may be displayed in the upper-left 
corner of the plot. 

•  Point: A square point appears at the plotted point at which the cursor is currently posi-
tioned. The coordinates of that point may be displayed in the upper-left corner of the plot. 
 

A "No Cursor" option removes any visible cursor and stops the coordinate display of the cursor 
position at the upper-left corner of the plot. 
 
The user may choose to display X-Data only, Y-Data only, both X and Y-Data or no data at the 
upper-left corner of the data plot. If data are to be displayed, then the data reflect either the cur-
rent mouse position (if Mouse Display is selected) or the position of the visible cursor if Vertical 
Only, Crosshairs or Point is is selected. Not that the displayed data are limited to three significant 
digits. 
 
Q.2 - Display the Mouse Position 
 
By default, both the X-Axis and Y-Axis coordinates of the current mouse position on the plot 
surface are displayed in the plot upper-left corner. With the Hysteresis Data Presentation dialog 
shown, move the cursor about the plot, observing the position. Note that the position and coordi-
nate display are not locked to a plotted data point. 
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Figure 1 - Mouse Position Display.  

 
Select "Data Reporting->X-Only" to show only the horizontal coordinate of the cursor. 
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Figure 2 - Mouse Position Display - X (Horizontal) Position Only.  

 
Select "Data Reporting->Both to return the display to the normal, two-coordinate presentation. 
 
Q.3 - Display the Vertical Cursor 
 
Select "Cursors->Vertical Only". A vertical line appears at the first data point. Use the arrow 
keys to advance the point with which the cursor is selected. Note that, for the hysteretic data plot 
of the PV measurement it is not apparent from the line which point is associated with the cursor. 
The data display presents the exact coordinates of the point. 
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Figure 3 - Vertical Cursor.  

 
Q.4 - Display the Crosshairs Cursor 
 
Select "Cursors->Crosshairs". A horizontal line now intersect the vertical line at the point at 
which the cursor is located. This removes visual ambiguity in the selected point. 
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Figure 4 - Crosshairs.  

 
Q.5 - Display the Point Cursor 
 
The "Cursors->Point" option replaces the point of intersection of the horizontal and vertical lines 
with a single point.  
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Figure 5 - Point Cursors.  

 
Q.6 - Tabbed View Cursor Control 
 
On the Data Presentation dialog, click Tabbed View. A reduced-sized data presentation appears. 
This consists of two tabs. The first shows the plotted data and the second the configuration and 
measured parameters. The reduced view is intended for laptop presentation and other small dis-
plays. Once selected, the reduced view is permanent until Plot Tab is unchecked in the plot con-
figuration dialog of a Measurement Task. 
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Figure 6 - Tabbed Data Presentation.  

 
The tabbed view does not offer menus. Instead cursor control is assigned to the Set Cursor and 
Set Data Display drop-down list boxes. Exercise these boxes as desired. 
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Figure 7 - Tabbed View Cursor Control Drop-Down List Boxes.  
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II - Advanced Vision Operations 
 

A - Overview 
 

Please note that many of the Figures in the following tutorials may appear slightly different 
from the windows that appear to you within Vision as you proceed through the tutorial. 
The software that you are working with changes rapidly and the help files often lag behind 
these changes. The Vision Manual will be updated as quickly and frequently as possible. In 
the meantime, differences between figures and actual windows will not be significant 
enough to affect your use of the tutorial. 
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models. 
 
In the tutorials of series I a number of Vision program concepts and entities were introduced and 
practiced for full understanding. Topics covered included: 
 

1.  Tasks 
2.  The QuikLook Menu 
3.  Hardware Tasks 
4.  Measurement Tasks 
5.  The Library 
6.  Test Definitions 
7.  The Editor 
8.  DataSets 
9.  Current Test Definitions 
10.  The Archive and Executed Test Definitions 
11.  Building a Test Definition 
12.  Updating Tasks in a Test Definition 
13.  Moving a Test Definition into a DataSet 
14.  Running a Test Definition 
15.  Recalling Archived Data 
16.  Filter Tasks 
17.  Adding, editing and deleting ETD Notes. 
18.  Right-click insertion of the General Information Task into a DataSet Archive. 
19.  Right-click insertion of the Hyperlink Task into a DataSet Archive. 
20.  Manipulating Plotted Data. 

 
These topics are enough to make Vision a very powerful custom ferroelectric measurement tool 
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and will serve the needs of most users very well. However, these represent only a small portion 
of the capabilities of the Vision program. This advanced set of tutorials will revisit most of these 
topics and expand on them. In addition, new concepts are presented. The tutorial begins by revis-
iting the QuikLook topic - a subject that was left incomplete because there was no method of 
saving the measured data. This situation is remedied in a number of ways in Tutorial II-B and II-
C. Tutorial II-D constructs a complete retention experiment from just a few well-chosen discrete 
Tasks. The example shows how a practical real-world experiment can be constructed quickly and 
efficiently. Nevertheless, you should note that the experiment of Tutorial II-D has been consoli-
dated into a single Task known as Retain, located in the Library in Hardware->Measurement-
>Long Duration. Tutorial II-E repeats the process of II-D for a complete Fatigue characteriza-
tion. As with retention, the Fatigue Task consolidates the actions of Tutorial II-E into a single 
Task. Subsequent tutorials each attempt to address particular advanced features of Vision and its 
Tasks. 
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B - QuikLook - Saving Data to a DataSet 
 

B.1: Discussion  
In Tutorial I-B your introduction to Vision began with the QuikLook menu and an immediate 
access to Tasks that could measure samples and produced data. However, the introduction was 
incomplete because no method of saving those data was presented. This tutorial remedies that 
deficiency, first by storing the data within Vision by moving them into a DataSet, then by export-
ing the data to target formats outside of Vision. These include the printer, a text file, Microsoft 
Excel and Microsoft Word. (A fifth target, called a Vision data file, will be presented in a later 
Tutorial. Plotted data can also be configured to be exported to a Windows Meta File, a JPEG im-
age file or a bitmap file.) This tutorial begins by duplicating the first six steps of tutorial I-B to 
produce the data to work with.  
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models. 
 
B.2: QuikLook Operation.  
 
Step 1 - Ensure that no connections are made to the Precision Tester DRIVE or RETURN 
ports on the front or rear panels of the tester.  

 
The Radiant Technologies, Inc. 4/20/80 PNZT Internal Reference Ferroelectric A Capacitor 
will be measured. No samples should be connected to the measurement ports. If you prefer to 
measure your own samples, please do not check the Enable Reference Ferroelectric control 
on the configuration dialog. Note that this control is enabled in Figure 2.  
 
Note that, for testers shipped prior to 2014, any selected Internal Reference Element will be 
measured in parallel with any external sample connected to the tester DRIVE and RETURN 
port. For testers dated 2014 or later, selecting an Internal Reference Element will disable the 
measurement of the external sample. In either case, to measure your external sample, no In-
ternal Reference Elements should be enabled. 

 
Step 2 - From the Vision main menu select " QuikLook->Hysteresis Tasks->Hysteresis ".  

 
The QuikLook menu is shown in Figure 1 .  
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Figure 1 - Select the Hysteresis Task from the QuikLook Menu.  

 
Step 3 - Configure The Hysteresis Task.  

 
The Hysteresis Task configuration dialog will appear as in Figure 2 .  
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Figure 2 - The Hysteresis Task QuikLook Configuration Dialog.  

 
Configure the Task as follows:  

 
Task Name:  "5.0-Volt/10.0 ms Hysteresis for Vision Manual Tutorials" 
Max Voltage:  5.0 
Hysteresis Period:  10.0 
Enable Reference Ferroelectric:  Checked (Enabled) 
Cap A Enable: Checked (Enabled) 
All Other Fields:  Default 

 
Click on Set Sample Info. A subdialog appears (Figure 3).   

 

  
Figure 3 - Sample Information Configuration.  
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Add the information as follows: 

 
Sample Name:  "Int. Ref. Ferroelectric" 
Lot ID:  "N/A" 
Wafer ID:  "N/A" 

 
Step 4 - Configure The Hysteresis Data Plot.  

 
Click on the QuikLook Plot Setup tab. The Hysteresis Task plot configuration dialog will ap-
pear as in Figure 4 .  

 

  
Figure 4 - Hysteresis Task Plot Configuration Dialog.  

 
Add the information as follows: 

 
Plot Title:  "5.0-Volt/10.0 ms Hysteresis Task QuikLook Demonstration" 
Plot Subtitle:  "Tutorial II-B: Internal Reference Ferroelectric A Cap." 
Plot X Axis Label:  "Voltage" 
Plot Y Axis Label:  "Polarization (µC/cm2)" 
User Self-Prompt:  "Show the sample PMax (µC/cm2): " 
Parameter to Append to Prompt:  "Hysteresis: PMax" 
Comments:  As Appropriate 

 
The careful documentation shown in these figures was extraneous in Tutorial I-A, since data 
were not to be saved. It was presented as an example of the type of documentation that 
should be maintained in saved data. In this tutorial, the data are to be saved and the detail is 
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appropriate. 
 

Step 5 - Make the Measurement.  
 

Click OK. The configuration dialog will close and the measurement will start. The measure-
ment will be indicated by the extinguishing of the green LED on the tester front panel and by 
"Hysteresis Test: 5.0-Volt Hysteresis" appearing on the Vision status bar at the lower-left 
portion of the main Vision window (Figure 5). A Stop Hysteresis Measurement? button will 
also appear.  

 

 

    
Figure 5 - Vision Status Bar and Stop Hysteresis Measurement? 

Button During Hysteresis Execution.  
 

B.3: Save the Data to a DataSet.  
 
Step 1 - Review the Data, then select "Save to New DataSet" before closing the dialog.  

 
Once the hardware has finished making the measurement, the data will be presented on the 
Hysteresis QuikLook Results dialog as in Figure 6. Review the dialog to familiarize yourself 
with the information presented and the way that it relates to the configuration that was per-
formed. Once you are satisfied with your review, select the "Save to New DataSet" in the un-
labeled list control, then click OK.  
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Figure 6 - Hysteresis QuikLook Response Dialog.  

 
Step 2 - Create a new DataSet.  

 
When the dialog of Figure 6 is closed, the standard DataSet creation dialog will open as 
shown in Figure 7. Configure the DataSet as follows:  

 
DataSet Name:  "Hysteresis QuikLook-to-DataSet" 
DataSet Path:  "c:\datasets\tutorials" 
Initials:  As Appropriate 
Comments:  As Appropriate - Not recommended. 
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Figure 7 - DataSet Configuration Dialog.  

 
NOTE: The DataSet Path control is automatically updated to assign the DataSet Name value 
as the DataSet File Name, with a *.dst extension. "C:\DataSets" is the default root folder. Da-
taSets may be placed anywhere on the Vision host hard disk or on other disks on the Local-
Area Network (LAN). 
 
Click OK to create the DataSet. The process may also be Canceled. 

 
Step 3 - Examine the resulting DataSet.  

 
The DataSet will be created and opened. The dialog will open to allow the CTD to be named 
as in Figure 8. Name the CTD "Hysteresis 5.0-Volt/10.0 ms Data from QuikLook". 

 

  
Figure 8 - CTD Naming Dialog.  

 
The CTD will contain the single Hysteresis Task "5.0-Volt/10.0 ms Hysteresis for Vision 
Manual Tutorials". The Task is configured identically to the QuikLook configuration and is 
ready to be executed in the DataSet. The Archive will contain a single Executed Test Defini-
tion (ETD) named "Hysteresis 5.0-Volt/10.0 ms Data from QuikLook:0". The ETD will con-
tain the single "5.0-Volt/10.0 ms Hysteresis for Vision Manual Tutorials:1" Task. 
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Figure 9 - DataSet Created from QuikLook Hysteresis Execution.  

 
Step 4 - Recall the Data from the Archive.  

 
Open the QuikLook-to-DataSet DataSet Archive, the single ETD and the "Experiment Data" 
folder. Double-click the "5.0-Volt/10.0 ms Hysteresis for Vision Manual Tutorials:1" Task as 
in Figure 9. The initial configuration dialog will open. The dialog will have most controls 
disabled, since they are presented for configuration review. Note that the Task is configured 
as it was for the QuikLook execution. Buttons to subdialogs are enabled so that the configu-
ration of parameters in those dialogs may be reviewed. Click For Task Instructions is availa-
ble and Cancel/Plot continues the data review. Click Cancel/Plot.  
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Figure 10 - Hysteresis Configuration Recalled from the DataSet Ar-

chive.  
 

The configuration dialog closes and a plot configuration dialog opens. All controls are ena-
bled to allow the display of the data, recalled from the Archive, to be configured. Here data 
labels are applied and, for the Hysteresis Task, various data manipulations may be selected. 
Discussion of these manipulations can be found in detail in the Hysteresis Task Instructions 
pages. Configure the labels appropriately, then click OK.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 171 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 11 - Plot Configuration Dialog.  

 
The plot configuration dialog will close and the data presentation dialog will appear. The dia-
log will be identical to that of Figure 6 except for the control unlabeled QuikLook-to-
DataSet list box is not shown.  
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Figure 12 - QuikLook Hysteresis Data Recalled from the Da-

taSet Archive.  
 

Step 5 - Add a second Quiklook execution to this DataSet.  
 

Press <Ctrl-R> to reopen the Hysteresis Task QuikLook configuration dialog. The Task will 
be configured just as it was in the previous execution (Figures 2, 3 and 4). Verify the config-
uration, execute the Task, review the results, select "Save to Open DataSet" and click OK.  

 

  
Figure 13 - QuikLook Data to an Existing Open DataSet.  
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Although there is no apparent change to the CTD, it has been updated with the new execu-
tion, configured just as the old execution. The CTD naming dialog appears. Use the name " 
Hysteresis 5.0-Volt/10.0 ms Data from QuikLook - 2 ".  

 

  
Figure 14 - Name the Second QuikLook Installation into the 

DataSet.  
 

The Archive will be updated with a second ETD named "Hysteresis 5.0-Volt/10.0 ms Data 
from QuikLook - 2 :0". QuikLook-measured data are available for recall and review.  

 

  
Figure 15 - The DataSet Archive is Updated with a Second 

ETD.  
 

Note that a DataSet must be open or this action will fail and the data will be lost.  
 
The next tutorial will address other means of saving QuikLook data.  

 
B.4: Tutorial II-B Lessons Learned.  
 

In this lesson you:  
 

1.  Had additional practice with repeated QuikLook Measurements.  
2.  Learned to move QuikLook data into a new DataSet.  
3.  Reviewed the QuikLook data in the DataSet.  
4.  Learned to write QuikLook data into an existing DataSet.  
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C - QuikLook - Exporting 
 
C.1: Discussion  
 
In Tutorial II-B data measured through the QuikLook menu, normally discarded, were saved by 
writing the Task into a new and then into an existing DataSet. This maintains the data within the 
Vision framework where they can be permanently stored and recalled at any time. Data may also 
be written to target formats outside of Vision. This is known as "Exporting". The first exporting 
method, discussed in Section C.3, is provided as part of the data plotting tool and is available, 
only for Tasks that show plotted data, directly from the data plot surface. This method is useful 
in particular circumstances noted in Section C.3. The second exporting method is programmed 
directly into Vision and provides methods for sending parameters and data, from every Task, di-
rectly to a printer, a text file, a Microsoft Excel window or a Microsoft Word window. All Vision 
exporting is presented in Section C.4. This tutorial begins, in Section C.2, by duplicating the 
actions of B.2 to generate data to be exported. 
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models.  
 
C.2: QuikLook Operation.  
 
Step 1 - Ensure that no connections are made to the Precision Tester DRIVE or RETURN 
ports on the front or rear panels of the tester.  

 
To generalize the tutorial for all customers, the 4/20/80 PNZT Internal Reference Ferroelec-
tric A Capacitor will be measured. No samples should be connected to the measurement 
ports. If you prefer to measure your own samples, please do not check the Enable Reference 
Ferroelectric control on the configuration dialog. Note that this control is enabled in Figure 
2.  

 
Step 2 - From the Vision main menu select "QuikLook->Hysteresis Tasks->Hysteresis".  

 
The QuikLook menu is shown in Figure 1.  
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Figure 1 - Select the Hysteresis Task from the QuikLook Menu.  

 
Step 3 - Configure The Hysteresis Task.  

 
The Hysteresis Task configuration dialog will appear as in Figure 2.  
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Figure 2 - The Hysteresis Task QuikLook Configuration Dialog.  

 
Configure the Task as follows:  

 
Task Name:  "5.0-Volt/10.0 ms Hysteresis for Vision Manual Tutorials" 
Max Voltage:  5.0 
Hysteresis Period:  10.0 
Enable Reference Ferroelectric:  Checked (Enabled) 

Cap A Enable: Checked (Enabled) 
All Other Fields:  Default 

 
Click on Set Sample Info. A Subdialog appears (Figure 3).  
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Figure 3 - Sample Information Configuration.  
 

Add the information as follows: 
 

Sample Name:  "Int. Ref. Ferroelectric" 
Lot ID:  "N/A" 
Wafer ID:  "N/A" 

 
Step 4 - Configure The Hysteresis Data Plot.  

 
Click on the QuikLook Plot Setup tab. The Hysteresis Task plot configuration dialog will ap-
pear as in Figure 4.  

 

  
Figure 4 - Hysteresis Task Plot Configuration Dialog.  

 
Add the information as follows: 
 

Plot Title:  "5.0-Volt/10.0 ms Hysteresis Task QuikLook Demonstra-
tion" 

Plot Subtitle:  "Tutorial II-B: Internal Reference Ferroelectric A Cap." 
Plot X Axis Label:  "Voltage" 
Plot Y Axis Label:  "Polarization (µC/cm2)" 
User Self-Prompt:  "Show the sample PMax (µC/cm2): " 
Parameter to Append to Prompt:  "Hysteresis: PMax" 
Comments:  As Appropriate 
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The careful documentation shown in these figures was extraneous in Tutorial I-A, since data 
were not to be saved. It was presented as an example of the type of documentation that 
should be maintained in saved data. In this tutorial, the data are to be saved and the detail is 
appropriate. 

 
Step 5 - Make the Measurement.  

 
Click OK. The configuration dialog will close and the measurement will start. The measure-
ment will be indicated by the extinguishing of the green LED on the tester front panel and by 
"Hysteresis Test: 5.0-Volt Hysteresis" appearing on the Vision status bar at the lower-left 
portion of the main Vision window (Figure 5). A Stop Hysteresis Measurement? button will 
also appear.  

 

 

  
   

Figure 5 - Vision Status Bar and Stop Hysteresis Measurement? 
Button During Hysteresis Execution.  

 
C.3: Exporting Plotted Data.  
 
Step 1 - Select the Exporting Dialog.  

 
Once the measurement of Section C.2 is completed, the Hysteresis data will appear in a dia-
log as in Figure 6.  
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Figure 6 - Hysteresis QuikLook Data.  

 
Place the mouse cursor within the plot window and right-click. From the popup menu that 
appears, select Export Dialog...  
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Figure 7 - Popup Menu with Export Dialog... Selected.  

 
Step 2 - Select the Clipboard Windows MetaFile (WMF) Exporting.  

 
A number of options are available including exporting of the data as text to the clipboard or 
to a file. This option is better met by using the Vision-specific exporting features discussed in 
Section C.4. Data may also be exported to a bitmap on the clipboard or in a file. However, 
the most practical use of this exporting tool is to copy an image of the data directly into an-
other program such as Microsoft Word or PowerPoint. Select Export->WMF and Export 
Destination-> ClipBoard . Click Export to buffer the MetaFile.  
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Figure 8 - Export Dialog - Export a MetaFile to the Clip-

Board.  
 

Step 3 - Use the MetaFile.  
 

Open a Microsoft program such as Word, Excel or PowerPoint. In the empty document select 
Edit-> Paste or press <Ctrl-V>. The image of the plotted data, including labels will appear. 
Note that this is a convenient tool because the image can be resized. All text and data will 
scale properly. Note that the original QuikLook data dialog, outside the limits of the plotted 
data, does not appear. The dialog will also not appear if the plot is saved as a bitmap.  
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Figure 9 - Metafile used in a Microsoft Word Document.  

 
C.4: Vision Export Tools.  
 
The export process described in Section C.3 is very useful for quickly moving a dynamic image 
of the plotted data into a common Microsoft Office tool. This is especially helpful in publica-
tions, demonstrations and presentations. However, there are two significant limitations to this 
method: Task configuration information, such as Hysteresis speed or amplification level are not 
available and only Measurement or Filter Task data can be exported in this fashion. Normally the 
user will be most interested in exporting measured data, but Vision provides a set of tools for ex-
porting any Task and maintaining a full record of all pertinent Task configuration information as 
well as data that are the result of Task execution. 
 
Step 1 - Export the Hysteresis Data to a Printer.  

 
Perform this step if your host computer (Precision USB testers) is connected to a printer. If 
the QuikLook Hysteresis data presentation dialog is not open, press <Ctrl-R> to reopen the 
Hysteresis QuikLook configuration dialog, then click OK to execute the Task. When the data 
dialog of Figure 6 appears, click Export. The dialog of Figure 10 will appear. Note that with 
the "Print" option selected, Browse for File Name is disabled. 
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Figure 10 - Export Dialog with Printer Option Selected.  

 
Ensure that "Print" is selected in the Select Option control. Header Only should be checked. 
When checked all pertinent Task configuration parameters will be printed, but no data. If un-
checked, the Task will send, line-by-line, the Time, Voltage and Polarization data for each of 
the 1001 measured sample points, resulting in a document of 20 or more pages. Adjust the 
Line Spacing, Left Margin and Tab Spacing controls to format the output to your printer. 
Some experimentation may be necessary to correctly identify these values. Once these values 
are established, they are written to the registry and become permanent. Click OK. The output 
will not begin until the data presentation dialog of Figure 6 is closed. At that time, a standard 
Windows printer configuration dialog, similar to that of Figure 11, will appear. The print job 
can be configured or Canceled at that dialog. 
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Figure 11 - Windows Printer Configuration Dialog.  

 
Step 2 - Export the Hysteresis Data to a Text File.  

 
This option is available to all Vision users. It does not require addition hardware (as does 
printing) or software (as does Microsoft Excel or Microsoft Word exporting). In this case the 
Task configuration parameters and measured data are written to a standard, tab-delimited text 
file. This file can be reviewed (and edited) in Notepad or any such text editor. It can be im-
ported into Excel, Origin or any spreadsheet or data manipulation program where the data 
can be analyzed, plotted, etc. 
 
With the QuikLook data displayed, click Export. Choose "Export Text" in the Select Option 
control. The Browse for File Name control will be enabled. Click it to open a standard Win-
dows browser. Navigate to an appropriate folder, assign a file name and click Save. The 
browser will close and the Export dialog will show the file path and file name in the File 
Name control. This is a read-only control that requires the browser to be updated. Click OK 
to return to the QuikLook data display dialog. The file will not be written until the QuikLook 
data dialog is closed. Note that with the "Export Text" option selected, the irrelevant controls 
Header Only, Line Spacing, Left Margin and Tab Spacing are hidden. 
 
Text output delimiters are under user control in the drop-down list box Column Delimiter. 
The selected delimiter may not make columns line up visibly with their headers or justify pa-
rameters. But they are recognized by Excel or other data processing program when importing 
the text data and data will be placed properly into columns in such a program. 
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Figure 12 - Text Exporting Sequence.  
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A portion of the resulting text output is shown in Figure 13. 
 

  
Figure 13 - Sample Hysteresis Task Text Export Output.  

 
Step 3 - Export Directly into Excel.  

 
This option requires that Microsoft Office/Excel 2000 or later be installed on the host com-
puter. Note that this export uses the *.XLSX file format.   

 
When exporting to Excel from the QuikLook plot dialog, the Excel program is opened and 
data are written directly to it in formatted fashion. A file path and file name may be assigned 
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to the Excel document in the Export dialog. This is not required to initiate the export, alt-
hough if the file path and name are not assigned, the Excel program will prompt to assign 
them when it is closed. 
 
From the QuikLook plot dialog click Export. Select "Export Excel" from Select Option. Note 
the following adjustments to the dialog: 

 
1.  Browse for File Name is enabled. 
2.   Header Only, Line Spacing, Left Margin, Tab Spacing and Column Delimiter are hidden 

 
Click Browse for File Name. A standard Windows file browser dialog opens. Navigate to an 
appropriate folder, assign a file name and click Save. The browser will close and the export 
dialog will have the File Name control updated to show the file path and name. This control 
is read-only and can only be updated by using the browser. This step assigns a file path and 
name to the Excel document. It will be immediately saved to that path and name once it is 
completely written. This step is optional. 
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Figure 14 - Excel Export Sequence.  

 
Click OK in the export dialog. The export process will begin once the QuikLook data plot di-
alog is closed. Sample output is shown in Figure 15. 
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Figure 15 - Sample Excel Export Output.  
 

Step 4 - Export Directly into Microsoft Word.  
 

This process is very similar to exporting to Microsoft Excel. It also requires that Microsoft 
Office/Word 2000 or later be installed on the host computer. Note that this export uses the 
*.DOC file format. This format can still be read by all versions of Microsoft Word. 

 
When exporting to Word from the QuikLook plot dialog, the Word program is opened and 
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data are written directly to it in formatted fashion. A file path and file name may be assigned 
to the Word document in the Export dialog. This is not required to initiate the export, alt-
hough if the file path and name are not assigned, the Word program will prompt to assign 
them when it is closed. 
 
From the QuikLook plot dialog click Export. Select "Export Word" from Select Option. Note 
the following adjustments to the dialog: 

 
1.  Browse for File Name is enabled. 
2.  Line Spacing, Left Margin, Tab Spacing and Column Delimiter are hidden 
3.  Header Only is shown. 
 
Check Header Only. If this control is disabled, each of the 1001 Hysteresis sample points 
will be written, line-by-line, to the document. The result will be a document of more than 20 
pages. 
 
Click Browse for File Name. A standard Windows file browser dialog opens. Navigate to an 
appropriate folder, assign a file name and click Save. The browser will close and the export 
dialog will have the File Name control updated to show the file path and name. This control 
is read-only and can only be updated by using the browser. This step assigns a file path and 
name to the Word document. It will be immediately saved to that path and name once it is 
completely written. This step is optional. 
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Figure 16 - Export Dialog Configured for Word Exporting.  

 
Click OK in the export dialog. The export process will begin once the QuikLook data plot di-
alog is closed. Sample output is shown in Figure 17. 
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Figure 17 - Sample Word Export Output.  

 
Step 5 - Export to a Vision Data File.  

 
This option is available to certain Measurement and Filter Tasks including all of those Meas-
urement Tasks that appear in the QuikLook dialog. This is a simple but powerful tool that 
writes Task configuration parameters and measured data to a highly-formatted binary file. 
Subsequent executions of the Task can be programmed to read the data from the file rather 
than making a measurement. This allows data from a single execution to be passed into any 
number of Test Definitions in any number of DataSets at any time. This is another method of 
passing QuikLook data into DataSets or to allow data acquired in a DataSet to be shared 
among other DataSets as shown in Figure 18. 

 
With the addition of Data Mining and ETD Transfer, this option may be inconvenient for 
large-scale data transfer. More detail is provided about this option in Tutorial IV. 
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Figure 18 - Utility of Vision Data File Exporting.  

 
To perform the export, open the export dialog from the QuikLook plot dialog and set Select 
Option to "Export Vision". The follow changes take place in the dialog. 
 
1.  Browse for File Name is enabled. 
2.  Header Only, Line Spacing, Left Margin and Tab Spacing are hidden. 
 
A file path and file name must be provided. Click Browse for File Name to open the standard 
Windows file browser dialog. Navigate to an appropriate folder, add a file name (the name 
will automatically take on the extension *.vis) and click Save. The file path and file name 
will appear in the File Name control. This is a read-only control that must be written my us-
ing the Browse for File Name button. 
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Figure 19 - Export Dialog Configured to Write a Vision Da-

ta File.  
 

Once the Export and QuikLook plot dialogs are closed, the file will be written. Since this 
process is unremarkable, it can best be validated by rerunning the Hysteresis Task and con-
figuring it to recall data from a file, rather than making the measurement. Open the Hystere-
sis Task configuration dialog from the QuikLook menu. Name the Task "Vision File Input". 
Click Set Hysteresis VDF Import. This opens a subdialog that is used to enable the VDF im-
port and browse to the file path and existing file name to import. Close the configuration dia-
log. Note that most controls are disabled by this action. That is because the Task configura-
tion parameters will be read from the file. The VDF file path and file name are displayed be-
neath Read Data From Vision File. Read Data From Vision File is checked. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 195 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 20 - Hysteresis Task Configured to Read from a Vi-

sion Data File.  
 

The QuikLook Plot Setup tab is accessible in the dialog of Figure 20. In this case, the con-
trols are not disabled because there is no mechanism for informing the plot tab that Vision 
Data File input is selected. However, altering the entries in the plot setup tab will not change 
the data labels or formatting in the plotted data since these are also read from the input file. 
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The single exception is the Task's Comments. Current Task comments are kept separately 
from the input file Task's comments and alterations here will appear on the results dialog as 
shown in Figure 21. 

 
Click OK to read the file and produce the data. Once the data are regenerated, they can be 
reexported in any of the export formats described above. 

 

  
Figure 21 - Hysteresis Data Recalled from a Vision Data 

File.  
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Step 6 - Export Directly to a Windows Metafile, JPEG or Bitmap.  

 
A recent addition to the collection of Vision tools is the ability to use the plot's export fea-
tures to write the plot image directly to a Windows Metafile, JPEG File or Bitmap file. This 
can only be done with the data displayed in the dialog. There are two consequences:  
 
1.  The file is exported immediately when the Export dialog button is closed and before the 

Data Presentation dialog is closed.  
2.  A exporting to any second target (Excel, Word, Printer, Text File, VDF) can be config-

ured and executed in a single QuikLook measurement.  
 
An export file must be specified for this export tool. In the Export dialog select "Export 
Metafile", "Export JPEG" or "Export Bitmap". Use the Browse for File Name button to iden-
tify the file path and file name to which the image will be saved.  
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Figure 22 - Configure a JPEG Image Export.  

 
Click OK to effect the export. The main Data Presentation dialog does not need to be 
closed. Open any appropriate program such as Microsoft PAINT, Word, Excel, 
PowerPoint, etc. that can import an image. Add the image to the document.  
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Figure 23 - Hysteresis Data Image Imported into Microsoft 

Word.  
 

C.5: Tutorial II-B Lessons Learned.  
 

In this lesson you:  
 

1.  Learned to export data to a meta file or to a text buffer directly from a Measurement Task 
or Filter Task data display.  

2.  Learned to export formatted Vision data to a printer, text file, Excel workspace or Word 
window.  

3.  Learned to export Measured or Filtered data to a Vision Data File and recover those data 
on a subsequent Task execution.  
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D - Retention Sequence Test Definition 
 

Please note that many of the Figures below may appear different from the windows that 
you see within Vision as you proceed through the tutorial. The software that you are work-
ing with changes rapidly and the Main Vision Manual often lags behind these changes. The 
manual will be updated as quickly and frequently as possible. In the meantime, differences 
between figures and actual windows will not be significant enough to affect your use of the 
tutorial.  
 
This tutorial will build on the DataSet operations of Tutorial I by constructing an experiment that 
involves more-advanced Filtering and Program Control operations. Here, a sequence of Tasks 
will be assembled into a Test Definition that performs a complete Retention test. This Test Defi-
nition will address new concepts such as Branch Looping , Filtering within a Branch Loop and 
Single-Point Filtering. The tutorial will begin by detailing every step in the process, but as steps 
recur they will be included without further detail. It is assumed that you have performed the op-
erations of DataSet Tutorial I and have become familiar with general Vision program operations. 
During the course of this Tutorial you will be constructing a DataSet named "Tutorial #2b1". 
This will be the twin of a DataSet that was provided with the Vision software, named "Tutorial 
#2a1". The provided tutorial may be reviewed and exercised for further detail. 
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models.  
 
Note that this tutorial represents a valid and effective experiment. However, its purpose is to 
demonstrate the advanced Vision tools. For actual experimentation, the Test Definition con-
structed here has been consolidated into the single Retain Task found in the Library in Hard-
ware->Measurement->Long Duration. The Retain Task and this demonstration both make use of 
the PUND measurement to collect data. The Retain Task measurement cannot be altered. How-
ever, the Task sequence detailed here can be used to supplant the PUND measurement with other 
Measurement Task - Hysteresis (P-V), Remanent Hysteresis, Piezoelectric, etcx. - as needed by 
the researcher.  
 
Advance Test Definition, EDITOR and DataSet topics introduced in this tutorial include... 
 

1.  Branch Looping 
2.  More Advanced Data Filtering 
3.  New Tasks 
4.  Clearing the EDITOR 
5.  Removing the most recently added Task from the Test Definition in the EDITOR 
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6.  Recalling a Test Definition from a DataSet Archive to the EDITOR. 
7.  Recalling a Test Definition from a DataSet Archive to the DataSet Current Test Defini-

tion (CTD). 
8.  Recalling a Test Definition from a DataSet CTD to the EDITOR. 
 

Test Procedures  
The basic Retain experiment consists of these steps: 
 

1.  Preset the sample into a polarization (µC/cm2) state using an unmeasured Simple Pulse 
Task. The Task applies a single square voltage pulse to the sample. The sign and magni-
tude of the voltage, along with the Pulse Width (ms), are determined by the user. The 
sign of the pulse voltage determines the preset polarization (µC/cm2) state. 

2.  Delay for a defined period of time (s). During this period a DC bias voltage may be ap-
plied to the sample.  Normally the DC bias will be at 0.0 Volts. If a nonzero voltage is to 
be applied it should be of the same sign as the preset pulse of 1 to maintain the sample's 
polarization (µC/cm2) state.  

3.  Apply a first (measured) simple pulse to read the polarization (µC/cm2) state of the sam-
ple after the Retain period. Polarization (µC/cm2) is read at both the peak pulse voltage 
and at zero Volts after the pulse voltage is removed. Sign, magnitude and pulse width 
(ms) of the read pulse are under the user's specification. Normally, this pulse will be of 
equal magnitude and opposite sign of the preset pulse voltage of 1. This results in a polar-
ization (µC/cm2) switching measurement.  

4.  Apply a second (measured) simple pulse to read the polarization (µC/cm2) state of the 
sample after the first read pulse. Polarization (µC/cm2) is read at both the peak pulse 
voltage and at zero Volts after the pulse voltage is removed. Sign, magnitude and pulse 
width (ms) of the read pulse are under the user's specification. Normally, this pulse will 
also be of equal magnitude and opposite sign of the preset pulse voltage of 1. This results 
in a polarization (µC/cm2) non-switching measurement.  

5.  Repeat 1 through 4 for a user-specified number of sequences. At each new sequence in-
crease the Retain time (s). This is accomplished using a Branch Task as described below 
and here. 
 

This set of basic procedures is augmented, here, by adding three additional Tasks. 
 

1.  The first Task in the Test Definition is a Pause Task. This Task presents a dialog on exe-
cution. This serves as a "Start" button for the retention experiment in the Test Definition. 

2.  The second Task is a General Information Task. This is a documentation Task that it no-
table for its unlimited Comments section. This allows a complete and details discussion 
of the purpose, makeup and configuration of the Test Definition to be archived with the 
data measured by the experiment. 

3.  After the second Simple Pulse Task and before the Branch Task (so that it is contained 
within the Branch Loop) a Single-Point Filter Task is placed. This Task records the 
measured polarization (µC/cm2) from both measurement pulses as a function of the reten-
tion time as the time is adjusted in the Branch Loop. 
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Step 1 – Begin Test Definition Programming – Add a Pause Task. 
  

1.  If there are any Tasks in the EDITOR window, remove them by pressing <Ctrl-A>., 
2.  In the TASK LIBRARY open the "Program Control" Folder. 
3.  With the left mouse button, click on the "Pause" Task icon. While holding the left mouse 

button move the Cursor into the EDITOR window and release the mouse button. The 
Pause Task configuration dialog will open. This procedure is known as "Drag-and-Drop". 
Note that the "Pause" label follows the cursor during Drag-and-Drop. Another option is 
to right-click on the Pause Task in the Task Library and select "To Editor" from the 
popup menu. Ensure that the Pause Task is being selected. It is easy to move the wrong 
Task. 

 

  
Figure 1 - Add the Pause Task to the Test Definition.  

 
4.  Configure the Pause Task as follows... 
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Task Name:  "Tutorial #2b – Retain - Pause for User Start"  
User Self-Prompt:  "Press <Enter> to Begin Retention"  
Comments:  As Appropriate.  

 
5.  Click OK to add the Pause Task as the first Task in the Test Definition in the EDITOR. 

 

  
Figure 2 - Configuring the Pause Task.  
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Figure 3 - The EDITOR Test Definition with the Pause Task.  

 
Step 2 - Add a General Information Task  
 
The General Information Task is used to configure a few general parameters such as Sample 
Name , Sample Area and Experiment Name. The Task's primary feature is a comment box that is 
not limited in the number of characters. (Most Tasks have Comments fields limited to 511 char-
acters.) This allows for a very detailed description of the experiment. This Task would normally 
be included as one of the initial Tasks in the Test Definition and would not normally be included 
in the Branch Loop that is introduced in this Tutorial. The Task performs no operation on execu-
tion, but stores the documentation it holds into the Archive for review. The General Information 
Task is found in the Task Library Program Control->Documentation folder.  

 
1.  Move the General Information Task to the EDITOR. The Task is in the TASK LI-

BRARY's Program Control->Documentation folder.  
2.  Configure the Task as follows...  

 
Task Name:  "Retention Tutorial Information"  
Experiment Title:  "Tutorial #1b Retention Demonstration" 
Area (cm2):  1e-4 cm2 (Default)  
Thickness (µm):  0.3 µm (Default)  
Sample Name:  "Int. Ref. Ferroelectric"  
Lot ID:  "N/A"  
Wafer ID:  "N/A"  
Experiment Discussion (Comments):  As Appropriate  
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Figure 4 - General Information Task Configuration.  

 
Step 3 – Add a Preset Simple Pulse Task  

 
1.  In the Library, open the folders "Hardware", "Measurement" and "Pulse" and move the 

"Simple Pulse" Task to the EDITOR. 
2.  Configure the Task as follows... 

 
Task Name:  

  "-9.0-Volt/10.0 ms Retention Preset Pulse"  
Pulse Volts:   -9.0 
Pulse Width (ms):  

 10.0  
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Read: 
 Unchecked  

Enable Reference Ferroelectric:  
  Checked  

Cap A Enable: 
 Checked 

Auto Amplification:   Unchecked 
Comments:  As Appropriate  

 
Note that the Sample Name, Lot ID, Wafer ID, Area (cm2) and Thickness (µm) are persistent 
from the General Information Task. These can be reviewed by clicking Set Sample Info. The 
Enable Ref. Cap. selection will become persistent after this Task is configured and added to 
the Test Definition. The Simple Pulse Tasks is found in Task Library->Hardware-
>Measurement->Pulse. 

 

  
Figure 5 - Preset Simple Pulse Configuration.  
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Figure 6 - Sample Information Sub-Dialog.  

 
Discussion:  
 
Sample Name, Lot ID, Wafer ID , Area (cm2) and Thickness (µm) controls: These values 
were set in the General Information Task configuration and remain persistent throughout the 
configuration of the Test Definition. The information can be accessed by clicking Set Sample 
Info, producing the sub-dialog of Figure 6. Values in the sub-dialog are informational. 
 
Enable Reference Ferroelectric control: This experiment is configured to switch a high pre-
cision 4/20/80 PNZT Ferroelectric Capacitor, manufactured by Radiant Technologies, Inc, 
into the signal path. Checking this control enables the Cap A Enable and Cap B Enable con-
trols. Cap A Enable is checked to switch one of the two available ferroelectric capacitors into 
the signal path. That capacitor will be the test element (DUT) for this tutorial. Ensure that 
there is no sample connected to the Precision Tester DRIVE and RETURN ports. If you pre-
fer, you may attach your sample to the DRIVE and RETURN ports. In that case, rename the 
sample, lot and wafer and ensure that the Enable Reference Ferroelectric control is un-
checked. 
 
Read control: Unchecked. This pulse is used to set the sample to the state to be retained. No 
data are to be collected. 
 
Pulse Width (ms): This is the duration of the pulse from the inital rise from zero Volts to the 
return to zero Volts.  
 
Pulse Volts control: In this experiment, the sample is to retain a negative polarization state. 
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Auto Amplification control: Since this Task is write-only, the return signal is of no conse-
quence. Disabling this control will ensure that only a single pulse is written to the sample. 

 
 Step 4 – Add a DC Bias Task.  

 
1.  Move the "DC Bias" Task from the Library Hardware folder to the EDITOR. 
2.  Configure the Task as follows... 

 
Task Name: 

 "Retention Delay (s)" 
Bias Voltage:  0.0 
Bias Duration:  1 
User Self-Prompt:  "Current DC Bias Time (s): " 
Parameter to Append to Prompt:   DC Bias: Current Time 
Perform Adjustment:  Checked 

Adjust By Scaling:  Selected 
Scale Factor:  2 

 

  
Figure 7 - DC Bias Task Configuration.  
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Discussion:  
 
Sample Name, Lot ID and Wafer ID controls: These values were set in the General Infor-
mation Task configuration and remain persistent throughout the configuration of the Test 
Definition. The information can be accessed by clicking Set Sample Info, producing the sub-
dialog of Figure 6. (Note that although Figure 6 was accessed from the Simple Pulse Task, 
the identical dialog will appear if accessed from DC Bias.) Most values are informational. 
 
Bias Voltage control: Zero Volts will be applied during the retention period. A Delay Task 
would have served just as well as the DC Bias Task. However, using the DC Bias Task, you 
have the option of applying a continuous voltage stress to the sample during the retention pe-
riod. Note that if a bias is applied it should be in the same direction (have the same sign) as 
the Preset Pulse voltage or the sample will switch with the application of the bias and the 
state opposite that intended will be retained. 
 
Bias Duration, Perform Adjustment, Adjust By Scaling and Scale Factor controls: the Reten-
tion test will be a repeated delay (retain) and measure operation. The repetitions will be per-
formed by including the delay (DC Bias) and measurement (Simple Pulse) Tasks in a Branch 
Loop. To create an effective experiment, the delay (DC Bias) will begin at 1.0 seconds and 
increase every time through the loop. It will be increased by multiplying the previous delay 
by a factor of 2.0, so that the delays will be 1.0 seconds, 2.0 seconds, 4.0 seconds, 8.0 sec-
onds and so on. Note: The DC Bias duration is in whole (integer) seconds. The scale fac-
tor is real-valued. A scale factor of, for example, 1.5 is quite valid. So would be a reduc-
ing scale factor such as 0.75. However, since the duration is in whole integers any frac-
tional value is truncated. As a result, if the initial duration is 1 second and the scale val-
ue is less than 2.0, the duration will not increase. Initial value = 1 second, 2nd duration = 
1 * 1.5 truncated to 1, etc. In this case the initial value should be set at 2 seconds. The 
table shows a few initial values and their minimum increasing scale factors.  
 

Initial Value Minimum Scale Factor 
1 2.0 
2 1.5 
3 1.34 
4 1.25 
5 1.2 
6 1.17 

 
Parameter to Append to Prompt and Prompt String controls: These controls combine to pro-
vide you a textual prompt during the progress dialog that is presented while the DC Bias 
Task is executing. A line of text provided by you in the Prompt String control will have ap-
pended to it a User Variable that you select – in this case, "DC Bias: Current Time". (These 
will have a value of 1.0, 2.0, 4.0, etc). User Variables are important features of Vision and 
are discussed in more detail below. 
 

  Step 5 – Add the First Read Simple Pulse Task  
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1.  Move another "Simple Pulse" Task to the EDITOR. 
2.  Configure the Task as follows... 

 
Task Name:  "Retention Read Pulse 1 - Switched" 
Pulse Volts:  9.0 
Pulse Width (ms):  10.0 
Read:  Checked 
Enable Reference Ferroe-
lectric: 

 Checked 

Cap A Enable:  Checked 
Auto Amplification:  Unchecked 
RETURN Signal Amplifi-
cation Level: 

 Select the appropriate level. This can be determined by trial-and-error or 
previous measurements. For example, before running the Test Definition, do a 
QuikLook PUND Task measurement. The results dialog will display the am-
plification level to the lower-left.  
 
NOTE: For this switching pulse measurement it is critical that Auto Amplifica-
tion be disabled and this level manually selected. Otherwise repeated, pre-
measurement pulses will preset the sample positive and this will become an 
unswitched measurement. 

Comments: As Appropriate 
 

  
Figure 8 - Configuration of the First Retention Read Pulse.  
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Discussion:  
 
Read control: Checked. This pulse reads the switching polarization immediately after the re-
tention period. The data are measured and retained. 
 
Pulse Volts control: The first measurement pulse will switch the sample from the negative to 
the positive state, reading the polarization response. 
 
Auto Amplification control: Since this is a measurement, the return signal must be amplified 
to the proper level for measurement. Auto Amplification causes the measurement to be re-
peated until the level is correct. 
 

Step 6 – Add the Second Read Simple Pulse Task  
 

1.  Move a third "Simple Pulse" Task to the EDITOR. 
2.  Configure the Task as follows... 

 
Task Name:  "Retention Read Pulse 2 - Unswitched" 
Pulse Volts:  9.0 
Pulse Width (ms):  10.0 
Read:  Checked 
Enable Reference Ferroelectric:  Checked 

Cap A Enable:  Checked 
Auto Amplification:  Unchecked 
RETURN Signal Amplification 
Level: 

 Select the appropriate level. This can be determined by trial-and-error 
or previous measurements. For example, before running the Test Defini-
tion, do a QuikLook PUND Task measurement. The results dialog will 
display the amplification level to the lower-left.  
 
NOTE: For this nonswitching pulse measurement disabling Auto Amplifi-
cation and manually selecting the amplification level is not critical. 

Comments: As Appropriate 
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Figure 9 - Configuration of the Second Retention Read Pulse.  

 
Discussion:  
 
Pulse Volts control: The second pulse will again collect the sample's polarization (µC/cm2) 
response to a positive voltage, capture nonswitching polarization (µC/cm2). 
 

Step 7 – Add a Plotting Single-Point Filter  
 

1.  Open the "Filters" folder in the Library and move the Single-Point Filter to the EDITOR. 
2.  Configure the Single-Point Filter Task Setup tab as follows... 

 
Task Name:   "Positive Switched and Unswitched Retention Results"  
Data Type:   "Simple Pulse"  
Task Selector:   Using the <Shift> key along with the mouse, select "Retention Read 

Pulse 2 - Unswitched" and "Retention Read Pulse 1 - Switched"  
Add Task:   Click here when the Task Selector has highlighted the two indicated 

Tasks. The Task names will have "(X)" appended to them indicating that 
they are selected.  

Single-Point X Axis Type:   "DC Bias Time (s)"  
Single-Point Data:   "Pulse Top (µC/cm2)" and  

       "Pulse Bottom (µC/cm2)"  
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Add Trace:   Click here when the Single-Point Data have been selected to validate 
the selection  

Comments:  As appropriate  
 

  
Figure 10 - Single-Point Filter Configuration.  

 
Discussion:  
 
Data Type control. Indicates the type of Task that is to be the source for the input data to the 
Single-Point Filter.  
 
Task Selector and Add Task controls: First the Task Selector is used to select all data-
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producing Tasks of the selected type ("Simple Pulse") whose data are to be accumulated. In 
this case, both of the read pulse Tasks are selected. Note that the Tasks are listed in reverse 
order of appearance in the Test Definition. The latest Task added is at the top of the list. The 
<Shift> key can be used along with the mouse to select more than one consecutive Task. The 
<Ctrl> key can be used along with the mouse to select more than one non-consecutive Task. 
Once the appropriate Tasks are selected, clicking Add Task creates the association between 
them and the Filter Task and indicates the selected Tasks in the Task Selector list by append-
ing "(X)" to the Task name. 
 

Single-Point X-Axis Selector control. This control is used to choose the independent variable 
against which the data are to be plotted. Note that the values available change with data type. 
"DC Bias Time (s)" requires that a DC Bias Task appear in the Test Definition before the 
Single-Point Filter Task (as it does here). In this case, each new measurement point will be 
plotted as a function of the duration, in seconds, of the previous DC Bias application. 
 
Single-Point Data and Add Trace controls: The Single-Point Data control is used to choose 
one or more extracted data values to be plotted. The <Shift> key can be used along with the 
mouse to select multiple consecutive parameters. The <Ctrl> key can be used along with the 
mouse to select multiple non-consecutive parameters. Once the appropriate parameters are 
select, click Add Trace to set them in the Filter. Parameters in this list depend on the type of 
input Task selected to provide the plotted data. 
 

2. Configure the "Plot Setup" tab as follows... 
 

Plot These Data:  Checked  
Plot Title:  "Positive Switched and Unswitched Retention Results"  
Plot Subtitle:  "Tutorial #2b-1 - Advanced DataSet Concepts"  
Plot X-Axis Label:  "Time (seconds)"  
Plot Y-Axis Label:  "Polarization (µC/cm2)". Note: to type ‘µ’, press and hold the <Alt> key and 

type 0181.  
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Figure 11 - Single-Point Filter Plotting Configuration. Data Will be 

Plotted as They are Measured During Test Definition Execution.  
 

Discussion  
 
Plot These Data control. This control enables runtime plotting. When enabled, a plot will ap-
pear during the experiment. If disabled, no plot will appear, but the data will be stored and 
recorded and may be recalled for display from the DataSet Archive. 
 
Note that, when the Single-Point Filter is added to the Test Definition, the Retention Read 
Pulse Tasks change their icons to include a small brown rectangle on their lower-right corner. 
This indicates that the Tasks are associated with one or more Filter Tasks that follow them in 
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the Test Definition. See Figure 13, below. 
 

  Step 8 – Add a Looping Branch Task  
  

1.  From the "Program Control->Branching" folder add a "Branch" Task to the Test Defini-
tion. 

2.  Configure the Task as follows... 
 

Task Name:   "Retention Loop Branch - Branch to 2000 s"  
Parameter to Compare:   "DC Bias: Current Time"  
Comparison:   "<= " 
Integer:   2000  
Use Tolerance:   Ensure this control remains unchecked.  
User Variable Limit Selection:   Ensure this selection stays set to "<<None>>"  
Branch Point Task:   "-9.0-Volt/10.0 ms Retention Preset Pulse"  
Select Branch Target:  Click to register the Branch Point Task. 
Comments:  As appropriate  
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Figure 12 - Branch Task Configuration.  

 
Discussion  
Inserting the Branch Task into the Test Definition causes the experiment execution to return 
to an earlier associated Task (the Branch Target - here, the Retention Preset Pulse). The Task 
sequence between the Branch Target Task and the Branch Task will reiterate. The process 
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will repeat until the Branch Logic Condition is no longer satisfied. This feature makes Vision 
a simplified visual programming language. The Branch Logic condition is constructed by 
making a logical comparison between a constant programmed value and a User Variable. 
 

User Variables  
 
User Variables are Vision program elements, maintained by Vision in a list of User Vari-
ables, that consist of a textual name, a type (text, integer, real or Boolean) and a value. 
User Variables are added to the list by Tasks as they are accessed in QuikLook, in the Li-
brary or in a DataSet. The list of User Variables is therefore of variable length depending 
on the number and type of Tasks accessed since the program started.  
 
User Variables serve four purposes:  
 
1.  Establish default values for Task configuration parameters.  
2.  Maintain current values for Task configuration and measurement parameters and es-

tablish persistence of the parameters from-configuration-to-configuration.  
3.  Provide access to program status for user review.  
4.  Provide mechanisms for program control as in the present case of controlling Branch 

Looping.  
 

The Branch Logic comparison is being made between a constant and a User Variable that is 
stored as an integer type. Since that is the User Variable type, the Branch Task configuration 
dialog automatically enables the Integer constant control. The Branch Task also adds its own 
User Variable, called "Loop Counter". This value records the number of times the sequence 
of Tasks has executed and may be used to control Branch Loop termination. Note that care 
must be taken in programming the Branch Task. It is entirely possible to perform a compari-
son with a parameter that will not change so that the Branch Loop will never terminate.  

 
Parameter to Compare, Comparison and Integer controls: A Branch Task is configured by 
comparing a typed User Variable to a user-set constant using a standard comparison operator. 
Here, the Parameter to Compare is the "Current DC Bias Time". This is a User Variable 
added to the variable list by the DC Bias Task. It reflects the duration of the DC Bias in its 
most recent execution. The duration may change in a loop (as here) and so this value may 
change from loop iteration to loop iteration. The Integer control is enabled, since the DC Bi-
as duration is in whole seconds and the User Variable is stored as an integer. The Compari-
son chosen is <=, so that as long as the User Variable is <= the Integer, the Branch Task will 
return execution to the Branch Target Task and another loop will occur. Note that the logic is 
reflected in an unlabeled text box in the center of the dialog for your verification. Since the 
DC Bias Task was configured so that the duration would double at each loop iteration, the 
duration is guaranteed to increase. Eventually the Branch condition will be false and the 
Branch Loop will exit normally. 
 
Branch Point Task and Select Branch Target controls. The Branch Point Task control lists, 
by name, all Tasks that precede the Branch Task that are eligible to be the first Task in the 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 219 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

Branch Loop. The Tasks are listed in reverse order from the Test Definition, so that the Task 
immediately preceding the Branch Task is at the top of this list. Branch Loops may not cross 
or be nested, so that any preceding Branch Task or any Task that precedes a preceding 
Branch Task will not appear on the list. The Retention Preset Pulse is set as the Branch Point 
Task (also known as "Branch Target") so that it, along with the DC Bias, The first and sec-
ond measurement pulses and the Filter, will reiterate. The Task is selected by highlighting it 
in Branch Point Task, then clicking Select Branch Target. The selection is indicated by an 
"(X)" appended to the Task name in Branch Point Task. The Pause Task does not reiterate so 
that after the initial execution, human interaction is not required. In the current configuration, 
the Preset Simple Pulse Task need not be included since the second read pulse also presets. 
However, that would not be a general design, so the loop will include the Preset Pulse. 
 

Note that when the Branch Task is added to the Editor's Test Definition, the Retention Preset 
Pulse Task changes its icon to one with a blue dot in the lower left corner. This is an indica-
tion that the Task is associated with the next Branch Task to follow it in the Test Definition. 
 

  
Figure 13 - Updated Editor Displaying Blue Dot and Brown Rectan-

gle Task Association Icons.  
 

Step 9 – Create the DataSet  

To create the DataSet, first select "File>New DataSet", or click the page icon ( )on the 
toolbar. 
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Figure 14 - DataSet Creation Options.  

 
A dialog will appear. Perform the following actions: 
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Figure 15 - Create the DataSet.  

 
NOTE: The DataSet Path control is automatically updated to assign the DataSet 
Name value as the DataSet File Name, with a *.dst extension. If the DataSet Name 
control is edited, the DataSet Path is automatically fully updated to be "C:\<Current 
Folder>\DataSet Name". This automatic updating may be defeated by using the 
Browse button to assign the file path and file name or by editing directly in the Da-
taSet Path control. "C:\DataSets" is the default root folder. Once changed, the most-
recently assigned file path becomes the default. Folders in the DataSet Path control 
need not exist when the DataSet is created. The folders will be created if they are not 
found. This feature was added at the request of Tohoku University and Michio 
Ohata-san of Nippon Ferrotechnologies. 

 
1.  Type "Tutorial #2b-1" for the DataSet Name. 
2.  The DataSet Path will be set automatically to "c:\DataSets\Tutorial #2b-1" as the Da-

taSet Name is typed. Note that the file name does not have to have the *.dst extension, 
but other functions in Vision look for this extension for DataSets. Once the DataSet 
Name is set, DataSet Path may be adjusted using the Browse button or by typing in the 
control field. 

3.  Place the DataSet in the "Tutorial" folder and the "Retention" subfolder. These fields 
are optional. 

4.  Enter your initials. This provides a reference identity for the DataSet. Any other person 
using the DataSet will know who the designer was. This field is required. 

5.  Type any comments you’d like. This field is optional. 
6.  Click OK. 
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Figure 16 - Retention DataSet Explorer Tab and Log Window.  

 
The DataSet will appear in the DataSet Explorer. A Tab page and log window will appear 
and the DataSet will be opened. 
 

Step 10 – Move the Test Definition into the DataSet  
 
The Task in the Editor represents a complete Test Definition. Move it into the DataSet as the 
Current Test Definition by: 
 

1.  Drag-and-Drop the Editor icon into the DataSet Explorer tab page for the Tutorial #2b-1 
DataSet. Or... 

2.  Click the right mouse button in the Editor window. From the popup menu select "Test 
Definition to Current DataSet". Or... 

3.  In the main menu select "Editor>Test Definition to Current DataSet". 
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Figure 17 - Moving the Test Definition from the Editor to the Da-

taSet CTD.  
 

A dialog will appear to allow you to rename the Current Test Definition. Name the CTD 
"Tutorial Discrete Retention Test 1". 
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Figure 18 - Rename the CTD.  

 
The DataSet Explorer Tab Page will be updated to reflect the new CTD, including the CTD 
name and the list of Tasks that make up the experiment. The DataSet Log window will re-
flect the new activity. 
 

  
Figure 19 - Open DataSet Explorer Tab and Log.  
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Step 11 – Run the Retention  

.  
1.  Select "Dataset>Execute Current Test Definition (CTD) (F1)", or press <F1>. 

 

  
Figure 20 - Run the Current Test Definition (CTD).  

  
2.  Observe the experimental operation. The Pause window will appear immediately on exe-

cution as in Figure 21. Note that the dialog affords the opportunity to stop the Test Defi-
nition from looping. By checking Branch Loop Abort, execution will proceed to the 
Branch Task, but execution from the preset pulse Simple Pulse Task to the Branch Task 
will not repeat. 
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Figure 21 - Pause Task Execution. "Start Button" for the Test 

Definition.  
 

3.  Once the Pause Task is acknowledged, operation will proceed automatically. Two win-
dows will appear during the execution. A progress dialog will show the duration of the 
DC Bias signal (Figure 22). This window will appear for increasing lengths of time as 
the Retention reiterates. Note that the final point will be measured after a delay of 2048 
seconds. It is not until this stress/measure cycle that the Branch Task detects that the cur-
rent delay time is greater than 2000 seconds. As with the Pause Task execution, the 
Branch Looping can be terminated by clicking Abbreviate DC Bias and Abort Branching 
By clicking Abbreviate DC Bias, the current delay period will terminate. Further execu-
tion will proceed normally. The window can be moved to unmask the Filter window be-
low it (Figure 23). The filter window shows the measurements, with a new point being 
added at each loop iteration. 
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Figure 22 - Retention Delay Period - DC Bias Task Execution.  
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Figure 23 - Retention Execution Data.  

 
4.   Once the Retention is complete, the log file will reflect the execution of every Task in the 

experiment. The DataSet Explorer tab page will have its Archive updated. The tree is 
now expandable. A folder representing the Executed Test Definition (ETD) appears 
named "Tutorial Discrete Retention Test One:0". That folder expands into two subfolders 
labeled "Experiment Design" and "Experiment Data". Both folders hold a list of Tasks. 
The first folder holds a copy of the CTD that was executed. The Tasks contain configura-
tion information, but no data. The second folder holds each instance of every executed 
Task. The Tasks includes both configuration information and measured data. The differ-
ences in Tasks lists between the "Experiment Design" and "Experiment Data" folder is a 
result of repeated execution of single Tasks in a loop. The "Experiment Design" folder is 
essential, since the original experiment cannot be recovered from the "Experiment Data" 
folder. 
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Figure 24a - Retention DataSet with Updated Archive.  
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Figure 24b - Retention DataSet Partial Log Window.  

 
5. Review the Data. Expand the DataSet Explorer Window by clicking on its right edge 

with the left mouse button and dragging the edge to the right. This will increase the win-
dow size so that the Task names are completely visible in the "Experiment Data" folder. 
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Figure 25 - Access DataSet Archive to Regraph Data.  
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Double-click on "Retention Read Pulse 2:3". This will open the Simple Pulse configuration 
dialog. The dialog will show the configuration that the Task had when it executed. The Click 
For Task Instructions and Cancel/Plot buttons are active. Buttons that open secondary dia-
logs are also active to allow review of parameters configured in the subdialogs. These are 
discussed in the Simple Pulse Help page. Other controls are disabled and are for configura-
tion review only. 

 

  
Figure 26 - Simple Pulse Regraph Configuration Dialog.  

 
Click the Cancel/Plot button to close the configuration dialog. A plot configuration dialog 
will appear (Figure 27). This is used to adjust the labels of the data plot that is to appear. 
Once closed, the Simple Pulse QuikLook Results dialog opens and the data are plotted (Fig-
ure 28). For a –5.0-volt pulse on the internal reference capacitor, the plot should show a 
"Top" of ~-50.0 µC/cm 2 and a "Bottom of ~0.0 µC/cm 2 . Note that this is a synthetic plot in 
which a zero baseline, followed by the pulse top measurement, followed in turn by the pulse 
bottom measurement are shown as a function of pseudo-time. The pseudo-time value has no 
real meaning, but represents the sequence of measurement. 
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Figure 27 - Simple Pulse Regraph Plot Configuration Dialog.  
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Figure 28 - Simple Pulse Data Recalled from the Archive. Two 

Measured Values are Shown in a Graphic Format.  
 

Now, double-click on one of the later "Retention Results" Filter Tasks. Review the configu-
ration, then click Cancel to show the accumulated measurements up to the point of the Filter 
Task execution. 
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Figure 29 - Archived Single-Point Filter Data Recalled after the 

Eighth Measurement.  
 

Finally, double-click on a Branch Task. After canceling the configuration dialog, a second 
dialog appears that indicates if the Branch branched into a new loop, or if it did not branch. 
 
(Note that Figure 29 displays each measured data point and the line between points. The de-
fault plot shows only the line. There are several ways to plot the data points along with the 
lines. Right-clicking on the plot surface and selecting "Mark Data Points" or "Plotting Meth-
od->Points + Line" will immediately display the points. Before plotting, selecting "Data Plot-
ting->Plotting Method->Points + Line" will adjust the default plotting method so that all sub-
sequent plots will include points along with lines.) 
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Figure 30 - Plot Points + Line.  

  
6.   Repeat the experiment. Select "Dataset>Execute CTD", or press <F1>. The Log window 

and DataSet Archive will be updated. A new Executed Test Definition will be added to 
the DataSet Archive, named "Retention Test 1:1". This differs from the original ETD 
name by the appended ":1". A serially incrementing value is appended to the ETD name 
to distinguish ETDs of the same root name. The "Experiment Design" and "Experiment 
Data" folders hold new copies of the Hysteresis Task. 

 
Step 12 - Various DataSet and Editor Operations  
 

This section will present some of the various operations that can be performed with Test Def-
initions in the Editor and the DataSet.  

 
1.  Clear the Editor of all Tasks. Select "Editor-> Clear All", Press <Ctrl-A> or right-click in 

the Editor window and select " Clear All" from the popup menu. The Tasks that form the 
Test Definition will be entirely removed from the Editor. Once deleted, they cannot be 
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recovered unless they have been stored in the Library or in a DataSet.  
 

  
Figure 31 - Clearing the Test Definition from the Editor.  

 
2.  Restore the Test Definition to the Editor from the CTD. The tools to restore the Test Def-

inition from the Library are discussed in other help pages. However, the entire experi-
ment can be restored from the Current Test Definition in the DataSet. Select " DataSet-> 
CTD to Editor" or highlight the CTD name, right-click and select " CTD to Editor" from 
the popup menu. The Test Definition will be restored to the Editor so that Tasks may be 
reconfigured and the Test Definition returned to the CTD or to the CTD of another Da-
taSet.  
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Figure 32 - Moving the Current Test Definition Back to the Editor.  

  
3.  Restore the Test Definition to the Editor from an ETD. Clear the Editor as in 1. Open the 

DataSet Archive. Open an ETD. Select the "Experiment Design" folder. Right-Click and 
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select "ETD to Editor". Again the Test Definition is restored to the Editor. This has an 
advantage over 2. in that the CTD holds a single Test Definition, while the Archive may 
hold many ETDs with varying Test Definitions. Many different Test Definitions can be 
stored in and recalled from the Archive using this technique. Note that if the Editor were 
not cleared before executing this option, the Test Definition would be appended to the 
Test Definition already in the Archive as in Figure 34 . In this case, each Task in the sec-
ond Test Definition would need to be reconfigured in order to rename the Task. Tasks 
may legally have the same name, but this is very poor practice and can result in incorrect 
associations between Tasks and Filters or the Branch Task.  

 

  
Figure 33 - Restoring the ETD Test Definition to the Editor.  
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Figure 34 - Restoring the Editor Test Definition from an ETD or the 
CTD Appends the Test Definition to the Existing Editor Test Defini-
tion. In this Case the Same Test Definition has been Restored Twice. 

The Second Set of Tasks Would Need to be Reconfigured and Re-
named.  

  
4.   Move an ETD directly into the CTD. A CTD can be overwritten by the Test Definition 

stored in one of the DataSets Executed Test Definitions, bypassing the need to more the 
Test Definition first to the Editor. Begin by clearing the Editor and moving a Pause or 
other Task into it to create a Test Definition of a single Task. Move this into the CTD us-
ing any of the Techniques already discussed. Don't worry about the CTD name. The pur-
pose is simply to create some other Test Definition as the CTD so that the effect of mov-
ing the ETD into the CTD will be apparent. Now, open the DataSet Archive. Open an 
ETD. Select the "Experiment Design" folder. Right-Click and select "ETD to CTD". The 
CTD will be updated and the CTD Name dialog will appear for updating.  
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Figure 35 - Restoring the CTD from an ETD.  

  
5.   As a final demonstration, suppose that some samples under test are losing polarization 

during retention too rapidly. As a standard of measure you have determined that if the 
switched measurement pulse top falls below 59.8 µC/cm2 or unswitched sample pulse top 
measurement rises above a magnitude of 22.2 µC/cm2 within the total execution time of 
the experiment, the sample is considered to have failed and the experiment should be 
terminated. You want to place an Automatic Branch Abort Task after each of the two 
read pulses but before the Single-Point Filter, but you do not want to recreate the entire 
experiment to do so. (The purpose of the Automatic Branch Abort Task is to provide a 
second Branch Logic Condition, based on measured polarization, on which to control the 
Branch Loop.) The Editor Aide tool allows a user to insert a Task directly into any loca-
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tion in a Test Definition. However, the Editor Aide is beyond the scope of this discus-
sion. For this demonstration, Tasks can be individually removed from the end of the Test 
Definition, backing up to the point of insertion. The deleted Tasks will need to be rein-
serted and reconfigured, but the workload has been somewhat reduced since the Tasks up 
to the point of insertion do not need to be reconfigured. Clear the EDITOR and restore 
the experiment using any of the methods described above. Select "Editor->Remove Last 
Task", press <Ctrl-L> or right-click in the Editor window and select "Remove Last Task" 
from the popup menu that appears. The Branch Task will be removed from the list. Re-
peat twice so that the Retention Read Pulse 1 Task is the last Task in the Test Definition ( 
Figure 36 ).  

 

  
Figure 36 - Repeatedly Remove the Last Task from the Test 
Definition in the Editor until the Insertion Point is Reached.  
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From TASK LIBRARY->Branch, move an Auto Branch Abort Task to the EDITOR. The 
Task is located in Program Control->Branching. Configure the Task as follows...  

 
Task Name:   "Abort Test - Low Switching Pulse 1 Value"  
Parameter to Compare:   "Simple Pulse: Top " 
Comparison:   <=  
Real:   59.8  
± Tolerance:   0.0  
User Variable Limit Selection:   "<<None>>"  
Comments:  As appropriate  

 

  
Figure 37 - Auto Branch Abort Task Configuration.  
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Reinsert the nonswitching +9.0-Volt/10.0 ms Simple Pulse Task. Configure the Task as fol-
lows... 

 
Task Name:  "Retention Read Pulse 2 - Unswitched" 
Pulse Volts:  9.0 
Pulse Width (ms):  10.0 
Read:  Checked 
Enable Reference Ferroelectric:  Checked 

Cap A Enable:  Checked 
Auto Amplification:  Unchecked 
RETURN Signal Amplification Level:  Select the appropriate level. This can be determined by trial-

and-error or previous measurements. For example, before run-
ning the Test Definition, do a QuikLook PUND Task measure-
ment. The results dialog will display the amplification level to 
the lower-left.  
 
NOTE: For this nonswitching pulse measurement disabling Auto 
Amplification and manually selecting the amplification level is 
not critical. 

Comments: As Appropriate 
 

  
Figure 38 - Configuration of the Second Retention Read Pulse.  
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Insert a second Auto Branch Abort Task to detect the high nonswitching polarization 
(µC/cm2). Configure the Task: 

 
Task Name:   "Abort Test - Low Nonswitching Pulse 2 Value"  
Parameter to Compare:   "Simple Pulse: Top " 
Comparison:   > 
Real:   22.2  
± Tolerance:   0.0  
User Variable Limit Selection:   "<<None>>"  
Comments:  As appropriate  

 

  
Figure 39 - Second Auto Branch Abort Task Configuration.  
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Add the Single-Point Filter Task and the Branch Task. Configure as in Figures 10, 11 and 
12. Move the Test Definition into the DataSet CTD and execute. If an in-house sample is 
used, the test conditions on the Automatic Branch Abort Tasks can be adjusted so that the 
test may or will terminate early.  
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E - Fatigue Sequence Test Definition 
 

Please note that many of the Figures below may appear slightly different from the windows 
that appear to you within Vision as you proceed through the tutorial. The software that 
you are working with changes rapidly and the help files often lag behind these changes. 
The help files will be updated as quickly and frequently as possible. In the meantime, dif-
ferences between figures and actual windows will not be significant enough to affect your 
use of the tutorial.  
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models.  
 
This tutorial provides more practice with the tools of Tutorial #2b-1 by constructing a practical 
Fatigue experiment. Fatigue is the primary ferroelectric damage mechanism in which a sample 
that experiences repeated switching loses available switchable polarization. In this tutorial a 
PUND measurement is used to establish the polarization parameters (±P*, ±P^ and ±∆P) that 
will be used to characterize the Fatigue. A series of stress/measurement sequences is applied. 
The stress is in the form of a 10 kHz switching Pulse waveform applied to the sample. The Pulse 
waveform is similar to a square wave except that the maximum positive and negative voltages 
are applied for only a fraction of the period of the waveform. During the remaining portion of the 
waveform, the sample is held at zero volts. Please see the Task Instruction pages for the Wave-
form Task for a detailed description. The "Pulse" waveform is the default waveform for the 
Waveform Task. The waveform is applied for a specified period, then the PUND measurement is 
made. In each subsequent stress sequence, the duration (and therefore the number of switching 
cycles) of the stress waveform will double. 
 
As with the retention experiment in the previous tutorial, the Fatigue experiment has been con-
solidated into a single Task for simplicity and to provide a slightly better organized experiment. 
As a result, this tutorial serves mainly as reinforcement of the lessons of Tutorial #2b-1, although 
the Test Definition created here is valid and would serve as a practical fatigue experiment. Dur-
ing this tutorial you will create the DataSet "Tutorial #2b-2". This will be an exact duplicate of 
the "Tutorial #2a-2" DataSet shipped with your Vision installation. This tutorial introduces the 
Waveform and PUND Tasks and provides a second example of the use of the tools introduced in 
Tutorial #2b-1. 
 
One possible benefit to using the discrete Tasks to create the Fatigue experiment is that the 
PUND measurement might be replaced directly by a Hysteresis Task, Remanent Hysteresis Task 
or other Task. This option is not available to the self-contained Fatigue Task.  
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Step 1 – Create the Fatigue Experiment  
 

In this step, you will construct a second practical experiment to measure the susceptibility of 
a sample to Fatigue. Fatigue is one of two primary ferroelectric damage mechanisms (the 
other is Imprint) in which a sample that is repeatedly switched begins to lose the remanent 
polarization characteristic that is its useful memory component. The experiment is very simi-
lar to the Retention experiment created in Tutorial #2b-1. The sample is repeatedly fatigued 
with a switching waveform for longer and longer periods. After each Fatigue period, a PUND 
test is made and pertinent resulting polarization parameters, such as P* or ∆P (P* - P^) are 
made and plotted as a function of the duration of the experiment. The loss in P* or ∆P re-
flects the Fatigue of the sample. While the tutorial Test Definition is useful as a tool for in-
struction, a Fatigue Task is available that condenses these operations into a single Task. 

 
1.  Clear the Editor. Select "Editor>Clear All" or press <Ctrl-A> 
 
2.  Open the Tutorial #2b-1 DataSet. You can immediately close this DataSet if you prefer. 

The purpose of this step is to cause the Branch Task to be accessed as it will be since it 
was a part of the CTD in that DataSet. By accessing the Branch Task the "Loop Counter" 
User Variable is placed on the User Variable list. That value will be used to control the 
Branch Looping in this tutorial. It will also be displayed on the Waveform progress dia-
log prompt line. It is the action in this step that makes the User Variable available for 
configuration of the Waveform Task. 

 
3.  Add and configure Tasks as follows 
 

i)    Pause (Task Library->Program Control) 
 

Task Name:  "Tutorial #2b2 - Fatigue - Pause for User Start"  
User Self-Prompt:  "Press <Enter> to Start Fatigue Testing"  
Comments:  As appropriate  
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Figure 1 - Fatigue Experiment Startup Pause Task.  

 
ii)   Waveform (Task Library->Hardware) 

 
Task Name:   "5.0-Volt/10 kHz Pulsed Fatigue Stress Waveform"  
Waveform Type:   Pulse  
Peak Voltage 1:   5.0  
Peak Voltage 2:   -5.0  
Pulse Width (ms):   0.01 (ms)  
Frequency (Hz):   10000 (Hz)  
Duration (s):   1 (second)  
Perform Adjustment:   Checked  

Adjust by Scaling:   Checked 
Scale Factor:   2  
Enable Reference Ferroelectric:  Checked 
Cap A Enable:  Checked 
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User Self-Prompt:   "Loop Counter: "  
Parameter to Append to Prompt:   "Loop Counter" 
Comments:  As appropriate  

 

  
Figure 2 - Fatiguing Waveform Task.  

 
The applied waveform is shown in Figure 3.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 251 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 3 - Fatigue Stress Profile.  

 
Clicking Profile Preview opens a subdialog that also shows the waveform... 

 

 
Figure 4 - Waveform Profile Preview. 
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From the Set Sample Info subdialog set information ...  

 
Sample Name:  "Int. Ref. Ferroelectric"  
Lot ID:  "N/A"  
Wafer ID:  "N/A"  

 

  
Figure 5 - Sample Identifying Information.  

 
Discussion  
 
A ±5.0-Volt 10 kHz bipolar switching pulse train will be applied to the with a 10% duty cy-
cle. The stressing waveform will last for 1 second in the first iteration and double in duration 
for each new loop iteration. 
 
The 1 nF internal reference capacitor will be used as the sample element for the measure-
ments. The 1.0 nF linear internal reference capacitor and 2.5 MΩ internal reference resistor 
are not available to the Waveform Task. The 4/20/80 PNZT internal reference ferroelectric is 
available and is selected for data presentation, below. Or, you may provide your own sample, 
in which case the sample information should be updated and the Enable Ref. Cap. control 
disabled in the PUND Task, below. Your sample will be attached directly to the Precision 
Tester DRIVE and RETURN ports. 
 
The progress dialog that appears during the stress period will report the current loop iteration, 
beginning at one. Note that the Loop Counter User Variable is added by the Branch Task. 
Since that Task was used earlier, the Loop Counter parameter will appear in the Parameter to 
Append to Prompt list. However, if no Branch Task had been accessed since program startup, 
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that parameter would NOT appear in the list. In that case, the Prompt String could still be set, 
but the Waveform Task would need to be reconfigured after the Branch Task was added in 
order to set the Parameter to Append to Prompt control. 

  
 iii)   PUND (Task Library->Hardware->Measurement->Pulse) 

 
Task Name:   "5.0-Volt/1.0 ms Fatigue Characterization PUND"  
Max. Voltage:   5.0  
Pulse Width (ms):  1.0 
Enable Reference Ferroelectric:   Checked  
Cap A Enable:  Checked 
Comments:  As appropriate  

 

  
Figure 6 - Fatigue Measuring PUND Task.  

 
NOTE: at this point supplement or replace the PUND Task with one or more Measure-
ment Tasks of the type needed for the research - Hysteresis, Remanent Hysteresis, Piezo, 
etc. 
 

iv) Single-Point Filter (Task Library->Filters) 
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1.  Single-Point Filter Setup Tab 

 
Task Name:   "Fatigue PUND Polarization (µC/cm2) Response"  
Data Type:   PUND  
Task Selector:   "5.0-Volt/1.0 ms Fatigue Characterization PUND " 
Add Task:   Click here after the PUND Task has been selected in the 

Task Selector control  
Single-Point X- Axis Type:   "Cum. Wave Cycles"  
Single-Point Data:   "P* (µC/cm2)",  

      "-P* (µC/cm2)",  
      "P^(µC/cm2)"  
      "-P^(µC/cm2)"  
      "dP (µC/cm2)" and  
      "-dP (µC/cm2)"  

Add Trace:   Click here after the single-point data have been selected.  
Comments:  As appropriate  
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Figure 7 - Data Plotting Single-Point Filter Task.  

 
Discussion:  
 
Data Type control. Indicates the type of Task that is to be the source for the input data to 
the Single-Point Filter.  
 
Task Selector and Add Task controls: First the Task Selector is used to select all data-
producing Tasks of the selected type ("PUND") whose data are to be accumulated. In this 
case, the single PUND Task is selected. Note that the Tasks are listed in reverse order of 
appearance in the Test Definition. The latest Task added is at the top of the list. The 
<Shift> key can be used along with the mouse to select more than one consecutive Task. 
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The <Ctrl> key can be used along with the mouse to select more than one non-
consecutive Task. Once the appropriate Tasks are selected, clicking Add Task creates the 
association between them and the Filter Task and indicates the selected Tasks in the Task 
Selector list by appending "(X)" to the Task name. 

 
Single-Point X-Axis Type control. This control is used to choose the single independent 
variable against which the data are to be plotted. Note that the values available change 
with data type. 
 
Single-Point Data and Add Trace controls: The Single-Point Data control is used to 
choose one or more extracted data values to be plotted. The <Shift> key can be used 
along with the mouse to select multiple consecutive parameters. The <Ctrl> key can be 
used along with the mouse to select multiple non-consecutive parameters. Once the ap-
propriate parameters are select, click Add Trace to set them in the Filter. Parameters in 
this list depend on the type of input Task selected to provide the plotted data. 
 
NOTE: if the PUND Task has been replaced by another Measurement Task, this Task 
configuration should be adjusted to match the replacement Task type. If the PUND Task 
has been supplemented with one or more Measurement Tasks, additional Single-Point 
Filter Tasks should be placed after those supplemental Tasks and configured appropriate-
ly to collect Fatigue-characterization data from those Tasks. 

 
2.  Single-Point Plot Setup Tab 

 
Plot These Data:  Checked  
Plot Title:  "Fatigue PUND Polarization (µC/cm2) Response/Int. Ref. Ferro"  
Plot Subtitle:  "Tutorial #2b-2 - Advanced DataSet Concepts"  
Plot X-Axis Label:  "Cumulative Fatigue Cycles"  
Plot Y-Axis Label:  "Polarization (µC/cm2)"  
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Figure 8 - Data Plotting Single-Point Filter Task. Plot Configuration 

Tab.  
 

Discussion  
 
Plot These Data control. This control enables runtime plotting. When enabled, a plot will 
appear during the experiment. If disabled, no plot will appear, but the data will be stored 
and recorded and may be recalled for display from the DataSet Archive. 

 
v)    Branch Task (Task Library->Program Control->Branching) 
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Task Name:   "Fatigue Branching = Branch to 10 Stress/Measure Sequences"  
Parameter to Compare:   "Loop Counter"  
Comparison:   "<="  
Integer:   10  
Use Tolerance:  Unchecked 
User Variable Limit Selection:  "<<None>>" 
Branch Point Task:    "5.0-Volt/10 kHz Fatigue Stress Waveform" 
Comments:  As appropriate  

 

  
Figure 9 - Fatigue Iterating Branch Task.  

 
Discussion  
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Inserting the Branch Task into the Test Definition causes the experiment execution to re-
turn to an earlier associated Task (the Branch Target - here, the Fatigue Stress Wave-
form). The Task sequence between the Branch Target Task and the Branch Task will re-
iterate. The process will repeat until the Branch Logic Condition is no longer satisfied. 
This feature makes Vision a simplified visual programming language. The Branch Logic 
condition is constructed by making a logical comparison between a constant programmed 
value and a User Variable. It is presented in plain English in the unlabeled text box in the 
center of the dialog of Figure 8. 

 
User Variables  
 
User Variables are Vision program elements, maintained by Vision in a list of User 
Variables, that consist of a textual name, a type (text, integer, real or Boolean) and a 
value. User Variables are added to the list by Tasks as they are accessed in QuikLook, 
in the Library or Editor or in a DataSet. The list of User Variables is therefore of vari-
able length depending on the number and type of Tasks accessed since the program 
started.  
 
User Variables serve four purposes:  

 
1.  Establish default values for Task configuration parameters.  
2.  Maintain current values for Task configuration and measurement parameters and 

establish persistence of the parameters from-configuration-to-configuration.  
3.  Provide access to program status for user review.  
4.  Provide mechanisms for program control as in the present case of controlling 

Branch Looping.  
 

The Branch Logic comparison is being made between a constant and a User Variable that 
is stored as an integer type. Since that is the User Variable type, the Branch Task configu-
ration dialog automatically enables the Integer constant control. The Branch Task also 
adds it own User Variable, called "Loop Counter". This value records the number of 
times the sequence of Tasks has executed and may be used to control Branch Loop ter-
mination. Note that care must be taken in programming the Branch Task. It is entirely 
possible to perform a comparison with a parameter that will not change so that the 
Branch Loop will never terminate.  
 
Parameter to Compare, Comparison and Integer controls: A Branch Task is configured 
by comparing a typed User Variable to a user-set constant using a standard comparison 
operator. Here, the Parameter to Compare is the "Loop Counter". This is an integer User 
Variable added to the variable list by the Branch Task, itself. It indicates the number of 
times the Tasks that comprise the Branch Loop have executed. This value is incremented 
at each loop and is, therefore, guaranteed to increase. Any Branch Loop based on this Us-
er Variable will always terminate provided the logic is properly configured. The Integer 
control is enabled, since the "Loop Counter" User Variable is stored as an integer. The 
Comparison chosen is <=, so that as long as the User Variable is <= the Integer, the 
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Branch Task will return execution to the Branch Target Task and another loop will occur. 
Note that the logic is reflected in an unlabeled text box in the center of the dialog for your 
verification. After the 11th iteration, the Branch condition will be false and the Branch 
Loop will exit normally. 

 
Branch Point Task and Select Branch Target controls. The Branch Point Task control 
lists, by name, all Tasks that precede the Branch Task that are eligible to be the first Task 
in the Branch Loop. The Tasks are listed in reverse order from the Test Definition, so that 
the Task immediately preceding the Branch Task is at the top of this list. Branch Loops 
may not cross or be nested, so that any preceding Branch Task or any Task that precedes 
a preceding Branch Task will not appear on the list. The Fatigue Stress Waveform is set 
as the Branch Point (also known as the Branch Target) so that it, along PUND and the 
Filter, will reiterate. The Task is selected by highlighting it in Branch Point Task, then 
clicking Select Branch Target. The selection is indicated by an "(X)" appended to the 
Task name in Branch Point Task. The Pause Task does not reiterate so that after the ini-
tial execution, human interaction is not required. 

 
Step 2 – Create the DataSet  
 

To create the DataSet, first select "File>New DataSet", or click the page icon on the toolbar. 
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Figure 10 - DataSet Creation Options.  

 
A dialog will appear. Perform the following actions: 
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Figure 11 - Create the DataSet.  

 
NOTE: The DataSet Path control is automatically updated to assign the DataSet Name value 
as the DataSet File Name, with a *.dst extension. The Browse button may also be used to as-
sign the file path and file name. Or these may be specified by editing directly in the DataSet 
Path control. "C:\DataSets" is the default root folder. It will be replaced in further updates to 
the DataSet Path control if it is changed using the Browse button or by editing directly into 
the DataSet Path control. Folders in the DataSet Path control need not exist when the Da-
taSet is created. The folders will be created if they are not found. 

 
1.  Type "Tutorial #2b-2" for the DataSet Name. 
 
2.  The DataSet Path control is automatically updated by appending the DataSet Name value 

to "C:\datasets\" to form the file name. (Illegal file characters in the DataSet Name are 
automatically replaced with '.'.). Once the DataSet Name value is set, the DataSet Path 
may either be accepted as is or may be edited. Note that the file name does not have to 
have the *.dst extension, but other functions in Vision look for this extension for Da-
taSets. Note that the default directory for the DataSet is "c:\DataSets". Any path may be 
defined for the DataSet using the browser. 

 
3.  Enter your initials. This provides a reference identity for the DataSet. Any other person 

using the DataSet will know who the designer was. This field is required. 
 
4.  Type any Comments that you’d like. This field is optional. Comments in this case are not 

recommended. 
 

5.  Click OK. 
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Figure 12 - Fatigue DataSet Explorer Tab and Log Window.  

 
6. The DataSet will appear in the DataSet Explorer. A Tab page and log window will appear 

and the DataSet will be opened. 
 

Step 3 – Move the Test Definition into the Tutorial #2b-1 DataSet and Run the 
Fatigue Experiment.  
 

Name the CTD "Fatigue Test One". When the experiment is executed the user-start Pause 
Task dialog waits for user acknowledgment. Then, as with the Retention experiment, two 
windows will appear. These are the Waveform Progress Dialog and the Fatigue Filter Plot. 
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Figure 13 - User-Start Dialog. Pause Task Execution.  

 

  
Figure 14 - Dialog Indicating the Progress of the Fatiguing Wave-

form at the Ninth Branch Loop Iteration.  
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Figure 15 - Fatigue Damage Growth Through Ten Iterations. Inter-

nal Reference Ferroelectric Capacitor.  
 

  
Figure 16 - Fatigue Damage Growth Through Ten Iterations. Log 

Cumulative Cycles Display.  
 

Repeat the measurement and exercise the Archived data as desired. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 266 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

III - Branch Loop Operations 
 

A - Overview 
 

In Tutorial II you constructed two practical Test Definitions that performed Retention and Fa-
tigue sample characterization. Each of these experiments used just a few Tasks to perform elabo-
rate iterative measurements over an extended number of sequences and an extended period of 
time by introducing the Branch Task and Branch Looping. Each test consisted of a stress period 
and a measurement that was iterated within the Branch Loop. As the experiment iterated the time 
duration of the stress period was increased in a programmable and predictable way. The Test 
Definitions also include a Filter programmed within the Branch Loop to accumulate and display 
data. Tutorial V extends the concept of adjusting time within a Branch Loop to adjustment of a 
general collection of parameters in standard Measurement Tasks. It also addresses, in detail, the 
general behavior of Filter Tasks when they are programmed into a Branch Loop. In the process, a 
collection of very useful Test Definitions will be created. These will serve to teach these ad-
vanced Vision features in great detail. But they will also provide a useful set of tools that can be 
used directly as templates in creating your own experiments.  
 
In Tutorial III, among other things, the following items are introduced: 
  

1.  Branch Loop configuration parameter adjustment.  
2.  The Auto Branch Abort Task.  
3.  Filter Append mode.  
4.  Filter Accumulate mode.  
5.  The Single-Trace Loop Average Filter.  
6.  The Two-Trace Math Filter.  

 
In the tutorial you will build up a DataSet named Tutorial #3b.dst that is the duplicate of Tutorial 
#5a.dst, included in the c :\DataSets directory with the shipment of Vision. The DataSets have 
differing indices because this tutorial has been moved up in the list of tutorials from V to III. 
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B - Multi-Volt Hysteresis 
 

This first example of operations within a Branch Loop begins by demonstrating a simple adjust-
ment of the maximum voltage in a Hysteresis loop, presenting a sequence of measurements rang-
ing from 3.0 Volts to 9.0 Volts in 1.0-Volt increments. The data are passed to a Collect/Plot Fil-
ter Task, programmed within the Branch Loop, for runtime display. Subsequent steps adjust the 
method of data display by the Filter Task within the Branch Loop. Here, the Filter Append and 
Accumulate options are introduced. Finally the Filter is placed outside of the Branch Loop and 
the various configurations are examined. 
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models.  
 
Step 1 - Create the Test Definition.  

 
1.  In the Vision Library, open the Hardware->Measurement->Hysteresis folder. Move the 

Hysteresis Task into the EDITOR window.  
 
2.  Configure the Task as follows: 

 
Hysteresis Task Name:   "Multi-Volt/10.0 ms Hysteresis"  
Max Voltage:   3.0  
Hysteresis Period (ms):  10.0 
Sample Area (cm2):   Default if If Enable Reference Ferroelectric is checked, or as 

appropriate  
Sample Thickness (µm):   Default if If Enable Reference Ferroelectric is checked, or as 

appropriate  
Enable Reference Ferroelectric:  Checked - Or attach your own sample 
Cap A Enable:  Checked - If Enable Reference Ferroelectric is checked. 
Comments:  As appropriate  
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Figure 1 - Configure the Hysteresis Task.  

 
3. Click on Set Sample Info and add the information as follows. Note that if you are follow-

ing on from the previous tutorial or have re-accessed that tutorial's DataSet, these values 
will be preconfigured since they are persistent from the previous Task access.  

 
Sample Name:  "Internal Reference Cap.", or as appropriate  
Lot ID:  "N/A"  
Wafer ID:  "N/A"  

 
4. Then click OK to return to the main dialog.  
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Figure 2 - Provide Sample Information.  

 
5. Click on Adjust Params and configure as follows.  
 

Adjust Hysteresis Volts in a Loop:  Checked  
Adjust by Incrementing:  Checked  
Voltage Increment:  1.0  
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Figure 3 - Configure the Branch Loop Parameter Adjustment.  

 
6. Then click OK to return to the main dialog. Note that the Adjust Parameters in a Loop 

control now appears checked as in Figure 1.  
 
 
 

Discussion:  
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The two main Hysteresis determining factors - Hysteresis Period (1/Frequency) and Hys-
teresis Voltage - may be independently adjusted in a Branch Loop. There are two meth-
ods of adjustment. In each, the programmed value, taken from the main dialog, is used in 
the first Branch iteration. Subsequent iterations determine the parameter value either by 
scaling the previous setting by a constant value or by incrementing it by a constant. In 
this example, the initial loop will be at 3.0 volts and 10.0 ms. Adjustment of Hysteresis 
Period is disabled, so all subsequent loops will also be at 10.0 ms. However, the maxi-
mum drive voltage is to be incremented at each iteration by 1.0 Volt. The second iteration 
will apply 4.0 Volts, the third 5.0 Volts and so on. Note that it is incumbent on the user to 
ensure that the Branch Loop Branch Logic Condition is programmed in a way that en-
sures that the combination of initial value, scale or increment constant and number of 
loops do not cause the adjusted parameter to exceed the capabilities of the hardware or 
cause any damage to the sample. Note that although both Hysteresis Period and Max 
Voltage may be adjusted, it would not be good policy to change both simultaneously 
since resulting changes in the sample response may not be able to be associated with a 
particular change. Note that in both cases, the scale factor may be between 0.0 and 1.0 
and the increment may be negative, so that parameters can be made to move from larger 
initial values to smaller values. In the case of Max. Voltage, the scale factor may be nega-
tive. It is important to ensure that the Hysteresis Period does not fall below 10-6 ms. Note 
that, if the DRIVE signal is specified in units of Electric Field (kV/cm) on the main con-
figuration page, the signal increment will be in units of Electric Field (kV/cm) on the 
Branch Loop Adjustment configuration page.  

 
7.  In the Vision Library open the Filters folder. Move the Collect/Plot Filter into the Editor. 

Configure the Task as follows:  
 

Task Name:   "Multi-Volt Hysteresis Data - Internal Ref. Ferroelectric"  
Data Type:   "Hysteresis"  
Task Selector:   "Multi-Volt/10.0 ms Hysteresis"  
Add Task:   Click this button after the Task Selector selection is made. An "(X)" will 

be appended to the Task name in the Task Selector window.  
Comments:  As appropriate  
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Figure 4 - Configure the Collect/Plot Filter.  

 
8.   Click on Collect/Plot Plot Setup tab. Configure the dialog as follows:  
 

Plot These Data:  Checked  
Append Data:  Unchecked  
Labels:  As Appropriate  

 
9. Then click OK add the Task to the Test Definition in the Editor.  
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Figure 5 - Configure the Filter Plotting Dialog.  

 
10.  In the Vision Library open the Program Control->Branching folder. Move the Branch 

Task into the Editor. Configure the Task as follows:  
 

Task Name:   "Branch to 9.0 Hysteresis Volts"  
Parameter to Compare:   "Hysteresis: Current Volts"  
Comparison:   "<"  
Real:   9.0  
Use Tolerance:  Unchecked 
User Variable Limit Selection:  "<<None>>" 
Branch Point Task:   "Multi-Volt Hysteresis"  
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Comments:  As appropriate  
 

  
Figure 6 - Configure the Branch Task.  

 
Discussion:  
 
The configuration and execution of the Branch Task has been described in detail in Tuto-
rial II-D and II-E. In the present case the Branch Logic Condition is based on the "Hyste-
resis: Current Voltage" User Variable that is added and updated by the Hysteresis Task. 
That value begins at 3.0 Volts and is incremented by 1.0 Volt at each Branch iteration. In 
this experiment the iterations are to continue until the voltage reaches 8.0 Volts. The iter-
ation immediately preceding this voltage has as its voltage 7.0 volts. When the Branch 
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Task sees 7.0 Volts it should Branch. When it sees 8.0 Volts it should not Branch. Thus 
the Branch Logic Condition is set to Branch any time "Drive Voltage" is <= 7.0 but not 
Branch if "Drive Voltage" is > 7.0. Any of the following configurations would achieve 
the same performance:  
 
1.  "Hysteresis: Current Voltage" < 8.0.  
2.  "Hysteresis: Current Voltage" NOT = 8.0  
3.  Branch on False checked and "Hysteresis: Current Voltage" > 7.0.  
4.  Branch on False checked and "Hysteresis: Current Voltage" >= 8.0.  
5.  Branch on False checked and "Hysteresis: Current Voltage" = 8.0.  
 
Note that when the Branch Task sees "Drive Voltage" equal to 8.0 Volts, the 8.0 Volt 
measurement and display has already occurred.  

 
Step 2 - Create the DataSet.  

 
1.  Using any of the methods discussed in earlier tutorials, initiate a new DataSet  
 
2.  When the DataSet configuration dialog opens, configure as follows:  

 
DataSet Name:  "Tutorial #3b"  
DataSet Path:  "c:\datasets\tutorials\tutorial #3b"  
Experimenter Initials:  Required  
Comments:  Optional - As Appropriate (Not Recommended) 

 

  
Figure 7 - Configure the DataSet.  
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NOTE: The DataSet Path control is automatically updated to assign the DataSet Name 
value as the DataSet File Name, with a *.dst extension. If the DataSet Name control is ed-
ited, the DataSet Path is automatically fully updated to be "C:\<Current Default 
Path>\DataSet Name". This automatic updating may be defeated by using the Browse 
button to assign the file path and file name or by editing directly in the DataSet Path con-
trol. "C:\DataSets" is the default root folder. Folders in the DataSet Path control need not 
exist when the DataSet is created. The folders will be created if they are not found. This 
feature was added at the request of Tohoku University and Michio Ohata-san of Nippon 
Ferro Technologies. 

 
3.  Click OK to create and open the DataSet.  
 
4.  Using any of the methods presented in earlier tutorials, move the Test Definition from the 

Editor into the DataSet as the Current Test Definition (CTD). Name the CTD "Tutorial 
#3B - Multi-Volt 1".  

 

  
Figure 8 - Name the CTD.  

 
Step 3 - Run the CTD.  

 
1.  Using any of the methods discussed in earlier tutorials, execute the Experiment. As the 

CTD runs, a Hysteresis measurement is made, then the Filter Task plots the data. At each 
new iteration, a new Filter plot window will be generated showing the most-recently 
made measurement. After six iterations the CTD will terminate, the Archive will be writ-
ten and, after opening the Archive and the ETD, the program will appear as in Figure 9. 
Note that the most-recent (9.0-Volt) measurement is displayed at the top of a stack of plot 
windows. Each of these windows holds a measurement at at different iteration.  
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Figure 9 - Vision Program Window After CTD Execution.  

 
2.  Any of the Hysteresis, Filter or Branch Task executions may be recalled from the DataSet 

Archive for review by double-click the Task icon in the "Experiment Data" folder of the 
Executed Test Definition (ETD). Reexecute the experiment and review data as desired.  

 
Step 4 - Add an Automatic Branch Abort Task.  
 

The Test Definition described to this point has been carefully designed to ensure that the 
Branch Looping will terminate and that voltages will not harm the sample and not exceed the 
capability of the tester to generate the measurement in its current configuration. Additional 
safeguards can be added by applying additional Branch Logic Conditions to the Branch Task. 
This is done by inserting a Branch Abort Task into the Branch Loop somewhere between the 
Branch Target and the Branch Task. Vision offers three Branch Abort Tasks. Manual Branch 
Abort presents a dialog to the user. This dialog can be programmed to display a prompt in-
cluding an appended User Variable. The user then determines if the Branching should con-
tinue or terminate. The Branch Task continues to examine its Branch Logic Condition if the 
user allows Branching to continue. The Manual Branch abort forces user interaction, howev-
er, and the Test Definition cannot run unsupervised. This situation is resolved by the Timed 
Branch Abort Task. This is a Manual Branch Abort that has a programmable time out and its 
execution shows a progress dialog. If the user does not acknowledge the dialog before the 
time out, the Task will terminate and Branch Looping will continue. However, although both 
these Tasks allow the user to make a choice based on the condition of a User Variable, they 
do not strictly introduce an additional Branch Logic Condition. The Automatic Branch Abort 
Task provides this function. The Task always runs unsupervised and provides a mechanism 
to add additional User Variable comparisons to the decision to continue Branching. Any 
number of Automatic Branch Abort Tasks can be inserted before the Branch Task, allowing 
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the Branch to depend on any number of Branch Logic Conditions. In this tutorial you will 
add a single Automatic Branch Abort Task to the Test Definition that acts as a safeguard by 
forcing a Branch Abort if the number of loop iterations grows too large.  

 
1.  Press <Ctrl-L> to remove the Branch Task from the Test Definition in the Editor. This 

can also be done by selecting "Remove Last Task" in the Vision "Editor" menu or in the 
popup menu that appears when you right-click in the EDITOR window.  

 
2.  From the Library Program Control folder move an Auto Branch Abort Task into the Edi-

tor. Configure the Task as follows:  
 

Task Name:   "Loop Counter Branch Abort Test"  
Parameter to Compare:   "Loop Counter"  
Comparison:   ">"  
Integer:   7  

± Tolerance:  0.0 
User Variable Limit Selection:  "<<None>>" 
Comments:  As appropriate  
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Figure 10 - Configure the Auto Branch Abort Task.  

 
3.   Click OK to append the Task to the Test Definition.  
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4.   From the Library, move a Branch Task back into the Editor. Reconfigure the Task as in 

Figure 6 .  
 
5.   Move the Test Definition into the DataSet. Name the CTD "Tutorial #3b - Multi-Volt 

Hysteresis 2". Execute the CTD. The behavior will be exactly as it was for the execution 
of "Tutorial #3B - Multi-Volt 1". Repeat execution and review the archived data as de-
sired. Note that, as configured, the Branch Abort Task will not abort Branch Looping be-
fore the Branch Task Branch Logic Condition terminates Branch Looping. 

 
Step 5 - Run the Filter in Accumulate Mode.  
 

An important consideration in Vision, and one that is addressed in this tutorial, is the behav-
ior of Filter Tasks programmed into a Branch Loop. The two previous executions of the Test 
Definition passed data into the Filter in its default mode. The Filter responded by generating 
a new plot window at each iteration and inserting the single, most-recently-measured plot in-
to the window. In this step the Filter will be reconfigured to change its behavior in the 
Branch Loop by enabling the Accumulate Mode. In this mode, the Filter will continue to 
generate a new plot at each iteration. However, at each execution of the Filter, the Task 
mines the Archive database for the entire history of the execution of the input Hysteresis 
Task. It then produces a plot that shows that history so that the first iteration will contain a 
single plot, the second the first two plots, and so on. This Filter option will be shown to have 
other uses in later steps in this tutorial.  

 
1.  Double-click the Filter Task icon in the Editor window to reopen the configuration dia-

log.  
 
2.  In the main dialog, check the From outside the loop, accumulate data from inside the 

loop control. Note that this control was previously labeled Accumulate .  
 
3.  Update Comments and the plot labels as appropriate. Click OK to update the Task in the 

Test Definition.  
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Figure 11 - Collect/Plot Filter Configured to Accumulate.  

 
4.  Move the Test Definition into the DataSet and name the CTD "Tutorial #3b - Multi-Volt 

3".  
 
5.  Execute the CTD. When the experiment has finished, the Vision program screen will ap-

pear as in Figure 12 .  
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Figure 12 - Vision After Execution in Accumulate Mode.  

  
6.  Reexecute and examine Archived data as desired.  

 
Step 6 - Run the Filter in Append Mode.  
 

A second Filter option, when running in a Branch Loop, is to configure the Task to execute 
in Append mode. Append and Accumulate modes are not independent. That is, the Task must 
be run in one or the other. If both are enabled, the Task will run in Append mode. In Append 
mode a plot window is opened on the first Filter iteration and the data from the associated in-
put Task are plotted. In subsequent iterations, the most-recently measured data are added to 
the plot on the single window by the Filter Task. This mode is the preferred mode when plot-
ting within a Branch Loop. All data are displayed without cluttering the User Space in Vision 
with many plots. If many iterations are executed, this method replaces the disadvantage of 
too many windows with the disadvantage of too many plots in a single window. However, 
once the CTD has executed, tools exist to display only a subset of the recorded plots.  

  
1.  Double-click the Filter Task icon in the Editor window to reopen the configuration dia-

log.  
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2.  Uncheck the From outside the loop, accumulate data from inside the loop control and 

update Comments as appropriate.  
 

  
Figure 13 - Disable Filter Accumulate Mode.  

  
3.  Switch to the "Collect/Plot Plot Setup" tab. Check the Append control and update plot la-

bels as appropriate. Click OK to update the Task in the Editor.  
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4.  Move the Test Definition into the DataSet and name the CTD "Tutorial #3b - Multi-Volt 

4".  
 

 
Figure 14 - Enable Append Mode. 

  
5.  Execute the CTD. When the experiment has finished, the Filter plot window will appear 

as in Figure 15.  
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Figure 15 - Plot Window of Filter in Append Mode After Execu-

tion. This Single Window Only will Appear.  
  

6.  Reexecute and examine Archive data as desired.  
 
Step 7 - Add a Filter After the Branch Task.  
 

A final question to be considered in this tutorial is the behavior of a Filter Task that is added 
after the Branch, but associated with a data input Task that is inside the Branch Loop. In this 
first example, both the Append and Accumulate modes are disabled. In this case, the Task 
will generate a single plot window with the most recent (8.0-Volt) measurement plotted.  

  
1.  Double-click the Filter Task in the Editor window to open it for reconfiguration.  
 
2.  Go to the "Collect/Plot Plot Setup" tab, uncheck Plot These Data and click OK to update 

the Task. Note that the plot label controls are disabled since the data will not be plotted. 
On execution this Task will continue to gather data that can be examined by recalling the 
Task from the DataSet Archive after complete execution.  
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Figure 16 - Collect/Plot Filter Plot Configuration Dialog with 

Plotting Disabled.  
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3.  From the Library Filters->Collect/Plot folder, move a Collect/Plot Filter Task into the 

Editor.  
 
4.  Configure the Task as follows:  

 
Collect/Plot Filter Task Name:  "Post-Branch Multi-Volt Hysteresis Data - Accumulate"  
From outside the loop, accumulate data 
from inside the loop:  

Unchecked  

Data Type:  Hysteresis  
Task Selector:  "Multi-Volt Hysteresis"  
Add Task:  Click this button after the Task Selector selection is made. 

An "(X)" will be appended to the Task name in the Task 
Selector window.  

Comments:  As appropriate  
 

  
Figure 17 - Collect/Plot Post-Branch Filter Configuration.  
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5.  Click on Collect/Plot Plot Setup tab. Configure the dialog as follows:  

 
 

Plot These Data:  Checked  
Append Data:  Unchecked  
Labels:  As Appropriate  

 
6.  Then click OK add the Task to the Test Definition in the Editor.  

 

  
Figure 18 - Collect/Plot Post-Branch Plot Configuration.  

 
7.  Move the Test Definition into the DataSet and name the CTD " Tutorial #3b - Multi-Volt 

5 ".  
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8.  Execute the CTD. When the experiment has finished, the Vision window will appear as 

in Figure 19.  
 

  
Figure 19 - Data Presented By Filter After the Branch Loop 

Terminates. No Accumulate or Append.  
  

9.  Reexecute and examine Archive data as desired.  
 
Step 8 - Run the Post-Branch Filter in Append Mode.  
 

This step demonstrates that programming the Filter, placed after the Branch Task, to acquire 
and display data in Append mode will not change its behavior. A single plot will be generat-
ed that shows the final (8.0-Volt) Hysteresis measurement.  

  
1.  Double-click the second Filter Task icon in the EDITOR Test Definition to reopen the 

configuration dialog for reconfiguration.  
 
2.  Go to the "Collect/Plot Plot Setup" tab, check Append , update plot labels and Comments 

as appropriate. Click OK to update the Task.  
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Figure 20 - Configure the Post-Branch Collect/Plot Filter to 

Append Data.  
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3.  Move the Test Definition into the DataSet and name the CTD " Tutorial #3b - Multi-Volt 

6 ".  
 
4.  Execute the CTD. The data appear as in Figure 20 . Except for plot labeling the data are 

identical to those of Figure 18 .  
 

  
Figure 21 - Data Presented By Filter After the Branch Loop 

Terminates. Append Mode.  
  

5.  Reexecute and examine Archive data as desired.  
 
Step 9 - Run the Post-Branch Filter in Accumulate Mode.  
 

This final example shows the proper use of the Filter when programmed after the Branch 
Loop. It also shows the proper use of the Accumulate mode. Here the Filter will mine the da-
tabase for the entire history of data collected by all executions of the Hysteresis Task. The 
single plot generated will show all six sets of data.  

 
1.  Double-Click the second Filter Task icon in the Editor Test Definition to reopen the con-

figuration dialog for reconfiguration.  
 
2.  Check From outside the loop, accumulate data from inside the loop . Update Comments 

as appropriate.  
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Figure 22 - Post-Branch Filter Task Configured to Accumulate.  
  

3.  Go to the "Collect/Plot Plot Setup" tab, uncheck Append and update plot labels as appro-
priate. Click OK to update the Task.  
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Figure 23 - Post-Branch Filter Task Accumulate Plot Configu-

ration.  
 

4.  Move the Editor Test Definition into the CTD and rename.  
 
5.  Execute the CTD. The data appear as in Figure 24.  
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Figure 24 - Data Presented By Filter After the Branch Loop 

Terminates. Accumulate Mode.  
  

6.  Reexecute and examine Archive data as desired.  
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C - PUND Pulse Width Dependence 
 

The PUND (a rather silly acronym meaning Positive Up Negative Down) measurement is a 
standard ferroelectric test consisting of five pulses applied in sequence. The pulses are of the 
same (programmable) pulse width, with a fixed delay time between the pulses and are of the 
same magnitude (|VMax|). The first pulse is in the negative VMax direction. It is not measured, but 
is used to preset the sample into the particular polarization (µC/cm2) state. The next two pulses 
are in the positive VMax direction. The first switches the polarization and the second does not so 
that both switched and unswitched polarization are measured. At each pulse measurements are 
made with the pulse voltage applied after the pulse width and again after the voltage returns to 
zero and a delay of the pulse width (ms). The last two pulses are in the negative VMax direction 
with the first pulse switching the sample and the last pulse maintaining the switched state. In this 
way switched and unswitched polarization is measured in both the positive and negative direc-
tion at both the pulse voltage and zero volts. Switched measurements are designate "P*" (P-Star) 
and unswitched measurements are called "P^" (P-Hat). Measurements at zero volts are distin-
guished by an appended "r". The eight measurements are, therefore, ±P*, ±P*r , ±P^ and ±P^r. 
Sample capacitance, known as Cef (C Effective), in nF, is derived from P* and the dielectric con-
stant (Kef ) is derived from Cef. See the PUND Task help pages for a more detailed discussion. 
 
PUND measured values are highly dependent on the pulse width (ms) up to the point that the 
pulse width exceeds 10 RC, where R is the output impedance of the tester (normally 1680 Ω) and 
C is the sample capacitance. Below this period, the pulse is not applied for a sufficient time to 
fully switch the sample and measured values are below values for longer pulse widths (ms). 
Clearly, the smaller the sample, the faster the PUND pulses can be programmed to run. This tu-
torial provides a practical Test Definition that characterizes PUND measurements as a function 
of pulse width (ms). The Test Definition consists of only three Tasks. The PUND Task makes 
the measurement and adjusts the pulse width (ms) by a factor of 2X in a Branch Loop. The Sin-
gle-Point Filter displays ±P* (µC/cm2), ±P^ (µC/cm2) and ±∆P (±P* - ±P^) (µC/cm2) as a func-
tion of the PUND pulse width (ms) at sample time. The Branch Task repeats the measurement 
seven times as the pulse width ranges from 1.0 µs (0.001 ms) to 1.0 second (1,000 ms), with the 
pulse width (µC/cm2) adjusted in decades. These values should be adjusted, if necessary, to 
maintain parameters within the specification of the tester being used and the sample limitations. 
 
The tutorial may be performed on either the 2600 Å 20 µm X 20 µm (4x 10-6 cm2 ) 4/20/80 
PNZT Internal Reference Ferroelectric, as in Tutorial #3a, or a sample of your choice. Labels 
and test parameters should be adjusted to reflect the sample under test. The sample is normally 
measured at 9.0 Volts. The parameter configurations and labels in the DataSet pertain to the 
4/20/80 PNZT. To maintain the measurement within the specifications of the Precision Multifer-
roic used to produce Tutorial #5, the DataSet includes data starting at 10.0 µs and adjusting, over 
seventeen iterations, to 1048.5 ms, with the pulse width doubling at each iteration. 
 
Step 1 - Create the Test Definition.  

  
1.  Clear the Editor of any Tasks. 
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2.  In the Vision Library, open the Hardware->Measurement->Pulse folder. Move the PUND 
Task into the EDITOR window.  

 

  
Figure 1 - Move the PUND Task into the EDITOR.  

  
3.  Configure the Task as follows: 

 
PUND Task Name:   "9.0-Volt/Variable Pulse Width PUND - Int. Ref. Ferroelectric"  
Max. Voltage:   9.0 (Or as appropriate for the sample attached)  
Pulse Width (ms):   0.001  
Enable Reference Ferroelectric:   Checked - Or use your own ferroelectric or linear sample at-

tached to the tester DRIVE and RETURN ports.  
Cap. A Enable:  Checked if Enable Reference Ferroelectric is checked. 
Sample Area (cm2):   Default if Enable Reference Ferroelectric, or as appropriate  

Sample Thickness (µm):   Default if Enable Reference Ferroelectric, or as appropriate  
Comments:  As appropriate  
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Figure 2 - Configure the PUND Task.  

 
4.  Click on Set Sample Info and add the information as follows. Note that if you are follow-

ing on from the previous tutorial or have re-accessed that tutorial's DataSet, these values 
will be preconfigured since they are persistent from the previous Task access.  

 
Sample Name:  "Internal Reference Cap.", or as appropriate  
Lot ID:  "N/A"  
Wafer ID:  "N/A"  

 
5.  Then click OK to return to the main dialog.  
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Figure 3 - Provide Sample Information.  

 
6.  Click on Set Adjust Params and configure as follows.  
 

Adjust Pulse Width (ms):   Checked  
Adjust by Scaling:   Checked  
Scale Factor:   2.0  
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Figure 4 - Configure the Branch Loop Parameter Adjustment.  

 
7.  Then click OK to return to the main dialog. Note that the Adjust Parameters in a Loop 

control now appears checked as in Figure 2 .  
 

Discussion:  
 
The three main PUND determining factors - Pulse Width (ms), Delay Time (ms) and 
PUND Voltage - may be independently adjusted in a Branch Loop. There are two meth-
ods of adjustment. In each, the programmed value, taken from the main dialog, is used in 
the first Branch iteration. Subsequent iterations determine the parameter value either by 
scaling the previous setting by a constant value or by incrementing it by a constant. In 
this example, the initial loop will be at 9.0 Volts with a Delay of 1000 ms and a Pulse 
Width of 0.001 ms. Adjustment of Delay and Max. Voltage are disabled. All iterations 
will measure at 9.0 Volts and with 1000 ms between pulses. Pulse Width will be scaled 
by a factor of 2.0 at each iteration. The second iteration will apply 0.002 ms pulses, the 
third 0.004 ms pulses and so on. Note that it is incumbent on the user to ensure that the 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 300 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

Branch Loop Branch Logic Condition is programmed in a way that ensures that the com-
bination of initial value, scale or increment constant and number of loops do not cause the 
adjusted parameter to exceed the capabilities of the hardware or cause any damage to the 
sample.  

 
8.  In the Vision Library open the Filters folder. Move the Single-Point Filter into the EDI-

TOR. Configure the Task as follows:  
 

Single-Point Filter Task Name:   "9.0-Volt/Variable Pulse Width (ms) PUND Data"  
Data Type:   PUND  
Task Selector:   "9.0-Volt/Variable Pulse Width PUND - Int. Ref. Ferroelectric"  
Add Task:   Click this button after the Task Selector selection is made. An "(X)" 

will be appended to the Task name in the Task Selector window.  
Single-Point X Axis Type:   "Pulse Width (ms)"  
Single-Point Data:   "P* (µC/cm2)", "P^ (µC/cm2)", "-P* (µC/cm2)", "-P^ (µC/cm2)", "dP 

(µC/cm2)" and "-dP (µC/cm2)"  
Add Trace:   After data are selected in Single-Point Data, click here to validate the 

selection. "(X)" will be appended to the selected values.  
Comments:  As appropriate  

 

  
Figure 5 - Configure the Single-Point Filter.  
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Discussion:  
 
At each Branch iteration the selected Single-Point Data values will be extracted from the 
PUND measurement and plotted as a function of Pulse Width (ms).  

 
9.   Click on the Plot Setup tab. Configure the dialog as follows:  
 

Plot These Data:  Checked  
X-Axis Log Scale:  Checked  
Labels:  As Appropriate  

 
10.  Then click OK add the Task to the Test Definition in the EDITOR.  

 

  
Figure 6 - Configure the Filter Plotting Dialog.  
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2. In the Vision Library open the Program Control folder. Move the Branch Task into the 

Editor. Configure the Task as follows:  
 

Branch Task Name:   "PUND Variable Pulse Width (ms) Branch Loop Branch to 655 ms"  
Parameter To Compare:   "PUND: Current Pulse Width"  
Comparison:   "<"  
Integer:   1000.0 
Use Tolerance:  Unchecked 
User Variable Limit Selection:  "<<None>>" 
Branch Point Task:   "PUND Variable Pulse Width (ms) Branching - Branch to 655 ms"  
Select Branch Target:  Click this button after the Branch Point Task selection is made. 
Comments:  As appropriate  

 

  
Figure 7 - Configure the Branch Task.  
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Discussion:  
 
The configuration and execution of the Branch Task has been described in detail in Tuto-
rial II-D and II-E. In the present case the Branch Logic Condition is based on the 
"PUND: Current Pulse Width" User Variable that is added and updated by the PUND 
Task. That value runs from 0.001 ms to 655.0 ms, or greater, as the Branch Loop iterates. 
The value doubles over each Branch Loop iteration. It would also be proper to control on 
"Loop Counter", determining in advance the proper number of iterations.  

 
Step 2 - Update the DataSet.  

  
1.  If DataSet Tutorial #3b is not open, open it.  
 
2.  Using any of the methods presented in earlier tutorials, move the Test Definition from the 

Editor into the DataSet as the Current Test Definition (CTD). Name the CTD "Tutorial 
#3b - 9.0-Volt/Variable Pulse Width (ms) PUND 1".  

 

  
Figure 8 - Name the CTD. 

 
Step 3 - Run the CTD.  

 
1.  Using any of the methods discussed in earlier tutorials, execute the Experiment. As the 

CTD runs, a PUND measurement is made, then the Filter Task plots the ±P*, ±P^ and 
±∆P response as a function of the Pulse Width at that Branch Loop iteration. At each new 
iteration, a the Filter plot window will be updated with the most recently made PUND re-
sponse. After seven iterations, the CTD will terminate and the Archive will be written. 
The figures below show data recovered from the Archive after the first, fourth and final 
measurement. The final measurement is shown again with normal (not log) X-Axis scal-
ing and in the maximized view.  
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Figure 9 - PUND Response After the First Branch Loop Itera-

tion.  
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Figure 10 - PUND Response After the Fourth Branch Loop It-
eration. Log X Scale.  

 

  
Figure 11 - PUND Response After the Seventh Branch Loop It-

eration. Log X Scale.  
 

  
Figure 12 - PUND Response After the Final Branch Loop Itera-

tion. X-Axis Normal Scaling (Not Log Scale).  
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Figure 13 - PUND Response After the Final Branch Loop Itera-

tion. Maximized View - Linear Scale.  
 

2.  Any of the PUND, Filter or Branch Task executions may be recalled from the DataSet 
Archive for review by double-click the Task icon in the "Experiment Data" folder of the 
Executed Test Definition (ETD). Reexecute the experiment and review data as desired.  
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D - Data Noise Reduction 
 

Measurements on ferroelectric capacitors that return very low polarization values - especially on 
capacitors in the range 1.0 µm2 or smaller - have noise and system parasitic components that can 
become significant in ratio to the measured sample response. Since noise is random and the sam-
ple response is constant, noise can be reduced in the measured response by repeated measure-
ment and averaging over the number of measurements. System parasitics are contributions to the 
response of the tester's internal electronics. These can simply be measured and subtracted from 
the total sample response. However, measurement of these parasitics is also susceptible to noise, 
so that repeated measurement and averaging of the constant parasitics is necessary to keep the 
subtraction from reintroducing noise into the total corrected response. 
 
This tutorial will take advantage of Branch Looping to make the repeated measurement and av-
eraging of both the sample and the system parasitics. The two distinct measurements are sub-
tracted in the final step of the Test definition. This tutorial introduces two new Filter Tasks: 
 

1.  Single-Trace Loop Average Filter. This Filter is called "Single-Trace" because it limits 
inputs to a single Measurement or Filter Task, and then only to a Filter Task type that 
produces only a single output trace. This is an inherited limitation. It is enforced to allow 
the Filter to be associated with the Two-Trace Math Filter (as in this tutorial), that, of ne-
cessity, enforces similar limitations. (A second Filter Task - the Multi-Trace Loop Aver-
age Filter - is identical to the Single-Trace Loop Average Filter except that is accepts in-
puts from multiple Tasks and Filters that produce multiple traces. It cannot be associated 
as an input Task with the Two-Trace Math Filter.) The Single-Trace Loop Average Filter 
is designed for use within a Branch Loop. It has no utility outside of a Branch Loop. The 
Filter is associated with a Measurement Task or another Filter. In the first iteration of the 
Branch Loop it gathers the input data. In subsequent iterations it sums the input data with 
previous accumulations. It then produces a trace that is the summation divided by the cur-
rent iteration count. Both the accumulation/summation data and the averaged data are 
available for user review. Note that, although perfectly legal, it is unlikely that associat-
ing this Task with a Measurement Task that changes parameters in the loop will produce 
meaningful data. 

2.  Two-Trace Math Filter. This Filter takes exactly one input data vector from exactly two 
sources. It then combines the two traces using one of four basic mathematical operations 
- addition, subtraction, multiplication or division. 

 
Please see the help pages for these two Filter Tasks for more detailed descriptions of Task con-
figuration, operation and theory. 
 
Step 1 - Create the Test Definition.  

 
1.  In the Vision Library, open the Program Control folder. Drag-and-Drop the Pause Task 

into the Editor window.  
 
2.  Configure the Task as follows: 
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Pause Task Name:  "Tutorial #3d - Parasitics Startup"  
User Self-Prompt:  "Disconnect DRIVE and RETURN Cables, then Press <Enter>"  
Parameter to Append to Prompt:  "None"  
Comments:  As appropriate  

 

  
Figure 1 - Configure the Startup Pause Task.  

  
3.  Move the Hysteresis Task from the Hardware->Measurement->Hysteresis Library folder 

to the EDITOR.  
 
4.  Configure the Task as follows: 

 
Hysteresis Task Name:   "9.0-Volt/10.0 ms Parasitics Measurement"  
Max Voltage:   9.0 Volts or as appropriate for the sample being measured.  
Period (ms):   10.0 ms or as appropriate for the sample being measured.  
Adjust Params:  Adjust Parameters in a Loop may be checked since the state is persistent from the 

previous tutorial. Click Adjust Params and disable any parameter adjustment in the sub-
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dialog. When finished Adjust Parameters in a Loop will be unchecked. 
 

 
Figure 2 - Disable Parameter Adjustment.  

Enable Reference 
Ferroelectric:  

 Unchecked. This control must be disabled in this step regardless of if you intend to 
measure the internal sample or attach your own sample to the tester DRIVE and RE-
TURN ports.  

Sample Area (cm2):   Default or as appropriate to reflect your sample.  
Sample 
Thickness (µm):   Default or as appropriate to reflect your sample.  

Comments:  As appropriate  
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Figure 3 - System Internal Parasitics Hysteresis Configuration.  
  

5.  Click on Set Sample Info and add the information as follows. Note that if you are follow-
ing on from the previous tutorial or have re-accessed that tutorial's DataSet, these values 
will be preconfigured since they are persistent from the previous Task access.  

 
Sample Name:  "No Sample - Parasitics"  
Lot ID:  "N/A"  
Wafer ID:  "N/A"  

 
6.  Then click OK to return to the main dialog.  
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Figure 4 - Provide Sample Information.  

 
7.  Open the Library Filters->Averaging folder and move the Single-Trace Loop Average 

Filter into the EDITOR. 
 
8.  Configure the Task as follows: 

 
STLA Task Name:   "9.0-Volt/10.0 ms Hysteresis System Parasitics Average"  
Data Type:   "Hysteresis"  
Task Selector:   "9.0-Volt/10.0 ms Parasitics Measurement"  
Add Task:   Click this button after highlighting the Task Selector item.  
Average X Domain:   Checked. This will cause voltage data from the Hysteresis to be accumulated and 

averaged along with the polarization data. If this box is not checked, the Task will take 
voltage data from the most-recently-measured Hysteresis execution at each iteration.  

Comments  As appropriate  
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Figure 5 - Single-Trace Loop Average Parasitic-Input Filter 

Configuration.  
 

9.  Click on the "Plot Setup" tab and configure the dialog as follows: 
 

Plot These Data:  Checked  
Plot Labels:  As appropriate 
Plot Type:  "Averaged Data"  
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Figure 6 - Accumulate/Average Parasitic Plot Configuration.  

 
10.  From the Program Control folder move the Branch Task from the Library to the EDI-

TOR. 
 
11.  Configure the Task as follows: 

 
Branch Task Name:   "Parasitics Averaging Branch Loop"  
Parameter to Compare:   "Loop Counter"  
Comparison:   "<="  
Integer:   19  
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Use Tolerance:  Unchecked 
User Variable Limit Selection:  "<<None>>" 
Branch Point Task:   "5.0-Volt/10.0 ms Parasitics Measurement" (Hysteresis Task 

configured above).  
Select Branch Target:   Click this button after the Branch Point Task has been selected.  
Comments:  As appropriate  

 

  
Figure 7 - Configure the Parasitics Measurement Branch Loop.  
  

12.  Make a duplicate of the Test Definition: 
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1.  If the Tutorial #3b DataSet is not open, open it. 
2.  Right click in the Editor Window and select "Test Definition to Current DataSet". 
3.  Name the CTD "Tutorial #3D - Measurement Noise Reduction" 

 

  
Figure 8 - Move the Test Definition from the EDITOR to the Da-

taSet.  
 

4.  Select the CTD name, right click and select "Current Test Definition to Editor". The 
first four Tasks of the Test Definition, configured above, are duplicated in the 8-Task 
Test Definition. 
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Figure 9 - Move the Test Definition from the DataSet back to the 

EDITOR.  
 

3. Double-click the second instance of the "Tutorial #3d - Parasitics Startup" Pause Task. 
Reconfigure the Task as follows: 

 
Pause Task Name:  "Sample Measurement Startup"  
User Self-Prompt: "Connect the Sample to DRIVE and RETURN, then Press <Enter>"  
Parameter to Append to Prompt:  "<<None>>"  
Comments:  As appropriate  
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Figure 10 - Configure the Sample Measurement Startup Pause 

Task.  
 
4. Double-click the second instance of the "9.0-Volt/10.0 ms Parasitics Measurement" 

Hysteresis Task to open the configuration dialog.  
  
5. Configure the Task as follows: 

 
Task Name:  "9.0-Volt/10.0 ms Sample Hysteresis Measurement"  
Max. Voltage:  Do not alter from the Parasitics Hysteresis configuration.  
Hysteresis Period:  Do not alter from the Parasitics Hysteresis configuration.  
Enable Reference Ferroelectric:  Checked, or uncheck and attach your own sample to the tester 

DRIVE and RETURN ports.  
Cap A Enable: Checked if Enable Reference Ferroelectric is checked. 

Sample Area (cm2):  Default if Enable Reference Ferroelectric is checked or as ap-
propriate to reflect your sample.  

Sample Thickness (µm):  Default if Enable Reference Ferroelectric is checked or as ap-
propriate to reflect your sample.  

Comments:  As appropriate  
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Figure 11 - Sample Measurement Hysteresis Configuration.  

  
6. Click Set Sample Info. In the subdialog identify Sample Name as appropriate. Click 

OK to close the subdialog and OK to close the dialog. 
 

 
Figure 12 - Sample Information.  
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7.   Double-click the second instance of the "5.0-Volt/10.0 ms Hysteresis System Para-

sitics Average" Single-Trace Loop Average Filter Task to open the configuration dia-
log and configure the Task as follows: 

 
Task Name:  "9.0-Volt/10.0 ms Sample Hysteresis Average"  

Data Type:  "Hysteresis"  
Task Selector:  "9.0-Volt/10.0 ms Sample Hysteresis Measurement"  
Add Task:  Click this button after highlighting the Task Selector item.  
Average X-Domain:  Checked.  
Comments:  As appropriate  

 

  
Figure 13 - Single-Trace Loop Average Filter Configuration.  
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8. Click on the "Plot Setup" tab and configure the dialog as follows: 

 
Plot These Data:  Checked  
Plot Labels:  As appropriated  
Plot Type:  "Averaged Data"  

 

  
Figure 14 - Single-Trace Loop Average Plot Configuration.  

 
9.   Double-click the second instance of the "Parasitics Averaging Branch Loop" Branch 

Task to open the configuration dialog. 
 
10.   Configure the Task as follows: 
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Task Name:  "Sample Measurement Averaging Branch Loop"  

Parameter to Compare:  "Loop Counter"  
Comparison:  "<="  
Integer:  19  
Branch Point Task:  "9.0-Volt/10.0 ms Sample Hysteresis Measurement" (Hysteresis Task config-

ured above).  
Select Branch Target:  Click this button after the Branch Point Task has been selected.  
Comments:  As appropriate  

 

  
Figure 15 - Configure the Sample Measurement Branch Loop.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 322 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
11.   From the Library Filters->Math folder and move the Two-Trace Math Filter into the 

Editor. 
 
12.   Configure the Task as follows: 

 
Branch Task Name:   "Parasitics Averaging Branch Loop"  
Parameter to Compare:   "Loop Counter"  
Comparison:   "<="  
Integer:   19  
Use Tolerance:  Unchecked 
User Variable Limit Selection:  "<<None>>" 
Branch Point Task:   "5.0-Volt/10.0 ms Parasitics Measurement" (Hysteresis Task config-

ured above).  
Select Branch Target:   Click this button after the Branch Point Task has been selected.  
Comments:  As appropriate  

 
13. Add a Two-Trace Math Filter Task. 

Task Name:   "Parasitics-Corrected/Noise-
Reduced Sample Hyst. Data"  

From outside a loop accumulate all data taken inside the loop:   Unchecked  
Data Type:   "Single-Trace Loop Average Fil-

ter"  
Task List A: Task Selector:   "9.0-Volt/10.0 ms Sample Hystere-

sis Average"  
Task List A: Add Task:   Click this button after highlighting 

the Task Selector item.  
Task List B: Task Selector:   "9.0-Volt/10.0 ms Hysteresis Sys-

tem Parasitics Average"  
Task List B: Add Task:   Click this button after highlighting 

the Task Selector item.  
X-Axis Option:   "Average A and B"  
Operation:   "Subtraction: Task A - Task B"  
Comments:  As appropriate  
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Figure 16 - Two-Trace Math Parasitic-Input Filter Configura-

tion.  
 

Discussion:  
 
This Task takes input of exactly one data vector from each of exactly two source Tasks 
(Task A and Task B). Data Type identifies the source Task type - here "Single-Trace Loop 
Average  Filter". The complete list of preceding Tasks of the selected type appear in the 
Task List A and Task List B Task Selector controls. A single input source is selected in 
each control, then Add Task is clicked to validate the selection. (Note that normally dis-
tinct input Tasks are selected as Task A and Task B, but this is not required.). The math-
ematical Operation is specified and will be performed by applying Task B to Task A 
(A+B, A-B, AxB or A/B). X-Axis Option determines the source and nature of the inde-
pendent domain data vector (here Voltage, passed to this Filter through the Accumu-
late/Average Filter). The independent values may be taken directly from the A or B Task 
or may be an averaged combination of both. There is also an option to perform the same 
math on the independent data vector as on the dependent (Y-Axis) vector.  

 
14. Click on the "Two-Trace Math Plot Setup" tab and configure the dialog as follows: 

 
Plot These Data:  Checked  
Append Data  Unchecked.  
Plot Labels  As appropriated  
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Figure 17 - Two-Trace Math Filter Plot Configuration.  

 
Step 2 - Update the DataSet.  

  
1.  If DataSet Tutorial #3b is not open, open it.  
 
2.  Using any of the methods presented in earlier tutorials, move the Test Definition from the 

Editor into the DataSet as the Current Test Definition (CTD). Name the CTD "Tutorial 
#3D - Measurement Noise Reduction".  

 

  
Figure 18 - Name the CTD.  

 
Step 3 - Run the CTD.  
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1.  Using any of the methods discussed in earlier tutorials, execute the Experiment. The Test 
Definition begins by prompting the user to disconnect the sample DRIVE and RETURN 
so that the tester is running unloaded. (If you intend to measure the internal reference ca-
pacitor, make sure that the control is not checked in procedure 4 (Figure 2) of Step 1 , 
above.)  

 

  
Figure 19 - Pause to Ensure Proper Parasitics Measurement 

Configuration.  
 

2.  Once the Pause Task is acknowledged, the program will sequence through a Hysteresis 
measurement and the Accumulate/Average Filter for twenty iterations. The tester is un-
loaded by any sample, so that the measured response purely relates to signal induced by 
the tester's internal electronics. As the cycling proceeds, the Accumulate/Average re-
sponse will become increasingly noise-free. The most dramatic changes will occur in the 
first few cycles. Figures 20 through 22 show the Filter iterations at Loop 1, 10 and 20. 
Note that there is little difference between the response of Figure 21 and that of Figure 
22. Note that the response polarization (µC/cm2) is very small in magnitude. This parasit-
ic value is of concern only to measurements that on samples that produce small polariza-
tion responses.  
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Figure 20 - Parasitics Measurement - Iteration 1 - Unaveraged.  

 

  
Figure 21 - Parasitics Measurement Averaged Ten Times.  
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Figure 22 - Parasitics Measurement Averaged Twenty Times.  

  
3.  Once the parasitic loop has terminated, a second Pause Task appears to prompt the user to 

reinsert the sample. The sample should now be connected to the tester DRIVE and RE-
TURN ports or, if using the internal reference capacitor, the Enable Ref. Cap. control 
should be checked in procedure 13, ( Figure 13 ) of Step 1 , above. This must be done 
before acknowledging the Pause Task.  
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Figure 23 - Pause to Insert the Sample into the Signal Path.  
 

4.  When the Pause Task is acknowledged, the Test Definition will enter a Branch Loop in 
which a Hysteresis measurement is made that passes its data into an Accumulate/Average 
Filter. The measurement and data averaging are repeated twenty times. This is the sample 
process as in sequence 2 of this step. The only differences should be that the sample is 
placed in the signal path and Filter plot labeling reflects the sample presence. Figures 24 
through 26 show the progress of the noise reduction at step 1, 10 and 20. The polarization 
(µC/cm2) of the 4/20/80 PNZT sample in the figures is not low with respect to measure-
ment noise, so the averaging does not appear to improve the measurements in these ex-
amples. Nevertheless, the techniques of these examples are valid noise reduction options. 

 

  
Figure 24 - Sample Measurement - Iteration 1 - Unaveraged.  
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Figure 25 - Sample Measurement Averaged Ten Times.  

 

  
Figure 26 - Sample Measurement Averaged Twenty Times.  

 
5.  Finally, the Two-Trace Math Filter subtracts the data generated by the final iteration of 
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the Parasitics Accumulate/Average Filter (Figure 22) from those generated by the final 
execution of the sample measurement Filter of Figure 26. The results are displayed in 
Figure 27. Note that in this example the sample response is three orders of magnitude 
larger than the parasitic response, so that the subtraction has little or no apparent effect. 
The same should be observed by users that perform the tutorial using the Internal Refer-
ence Capacitor.  

 

  
Figure 27 - Sample Measurement with Parasitics Removed and 

Noise Reduced by Averaging.  
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E - Custom Text-File Parameter  Adjustment 
 
In addition to incrementing or scaling a parameter by a fixed value in a Branch Loop, several 
Tasks now offer custom parameter adjustment by setting the parameter, line-by-line, from values 
written to a text file. Tasks that offer this feature include: 
 

•  DC Bias 
•  General Pulse 
•  Hysteresis 
•  Simple Pulse 
•  Advanced Piezo 
•  Curve Energy 
•  DLTS 
•  CS 2.5 DC Magnetic Field 
•  Current Loop 
•  Quantum Design PPMS/Dynacool Cryochamber control. 
 

As of this writing this list is rather arbitrary. This capability is being extended to all Tasks capa-
ble of Branch Loop Parameter Adjustment and updated Tasks will be released as they are com-
pleted.  
 
Each Branch Loop iteration will take its programmed parameter from a line in the custom file. 
The first iteration will take the first value and so on. If the number of Branch Loop iterations ex-
ceeds the number of lines in the input file, the sequence will repeat until Branching terminate. If 
Branching is to depend on the current value of the parameter under custom adjustment, one entry 
in the file should be set to a value that causes the execution to terminate. For example: 
 

If "Hysteresis: Current Volts" < 10.0 then Branch 
 

a terminating entry in the file of 10.0 Volts or greater should be entered into the file. Other op-
tions include having the Branch Task decision depend on "Loop Counter" or set the Branch Task 
Branch Loop Limit to a terminating value. 
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Figure 1 - Custom Adjustment Branch Task Options. 
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Step 1 - Create a Custom Hysteresis Voltage Sequence File 
 

1.  Using the Windows Notepad program assign a sequence of Hysteresis Task Voltages in 
the range ±10.0 Volts. (Note that the example does not necessarily reflect a practical use 
of this feature.) 

 

 
Figure 2 - Custom Hysteresis Voltage Sequence. 

 
2.  Save the file to an appropriate location and under and appropriate file name. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 334 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
Figure 3 - Save the Custom Hysteresis DRIVE Voltage File. 

 
Step 2 - Create the Test Definition  
 

1.  Clear the EDITOR if there are Tasks in it. 
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2.  Move a Hysteresis Task to the EDITOR. 
3.  Configure the Task as follows: 
 

Hysteresis Task Name:  "10.0 ms/Custom Voltage Hysteresis - Int. Ref. Ferroelectric" 
Max Voltage: 

 4.0 (Default - or any arbitrary value) 
Period (ms): 

 10.0 
Enable Reference Ferroelectric:  Checked (Or attach your own sample to the tester DRIVE and RE-

TURN ports) 
Cap A Enable:  Checked (if Enable Reference Ferroelectric is checked) 
Comments: As appropriate 

 

 
Figure 4 - Initial Hysteresis Task Configuration. 

 
4.  Click Adjust Params  to open the Branch Loop Parameter Adjustment Configuration 

subdialog. 
5.  Configure the as follows: 
 
Adjust Hysteresis Volts in a Loop:  Checked 
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Adjust by Custom File: 
 Checked 

Browse to File: 
 Click this button to open a standard Windows File 

Browser. Use the browser to navigate to and select the custom 
Hysteresis Voltage DRIVE Profile Text File. Click Open to 
register the file. 

File Path and Name (Unlabeled):  This control is update after the file is selected. 
 

 
Figure 5 - Configure Hysteresis Voltage Custom Branch Loop 

Adjustment.  
 
6.  Click OK to close the parameter adjustment subdialog. Adjust Parameters in a Branch 

Loop will be checked on the main Hysteresis configuration dialog. 
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Figure 6 - Adjust Parameters in a Branch Loop is Checked.  

 
7.  Click OK to close the Hysteresis configuration dialog and add the Task to the EDITOR. 
8.  Move the Hysteresis Filter Task from TASK LIBRARY->Filters->Task-Specific to the 

EDITOR. Configure the Task as follows: 
 

Hysteresis Filter Task Name:  "Centered Custom-Volt/10.0 ms Hysteresis Data". 
Filter: 

 "Centered Polarization (µC/cm2)" or as preferred. 
Task Selector: 

 "10.0 ms/Custom Voltage Hysteresis - Int. Ref. Ferroelectric". 
Add Task:  Click this button after make the Task Selector selection to register the 

input Task. 
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Figure 7 - Hysteresis Filter Task Main Configuration Dialog Tab.  
 
9.  Click the "Plot Setup" tab. Ensure Plot These Data and Append These Data to Previous 

Data Taken Inside a Loop are checked. Assign plot labels as appropriate. Select the X-
Axis Plot Option as appropriate. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 339 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
Figure 8 - Hysteresis Filter Task Plot Configuration Tab.  

 
10.  Click OK to close the dialog an append the Hysteresis Filter Task to the Test Definition 

in the EDITOR. 
11.  Move a Branch Task into the EDITOR. Configure the Task as follows (or establish 
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Branch Loop Logic as desired): 
 

Branch Task Name:  "Branch Over 10.0 ms/Custom Voltage Hysteresis Iterations" 
Parameter to Compare: 

 "Loop Counter" 
Comparison: 

 "<" 
Integer:  10 
Use Tolerance:  Unchecked 
User Variable Limit Selection:  "<<None>>" 
Branch Point Task:  "10.0 ms/Custom Voltage Hysteresis - Int. Ref. Ferroelectric" 
Select Branch Target:  Click this button after selecting the Branch Point Task. 
Comments: As Appropriate 
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Figure 9 - Configure the Branch Task.  

 
12.  Click OK to close the dialog and add the Branch Task to the Test Definition in the EDI-

TOR. 
 

Step 3 - Update the DataSet.  
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1.  If DataSet Tutorial #3b is not open, open it.  
 
2.  Using any of the methods presented in earlier tutorials, move the Test Definition from the 

Editor into the DataSet as the Current Test Definition (CTD). Name the CTD "Tutorial 
#3E - Custom Branch Loop Parameter Adjustment".  

 

  
Figure 10 - Name the CTD.  

 
Step 4 - Run the CTD.  

 
1.  Using any of the methods discussed in earlier tutorials, execute the Experiment. The Hys-

teresis Task will execute repeatedly at the specified variety of voltage levels and the Hys-
teresis Filter Task will append the measured data at each execution. As configured, the 
list of Figure 2, with ten entries, will be repeated once as the Branch Task loops over 
twenty iterations. 
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Figure 11 - First Branch Iteration.  

 

 
Figure 12 - Fourth Branch Iteration. 
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Figure 13 - Seventh Branch Iteration. 

 

 
Figure 14 - Tenth Branch Iteration.  
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IV - Vision Data File Export & Import 
 

Vision Data File Export & Import 
 

As presented in this tutorial, the Vision Data File Export/Import options was intended as a solu-
tion to the problem of moving data from one part of Vision - QuikLook Execution, DataSet Ar-
chives - to another - normally a new DataSet - for direct comparison with other archived data 
and/or with immediate measurements. That functionality is now more efficiently and better 
served using Vision tools such as Data Mining and ETD Transfer. Nevertheless, the Vision Data 
File export/import option remains available and may be a more-efficient tool when moving data 
from a small number of Tasks. It may also serve when passing data from single measurements 
among researchers who have Vision available. This tutorial presents the Vision Data File tool as 
originally conceived.  
 
Vision offers an exporting option called Vision Data File Exporting. This option is available to 
all Measurement Tasks and most Filter Tasks. When this option is selected, a file path and file 
name are specified. The Task then writes a binary file with the specified name that stores both 
configuration parameters and measured values. Subsequent executions of the Task can be con-
figured to take their data from the file rather than by direct measurement. This simple mechanism 
is a powerful tool because it allows a single measurement - taken under QuikLook or in a Da-
taSet - to be repeatedly referenced throughout Vision. In particular, data taken from one DataSet 
can be recalled and filtered in another. An example is shown in Figure 1. 
 
Note that the Task configurations in the figures of these tutorial help pages match the configura-
tions specified in the tables and discussion. Measurements are configured to be made on the 100 
µm X 100 µm 2700Å 4% niobium doped 20/80 PZT (4/20/80 PNZT) sample. This is the sample 
that is inserted as the Internal Reference Ferroelectric in all modern Precision tester. It is de-
tailed here. A 2.5 MΩ Reference Resistor and a 1.0 nF Linear Reference Capacitor are also 
available and may be switched into the signal path. Or the user's own sample may be connected 
to the tester's DRIVE and RETURN ports. The Internal Reference Ferroelectric is not available 
in the discontinued Precision RT66B and Precision LC tester models.  
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Figure 1 - Utility of Vision Data File Exporting.  

 
In this Tutorial a QuikLook Hysteresis measurement will be made at 5.0 Volts. You will write 
the measured data to a Vision data file. Then you will construct a Test Definition with three Hys-
teresis Tasks. The first Task will import the Vision data file. The second and third Tasks will 
measure independently at 6.25 Volts and 7.5 Volts respectively. A Collect/Plot Filter will gather 
and display the data from all three Hysteresis Tasks. Note that the figures below will show data 
measured on a 100 µm X 100 µm 4/20/80 PNZT sample manufactured by Radiant Technologies, 
Inc. You may provide your own sample (and label accordingly) or select the Internal Reference 
Ferroelectric. 
 
Step 1 – 5.0-Volt QuikLook Hysteresis Measurement  

  
1.  From the main Vision menu, select " QuikLook->Hysteresis Tasks->Hysteresis".  
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Figure 2 - Select the QuikLook Hysteresis Task.  

 
2.  Configure the Task as follows: 

 
Task Name:   "5.0-Volt/10.0 ms Hysteresis"  
Max. Voltage:   5.0  
Hysteresis Period (ms):  10.0  
Enable Reference Ferroelectric:   Checked - Or use your own ferroelectric or linear sample at-

tached to the tester DRIVE and RETURN ports.  
Cap A Enable:  Checked, if Enable Reference Ferroelectric is checked. 
Sample Area (cm2):  Default if Enable Reference Ferroelectric is checked, or as 

appropriate  
Sample Thickness (µm):   Default if Enable Reference Ferroelectric is checked., or as 

appropriate  
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Figure 3 - Configure the QuikLook Hysteresis Task.  

 
3.  Click on Set Sample Info and add the information as follows.  
 

Sample Name:  "Internal Reference Ferro", or as appropriate  
Lot ID: "N/A"  
Wafer ID: "N/A"  

 
4.  Then click OK to return to the main dialog.  
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Figure 4 - Provide Sample Information.  

 
5.  Click the "QuikLook Plot Setup" tab and configure the data labeling as appropriate.  

 

  
Figure 5 - Configure Plotted Data Labeling.  

  
6.  Click OK to make the measurement. The green ACTIVE LED will extinguish on the test-

er front panel while the drive voltage is applied to the sample. The light make turn on an 
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off several times as measurements are made and RETURN amplification levels are ad-
justed. A Stop Measurement button will appear during the Task execution. Once the 
measurement is complete, the data will appear in the QuikLook Results dialog as in Fig-
ure 6. 

 

  
Figure 6 - 5.0-Volt Hysteresis Measured Data.  

  
7.  On the QuikLook Results dialog click Export. The standard export dialog will appear as 

in Figure 7. 
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Figure 7 - Standard Vision Export Dialog. Select "Export Vi-

sion".  
  
8.  Set Select Option to "Export Vision". Browse for File Name will be enabled. Click the 

control to open the browser. 
9.  Browse to an appropriate folder and assign an appropriate file name, then click Save. 
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Figure 8 - Standard Windows File Browser Dialog. Assign File 

Name and Location.  
 

10.  The File Name control in the Export dialog will be updated with the assigned file path 
and file name. This control is read-only and can only be set by using the Browse for File 
Name button. Note that the *.vis file extension is assigned automatically. 
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Figure 9 - Export Dialog with Updated File Name Control.  

  
11.  Click OK to close the Export dialog, then click OK to close the QuikLook Results dialog. 

The Vision Data File will be written when the main dialog is closed. The delay in writing 
the data is to allow you to change the export option. 

 
Step 2 – Create the Test Definition.  

  
1.  Clear the Editor if there are Task in it. 
2.  Open the Hardware->Measurement->Hysteresis folder in the Vision TASK LIBRARY. 
3.  Move the Hysteresis Task from the TASK LIBRARY to the EDITOR. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 354 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 10 - Move the Hysteresis Task into the Editor from the 

Library.  
 

4.  Configure the Task as follows: 
 

Task Name: "5.0-Volt/10.0 ms Imported Hysteresis"  

Comments: As appropriate  
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Figure 11 - Start to Configure the First Hysteresis Task to Im-

port its Data.  
  

5.  Click Set Hysteresis VDF Import. A subdialog will open. Check Import Hysteresis Vision 
Data File. Browse to File will be enabled. Click Browse to File to open a standard Win-
dows file browser dialog. Use the dialog to navigate to the Vision Data File 
C:\Testing\5.0-Volt 10.0 ms QuikLook Hysteresis.vis. Click OK to close the browser. 
The file path and file name will appear. Click OK to close the subdialog. Read Data 
From Vision File will be checked and the file path and file name will appear below the 
checkbox. 
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Figure 12 - Enable VDF Import and Locate the Input File.  
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Figure 13 - Hysteresis Task Configured to Import the Vision Da-

ta File (VDF/*.vis). 
 

6.  Click OK. The Task will appear in the Editor Test Definition. 
 

  
Figure 14 - First Task in the Test Definition.  

  
7.  Move a second Hysteresis Task into the EDITOR. Configure the Task as follows: 

 
 

Task Name:   "6.25-Volt/10.0 ms Hysteresis"  
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Set Hysteresis VDF Import:  Click this button to open the subdialog, then uncheck Import 
Hysteresis Vision Data File to disable the import. 
 

 
Figure 15 - Disable VDF Import.  

Max. Voltage:   6.25  
Hysteresis Period (ms):  Persistent from the QuikLook Execution  
Sample Area (cm2):   Persistent from the QuikLook Execution  
Sample Thickness (µm):   Persistent from the QuikLook Execution  
Internal Reference Ferroelectric:  Persistent from the QuikLook Execution 
Cap A Enable:  Persistent from the QuikLook Execution 
Set Sample Info:   Persistent from the QuikLook Execution  
Comments: As appropriate  

 

  
Figure 16 - 6.25-Volt Hysteresis Task Configuration.  
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8.  Move a third Hysteresis Task into the EDITOR. Configure the Task as follows: 

 
Task Name:   "7.5-Volt/10.0 ms Hysteresis"  
Read Data From File:   Unchecked 
Max. Voltage:   7.5  
Hysteresis Period (ms):  Persistent from the QuikLook Execution  
Sample Area (cm2):   Persistent from the QuikLook Execution  
Sample Thickness (µm):   Persistent from the QuikLook Execution  
Set Sample Info:   Persistent from the QuikLook Execution  
Internal Reference Ferroelectric:  Persistent from the QuikLook Execution 
Cap A Enable:  Persistent from the QuikLook Execution 
Comments:  As appropriate  

 

  
Figure 17 - 7.5-Volt Hysteresis Task Configuration.  

 
9.  Open the "Filters-" folder in the TASK LIBRARY. Move the Collect/Plot Filter Task into 

the EDITOR. Configure the Task as follows: 
 

Task Name:   "Multi-Volt/10.0 ms Hysteresis Data"  
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Data Type:   "Hysteresis"  
Task Selector:   Select all three listed Hysteresis Tasks  
Add Task:   Click after the three Tasks are selected in Task Selector  
Comments:  As appropriate  

 

  
Figure 18 - Collect/Plot Filter Task Main Configuration.  

 
10.  Click the "Collect/Plot Plot Setup" tab. Configure the Plot as follows: 

 
Plot these Data: Checked  
Plot Title: "5.0, 6.25 and 7.5-Volt/10.0 ms Hysteresis Data"  
Plot Subtitle: "5.0-Volt Input Task Recovers Data from a Vision Data File"  
Plot X Axis Label:  "Voltage"  
Plot Y Axis Label:  "Polarization (µC/cm2)" Note: to type "µ" press the <Alt> key and type "0181".  
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Figure 19 - Collect/Plot Filter Task Plot Configuration.  

 
11.  Click OK to add the Task to the Test Definition. 
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Figure 20 - Final Tutorial III Test Definition.  
 

Step 3 – Create the DataSet.  
 

1.  Using any technique described in previous sections, initiate the creation of a new Da-
taSet. 

2.  The New DataSet dialog appears. Configure the DataSet as follows: 
 

DataSet Name: Tutorial #4b  
DataSet Path: "c:\datasets\tutorials\tutorial #4b"  
Experimenter Initials: Required for the DataSet  
Comments:  As appropriate. This entry is optional and not recommended.  

 

  
Figure 21 - Configure the DataSet.  

  
3.  Click OK to create and open the DataSet. 
4.  Using any of the previously-discussed techniques, move the Test Definition from the Edi-

tor to the Current Test Definition (CTD) in the DataSet. In the Vision main menu select 
"Editor-> Test Definition to Current DataSet" or in the Editor, right-click and select "Test 
Definition to Current DataSet" from the popup menu or Drag-and-Drop the Editor into 
the DataSet. 

5.  Name the CTD "Tutorial #4 - Vision Data File". 
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Figure 22 - Name the CTD.  

 

 
Figure 23 - Updated DataSet and Log Window.  

 
 
 

Step 4 – Run the Experiment and Review the Data.  
  

1.  Using any of the previously-discussed techniques, run the Experiment. In the Vision main 
menu select "DataSet->Execute Current Test Definition (CTD)" or select the CTD name 
in the DataSet, right-click and select "Execute Current Test Definition (CTD)" from the 
popup menu or simply press <F1>. 

2.  The Experiment will begin. No data will appear until the Filter Task has executed. How-
ever, the execution of the second two Hysteresis Tasks will be indicated in the status bar 
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at the lower left of the Vision display. The Stop Measurement button will appear. The 
green ACTIVE LED will also extinguish when voltage is applied to the sample. The 
LED may turn off and on several times during a measurement. When the experiment is 
finished, the Collect/Plot Filter will plot the data in a window, the DataSet Archive will 
be updated and the Log Window will reflect the activity within the DataSet. The Archive 
in Figure 23 has been opened to show the complete Executed Test Definition (ETD). 
Note that the data displayed in the figure show noise that is not representative of the re-
sponse of Precision testers. This is the result of the experimental hardware configuration 
of the prototype tester on which these data were acquired. 

 

  
Figure 24 - DataSet After Execution.  

  
3.  Reconfigure and/or re-execute the CTD as desired. Open the Archive, the ETD, the "Ex-

periment Data" folder and double-click on any Task to review the configuration and exe-
cution. 
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V - Sensor Measurements 
 

Sensor Measurements 
 

Precision Hardware and Vision software combine to allow one or two externally-generated volt-
ages, in the ±10.0 Volts range, to be captured by any Measurement Task, simultaneously with 
the capture of the sample response at the tester RETURN port. The external voltages are attached 
to the SENSOR 1 and SENSOR 2 ports at the rear of the tester. (The RT66B and RT66C testers 
offer only a single SENSOR port.) These may be generated by any external instrument that pro-
duces a voltage, in the ±10.0 Volts range, that is linearly related to the property the instrument is 
measuring. Vision allows a programmable linear mX + b scale and offset transform to be applied 
to the voltage to convert it back to the original meaningful property being captured. Vision also 
allows the user to label the data to assign them meaning. This is a strictly generic tool that can be 
used to capture any property such as light intensity, temperature, pressure, etc. This capability is 
used specifically by the Piezo Task to capture physical sample displacement simultaneously with 
sample polarization as the drive profile is applied. 
 
This tutorial is intended primarily to teach the configuration and use of the Sensor tool. It does 
not measure useful data generated by an external instrument. Instead, it passes the Precision 
Tester's own DRIVE voltage, applied to the sample, back into the SENSOR port where it is cap-
tured simultaneously with a Hysteresis Measurement. The Sensed DRIVE voltage is then plotted, 
along with the polarization, as a function of the drive voltage. This is a redundant example since 
the Hysteresis Task allows the voltage to be plotted, along with polarization, parametrically as a 
function of time. Note that using the default linear transform parameters, with a scale factor of 
1.0 and an offset of 0.0, this example will produce an exact 1-to-1 correspondence between the 
DRIVE and SENSOR voltages. To demonstrate the linear transform, arbitrary values of scale = -
10.0 and offset = 50.0 are used. This produces a negative sloped response that does not pass 
through the origin. Note that the configuration of the sensor input also allows a correction to 
match the external instrument's output impedance. This parameter is left at the default value of 
50 Ω. 
 
Step 1 – Configure the Hardware  
 

Using a BNC cable, connect the DRIVE at the rear of the tester to the SENSOR port. If you 
intend to attach your own linear or ferroelectric sample, instead connect a BNC T-connector 
to the DRIVE port at the front of the tester. Connect one terminal of the T to the SENSOR 
port at the rear of the tester using a BNC cable. Connect the other terminal to your sample to 
provide the stimulus voltage. Note that Figure 1 is a generic diagram that does not represent 
the configuration or port arrangement of any particular Precision test system. For the data 
presented in this tutorial, a ferroelectric sample is used. 
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Figure 1 - Tester Configurations for the Tutorial. Top Image is for 
Use with the Internal Reference Capacitor. Bottom Image is for an 

Externally-Attached Sample.  
 

Step 2 – Configure the Measurement  
  

1.  From the main Vision menu, select " QuikLook->Hysteresis Tasks->Hysteresis".  
 

  
Figure 2 - Select the QuikLook Hysteresis Task.  
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2.  Configure the Task as follows: 
 

Task Name:  "5.0-Volt/10.0 ms Hysteresis w/Sensor 
Max Voltage:  5.0 
Enable Ref. 
Cap.:  

Checked - Or use your own ferroelectric or linear sample attached to the tester DRIVE 
and RETURN ports. 

Area:  Default if Ref. Cap., or as appropriate 
Thickness  Default if Ref. Cap., or as appropriate 

 

  
Figure 3 - Configure the QuikLook Hysteresis Task.  

 
3.  Click on Set Sample Info and add the information as follows. Note that if you are fol-

lowing on from the previous tutorial or have re-accessed that tutorial's DataSet, these 
values will be preconfigured since they are persistent from the previous Task access.  

 
Sample Name:  "Internal Reference Cap.", or as appropriate 
Lot ID  "N/A" 
Wafer ID  "N/A" 

 
4.  Then click OK to return to the main dialog.  
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Figure 4 - Provide Sample Information.  

 
5.  Click on Set Sensor and configure as follows.  

 
Sensor Enabled:  Checked 
Sensor Scale:  -10 
Sensor Offset:  50 
Sensor Impedance:  50 (default) 
Sensor Label:  "Scaled DRIVE" 

 

  
Figure 5 - Configure the Sensor Measurement.  

 
6.  Then click OK to return to the main dialog. Note that the Sensor Enabled control now 
appears checked as in Figure 3 .  
 
7.  Click the "QuikLook Plot Setup" tab and configure the data labeling as appropriate.  
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Figure 6 - Configure Plotted Data Labeling.  

 
Step 3 – Execute the Measurement and Review the data  

  
1.  On the configuration dialog click OK . The measurement will begin as indicated by text 

written to the status bar in the lower left corner of the Vision display window. The test-
er's front panel green ACTIVE LED will extinguish while the measurement is being 
made. The LED may turn on and off several times during the measurement as the RE-
TURN signal amplification level is adjusted and the measurement is repeated. Once the 
measurement is finished, the data will be display on the QuikLook Results dialog as in 
Figure 7. Note that both the polarization and sensor data are plotted as a function of the 
same independent variable - Drive Voltage. However, the data are shown in separate 
plots. There are are two reasons to separate the plots: the sensor data units are almost 
certainly not the same as the measured sample data and should not be mixed; the units 
of the measured data, after filtering and applying the linear transform to the sensor data, 
may differ greatly so that the two data vectors will not plot well together. Note that the 
plotted Sensor Data, labeled "Scaled DRIVE", are an accurate representation of the lin-
ear conversion:  

 
Scaled Drive = -10.0 x Drive Voltage + 50.0  
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Figure 7 - 5.0-Volt/10.0 ms 1.0 nF Linear Reference Capacitor 

Hysteresis + Scaled and Offset SENSOR.  
  
2.  All standard operations previously described can be performed on these data. Tools that 

affect the display are accessible by right-clicking with the cursor in the plot surface. 
Data may be exported to a text file, a printer, Excel, Word or a Vision Data File. Data 
may be written into an existing (open) DataSet or a new DataSet may be created and 
receive these data.  
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VI - Parasitic Operations 
 

A - Parasitic Operations - Part 1 
 

The contribution of the Precision tester electronics to the measured signal, known as "Parasitics", 
is normally very small with respect to the measured signal returned from the sample and can 
generally be ignored. However, in the measurement of very small samples - 1.0 µm2 or smaller - 
the parasitics can be a significant percentage of the entire signal and should be removed from the 
signal. Tutorial III-D gave a practical Test Definition that can be used to remove system parasit-
ics as well as averaging away any measurement noise that can also be appreciable in a small 
sample measurement. 
 
This tutorial presents two new Tasks that work as a pair to provide an additional tool for adjust-
ing for system parasitics. These are the Parasitics Task and the Parasitics Filter (also known as 
the Compensation Filter). The Parasitics Task consolidates the parasitics measurement portion of 
the Test Definition described in Tutorial III-D into a single Task. The primary advantage of the 
Parasitics Task is that it need be executed only once for a particular configuration. Once it has 
executed its measured values are written to a formatted data file that can be used and reused from 
that point on. There is never a need to remeasure the parasitic tester contribution for a given 
measurement configuration. 
 
The Parasitics Filter Task takes as its input a Measurement Task of the specified type (Hystere-
sis, PUND, General Pulse, Simple Pulse or Piezo) and the file name of the previously-measured 
parasitics data. It compares the data in the file to the input measurement for type and number of 
points. These must match or the Filter will provide a warning and terminate. It also compares 
Task configuration parameters such as Voltage, Pulse Width, Hysteresis Speed, etc.. If these do 
not agree, the user is warned, but the Filter runs on the input data once the warning is acknowl-
edged. The Filter produces a vector that is simply the input measured data minus the parasitics 
file data. 
 
The Parasitics Task must be executed in a DataSet. It is not available from the QuikLook Menu. 
If programmed into a Branch Loop, parameters may be adjusted as the loop iterates and a series 
of parasitic record files created. Since the parasitic input files must exist to be associated with the 
Parasitics Filter Task at configuration time, the Parasitics Task and the Parasitics Filter Task will 
not be used in the same Test Definition. It is recommended that a Test Definition be created that 
will produce, in a single execution, all of the parasitics files that are likely to be needed to correct 
future measurements. Detailed file names should be given to clearly identify the nature of the 
parasitic measurement. If the Parasitics Task is running in a Branch Loop and the Serialize File 
Name in a Branch Loop control is checked, a new file will be created at each iteration. The file 
will have a common base file name and a ".#" will be appended where, '#' is an integer indicating 
the current iteration. 
 
 
 
Step 1 - Create the Test Definition.  
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1.  In the Vision Library, open the Parasitics folder. Drag-and-Drop the Parasitics Task into 

the Editor window.  
 
2.  Configure the Task as follows: 

 
Task Name:  "7.0-Volt/Multi-Speed Hysteresis Parasitics"  
Number of Averaging Measurements:  30 - NOTE: Since the measurement is being made with no sample in 

the signal path, the return signal is very small and has a low Signal-
to-Noise ratio. The measurement is repeated for the number of times 
specified in this control and averaged over those times to reduce, by 
averaging out, the random noise.  

Disable Probe Messages:  Checked  
Measurement:  Hysteresis  
Sample Area:  As appropriate  
Sample Thickness:  As appropriate  
Serialize File Name in a Branch Loop:  Checked  
Comments:  As appropriate  

 

  
Figure 1 - Configure the Main Parasitic Task.  

 
3.  Click Browse to File and assign an appropriate and descriptive file path and file name.  
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Figure 2 - Output File Browser.  

 
4.  Click Configure Hysteresis and configure the dialog as follows:  

 
Max. Volts:  7.0  
Preset Loop:  Checked  
Hysteresis Period:  0.1  
Preset Loop Delay:  1000  
Drive Profile Type:  "Standard Bipolar"  
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Figure 3 - Hysteresis Measurement Configuration.  

  
5.  Click Set Adjust Params and configure the dialog as follows:  

 
Adjust Hysteresis Period in a Loop:  Checked  
Adjust by Scaling:  Checked  
Period Scale Factor:  10  

 

  
Figure 4 - Hysteresis Parameter Loop Adjustment Configura-
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tion.  
 

6.  Click OK to add the Task to the Test Definition in the Editor.  
 

7.  Move a Branch Task from the Program Control folder in the Library into the Editor and 
configure the dialog as follows:  

 
Task Name:  "Hysteresis Parasitics Speed Loop"  
Parameter to Compare:  "Para Hyst: Current Period"  
Comparison:  <  
Real:  1000  
Branch Point Task:  "7.0-V Multi-Spd Hyst Parasitic"  
Select Branch Target:  Click here after Branch Point Task is selected.  
Comments:  As appropriate.  

 

  
Figure 5 - Branch Task Configuration.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 376 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
Step 2 - Create the DataSet.  

 
1.  Using any of the methods to initiate a new DataSet, open the DataSet creation dialog.  

 
2.  Configure the DataSet as follows: 

 
DataSet Name:  "Tutorial #6b - Parasitics"  
DataSet Path:  "c:\datasets\tutorials\tutorial #6b - parasitics.dst"  
Experimenter Initials:  Required  
Comments:  Optional - As appropriate - not recommended 

 

  
Figure 6 - Configure the DataSet.  

 
3.  Using any method, move the Test Definition from the Editor into the DataSet.  

 
4.  Name the CTD "1. Measure 7.0-Volt Multi-speed Hysteresis Parasitics".  
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Figure 7 - Name the Current Test Definition. 

  
Step 3 - Run the Current Test Definition.  

 
1.  Ensure that no connections are made to the tester DRIVE or RETURN ports at the tester 

front or rear panels.  
 

2.  Using any method, execute the CTD.  
 

3.  The execution progress will be indicated by updates to the Vision Status Bar and to the 
Log window.  
 

4.  Configured as above, the execution will take a significant amount of time. That will be 
from 20 minutes or so for a Precision Workstation and Premier, to up to an hour for a 
Precision LC. To speed the execution, reduce the number of averages ( Figure 1 ) from 
30.  

 
Step 4 - Review the data.  

  
1.  Go to the directory assigned for the output files and verify that five files, named "7.0-Volt 

Multi-Speed Hysteresis - 0.1 ms to 10.0 5. x .pcf" (where x is a serial value from '1' to '5') 
are present.  
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Figure 8 - Output Files.  
  

2.  Open the DataSet Archive, the Executed Test Definition (ETD) folder and the "Experi-
ment Data" folder.  

 

  
Figure 9 - DataSet with Updated Archive.  

 
3.  Double-click on any of the Parasitics Tasks. The main configuration dialog will appear. 

Most controls are disabled and presented for review. The Hysteresis sub-dialog and its 
parameter adjustment subdialog may be opened for more detailed review.  
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Figure 10 - Configuration Dialog Recalled from the DataSet.  
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Figure 11 - Hysteresis Configuration Sub-Dialog.  
 

 
Figure 12 - Parameter Adjust Sub-Dialog.  

 
4.  Exit the configuration dialog. A plot configuration dialog will appear. Configure the plot 

labels as appropriate.  
 

  
Figure 13 - Plot Configuration Dialog.  

  
5.  Click OK . The plot configuration dialog will close and the recalled parasitic data will be 

displayed in a Hysteresis-specific plotting dialog. Figures 15 through 19 show the plotted 
data for all measurements from 0.1 ms to 1000 ms (1 second). Note that the 100 ms plot 
of Figure 18 is shows strong 60 Hz noise, apparent as a periodic ripple in the data. The 
60 Hz contribution is also apparent in the magnitude and shape of the response in the 
faster measurements, especially Figures 16 and 17. In Figure 19, that noise has become 
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more rapid as there are ten times as many cycles (60 Vs 6) in the slower measurement. 
Such noise is common when measuring very small capacitors or whenever the signal is 
very small. The noise can be introduced by fluorescent lamps, rotating machinery and/or 
power cables running near or over the DRIVE or RETURN cables with a sample at-
tached. The noise is minimized by proper grounding of all system and experiment com-
ponents (metal tables, optical benches, probe station, etc.). In extreme cases, the noise 
must be eliminated by placing the experiment within a shielded box. It is the magnitude 
of the 60 Hz noise that makes the Parasitics data appear large in polarization.  

 
Note that the number of points increases with increased Hysteresis period until 8001 
points is reached. Point count is computed automatically by the Hysteresis (or Parasitics) 
Task to be maximized for the Task configuration. The number of points depends on the 
Hysteresis period and the maximum voltage. Since the Parastics Filter will subtract the 
parasitics point-by-point from a measured Hysteresis loop (as shown in the next part of 
Tutorial #6), the number of points stored into the Parasitics file must match the number of 
point in the associated Hysteresis Task when both the Task and the file are associated 
with the Parasitics filter. If the point counts do not agree, the Filter will provide a warning 
and will terminate the Test Definition with no action. Since the introduction of a user-
selected maximum point count of up to 32,000 points, the Parasitics Task output now 
must match the compensated measurement in voltage, period and point count. For this 
reason, identically-prepared Parasitics Tasks may need to be run repeatedly over a series 
of selected point counts. Figure 14 shows the point count selection in the Options dialog. 
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Figure 14 - Select the Maximum Hysteresis Point Count.  
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Figure 15 - 0.1 ms Data Recalled from the DataSet Archive. (Y-

Axis Scale has been Adjusted to Put Data in Perspective.)  
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Figure 16 - 1.0 ms Data Recalled from the DataSet Archive. (Y-

Axis Scale has not been Adjusted.)  
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Figure 17 - 10.0 ms Data Recalled from the DataSet Archive.  
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Figure 18 - 100.0 ms Data Recalled from the DataSet Archive.  
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Figure 19 - 1000.0 ms Data Recalled from the DataSet Archive.  
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B - Parasitic Operations - Part 2 
 

In part one of this tutorial, the contribution of system internal electronics to polarization meas-
urements, known as "Parasitics", were measured for the Hysteresis Task at 7.0 Volts at Hystere-
sis speeds ranging from 0.1 ms to 1000.0 ms in decades. The measurements were made using the 
Parasitics Task, which saved the measured values permanently to files. The files had a common 
base name and were differentiated by appending a serialized number to each file. This was done 
automatically in a Branch Loop. 
 
This portion of the tutorial will make use of the archived parasitics files to compensate standard 
Hysteresis Task measurements made on a sample. The Hysteresis measurements will be config-
ured identically to the measurements that created the files. This is the only correct method of us-
ing the parasitics files. The files must agree with the measurement in number of points and, while 
other measurement parameters may differ, warnings would be presented since the Hysteresis 
measurement would be compensated by parasitics measured under different circumstances. The 
Hysteresis Task is configured to adjust its period from 0.1 ms in decades in a Branch Loop. (The 
Branch Loop is configured to terminate when the Hysteresis speed reaches 1000.0 ms.) The 
compensation is performed by the Compensation Filter Task. This Filter Task is paired with the 
Parasitics Task and depends on the file output of that Task. The Filter is associated with the Hys-
teresis Task as data input source and is also associated with an input file. In this case, the Filter is 
configured to serialize the input file name in a Branch Loop and is actually associated with the 
file base name. On execution, the Hysteresis measurement is made, then the Compensation Filter 
Task subtracts the parasitics file data from the Hysteresis input data vector, effectively removing 
the contribution of system parasitics from the measurement. 
 
Note that this technique is normally applied to very small samples whose polarization response is 
small so that the parasitic contribution of the tester is significant. In the sample used in the fig-
ures below, the polarization response is large relative to the measured parasitics and the compen-
sation is not significant. The primary purpose of this example is to demonstrate procedures and 
discuss the theory and intentions of the Parasitics Task/Compensation Filter pair. 
 
Step 1 - Create the Test Definition.  

  
1.  In the Vision Library, open the Hardware->Measurement->Hysteresis folder. Drag-and-

Drop the Hysteresis Task into the Editor window.  
 

2.  Configure the Task as follows: 
 

Task Name:  "7.0-V/Multi-Speed Hysteresis"  
Max Voltage:  7.0  
Hysteresis Period:  0.1  
Sample Area:  As appropriate  
Sample Thickness:  As appropriate  
Comments:  As appropriate  
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Figure 1 - Configure the Hysteresis Task.  

 
3.  Click Adjust Params. Configure the sub-dialog as follows.  

 
Adjust Hysteresis Period in a Loop:  Checked  
Adjust by Scaling:  Checked  
Period Scale Factor:  10.0  
Adjust Hysteresis Volts in a Loop: Unchecked 
Adjust By User Variable: "<<None>>" 
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Figure 2 - Configure the Hysteresis Parameter Branch Loop Ad-

justment.  
 

4.  Click OK in the subdialog and OK in the main dialog to add the Task to the Editor.  
 

5.  From the Library "Parasitics" folder move the Compensation Filter Task in to the Editor.  
 

6.  Configure the Task as follows:  
 

Task Name:  "7.0-Volt/Multi-Speed Hysteresis Parasitics Compensa-
tion"  

Data Type:  "Hysteresis"  
Task Selector:  "7.0-Volt/Multi-Speed Hysteresis"  
Add Task:  Click this button after the Task Selector entry has been 

highlighted.  
Compensate for Constant Capacitance1:  Unchecked  
Compensate for Constant Resistance1: Unchecked  
Compensate for File-Stored Capacitance:  Checked  
X-Axis Option:  "Average Measured and Parasitic"2 

Serialized Input File in a Branch Loop:  Checked  
Comments:  As appropriate  
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1 The Compensation Filter Task allows the input data vector to be compensated for the contribution of a 

known constant sample resistance and/or linear capacitance to the measured sample polarization response. 
In this case the polarization contribution of each selected parameter is computed at each voltage step (for a 
Hysteresis compensation) from the given constant and subtracted from the input response. This feature is 
not under display in this tutorial and these controls are unchecked.  
 

2 Here, as indicated in the unlabeled text display to the right of the control, at each Hysteresis step, the inde-
pendent voltage value is derived from the average of the file-stored parasitic voltage and the Hysteresis in-
put voltage at that step. You may opt to use either the Hysteresis input voltage only or the file-recorded 
voltage as the independent value over which the sample polarization response is plotted.  

 

  
Figure 3 - Parasitics Compensation Filter Configuration.  

 
7. Click Browse to File . Navigate to the stored Parasitics files and select the first file. 

Since the Filter Task will be serializing the input file in the Branch Loop, it will be 
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providing its own ". x " value, where x is the serial value (in this case, '1', '2', '3', '4' and 
'5'). For that reason the Filter requires the base file name only. In the File name: con-
trol, erase the ".1" at the end of the serialized file name. If the Filter were not config-
ured to serialize you would leave the serial value in the file name to specify the exact 
input file. Click O pen . The dialog will close and the Parasitics File Path and Name 
control will be updated with the input base file name as in Figure 3 .  

 

  
Figure 4 - Hysteresis Parameter Loop Adjustment Configura-

tion.  
 
8. Click the "Compensation Filter Plot Setup" tab. Configure as follows:  
 

Plot These Data:  Checked  
Append Data:  Unchecked  
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Plot Labels:  As appropriate.  
 

 
Figure 5 - Configure Filter Runtime Plotting.  

  
9. Click OK to add the Compensation Filter Task to the Test Definition in the Editor. 
  
10. From the Library "Program Control" folder move the Branch Task into the Editor.  
 
11. Configure the Task as follows:  
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Task Name:  "7.0-Volt Hysteresis Parasitics Compensation Filter Loop"  
Parameter to Compare:  "Hysteresis: Current Period"  
Comparison:  "<"  
Real:  1000.0  
Branch Point Task:  "7.0-Volt/Multi-Speed Hysteresis"  
Select Branch Target:  Click this button after the Branch Point Task has been selected.  
Comments:  As appropriate  

 

  
Figure 6 - Branch Task Configuration.  

 
12. Click OK to close the dialog and add the Branch Task to the Test Definition.  
 

Step 2 - Update the DataSet.  
  

1.  If the Tutorial #6b DataSet is not open, open it.  
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2.  Using any method, move the Test Definition from the Editor into the DataSet.  
 
3.  Name the CTD "2. Compensate Hysteresis from Parasitics File".  

 

  
Figure 7 - Name the Current Test Definition.  

 
Step 3 - Run the CTD.  

  
4.  Connect a sample between the tester DRIVE and RETURN Port. Or, if using an internal 

sample, be sure that it is selected in Step 1:2. In the examples below the 4/20/80 PNZT 
internal reference ferroelectric capacitor is enabled. 
 

5.  Using any method, execute the experiment in the DataSet.  
 

6.  The experiment will sequence by iterating five times over the Hysteresis Task and Com-
pensation Filter Task. Hysteresis Execution will be indicated by the "ACTIVE" lamp ex-
tinguishing, perhaps repeatedly, on the tester front panel and by an indication on the main 
Vision window Status Bar. A Stop Measurement button will also appear. The Compensa-
tion Filter will generate a plot window each time it executes. The data on the window 
represent the measured Hysteresis Data, with the data from the appropriate serialized par-
asitics input file subtracted. In the figures the compensation is not significant.  Note that 
the figures show, in sequence, 201-point data, 2001-point data, 6665-point data and 8001-
point data. Figure 12 is also at 8001 points. 
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Figure 8 - 0.1 ms Compensated Hysteresis Data.  

 

 
Figure 9 - 1.0 ms Compensated Hysteresis Data.  
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Figure 10 - 10.0 ms Compensated Hysteresis Data.  

 

 
Figure 11 - 100.0 ms Compensated Hysteresis Data.  
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Figure 12 - 1000.0 ms Compensated Hysteresis Data.  

 
7.  Reexecute the CTD and recall Hysteresis and Compensation Filter data from the DataSet 

Archive as desired.  
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VII - High-Voltage Operations 
 

A - High-Voltage Operations - Hardware 
 

This tutorial differs from the previous lessons in that it does not present any step-by-step actions 
to be performed. Instead, it gives an extensive discussion of the process by which high-voltage 
measurements are configured and made. Since each user's circumstance differ, you should re-
view this discussion, then attempt high-voltage measurements of your own configuration if you 
have the appropriate equipment. 
 
Note that this document extends over many generations of Precision Tester, High-Voltage Inter-
face (HVI) and High-Voltage Amplifier as described in the History section, below. Many of the 
figures and tables, as well as the discussion, may refer to older instruments. The information that 
is presented will continue to apply to modern instruments unless otherwise specified. 
 
The Precision family of ferroelectric test systems, along with the Vision software, are capable of 
generating sample stimulus signals of up to ±500.0 Volts, depending on tester model, using in-
ternal amplifiers and without the need to add additional equipment. By adding a Precision High-
Voltage Interface (HVI) and a High-Voltage Amplifier (HVA), measurements of up to ±10,000 
Volts can be made. A basic description of the accessories required to make a high-voltage meas-
urement includes: 
 

1.  High-Voltage Interface (HVI) - An interface between the High-Voltage Amplifier and 
the Precision tester. The HVI provides security for equipment and human operators by 
guarding against high voltage being applied to the (normally zero-volt) RETURN port as 
a result of sample breakdown. Such an event causes the high voltage DRIVE signal to be 
interrupted and the RETURN signal to be protectively buffered. The HVI also provides a 
logical signal to the Vision software through the Precision tester to indicate its presence 
and contribute to the enabling of the high-voltage measurement.  

 
2.  High-Voltage Amplifier (HVA) - The HVA takes a low voltage input signal and scales 

it upwards by a constant gain factor to generate the high-voltage output. That signal is re-
turned to the HVI through which it is switched to the sample. The HVA also provides a 
low-voltage monitor signal that represents a scaled copy of the actual high-voltage signal 
that is being applied. Any HVA within the ±10,000.0-Volt limit may be used. Trek am-
plifiers are the most common. Each HVA to be used with Vision and the Precision tester 
must be identified with an ID Module specific to the HVA.   

 
3.  ID Module - This is an Erasable, Programmable Read-Only Memory (EEPROM) that is 

connected to the HVI using a 25-pin data cable. This unit logically represents the ampli-
fier that is connected into the signal path. It provides detailed amplifier information such 
as type, maximum voltage, gain factor, ramp rate, maximum current, etc. to the Vision 
software. The ID module must be present to enable Vision to perform the high-voltage 
measurement. As of April 2017, HVIs have user-programmable EEPROMs that serve as 
the ID Module. No separate ID Module will be shipped. The EEPROM will be prepro-
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grammed, just as the earlier ID Module was, for the user's specified amplifier. However, 
if the user introduces a new amplifier, it may be immediately programmed into the HVI 
EEPROM on high-voltage configuration, provided it appears on the selectable list of 
available amplifiers. Otherwise, RTI can add it to a new list to be provided to the user. 

 
A.1 - History of High-Voltage Measurements  
 
A description of the evolution of the current High-Voltage hardware available and Vision high-
voltage configuration and measurement will help provide a clearer understanding of the steps 
presented in this tutorial. This historical description shows that a large number of configurations 
are possible, differing from customer-to-customer, so that a generic tutorial must be limited in its 
scope. Descriptions within the tutorial will extend its applicability to all configurations. See the 
help pages for any Hardware Task for more detail regarding high-voltage configuration and exe-
cution.  

 
1.  Initial Configurations Available: With the first Precision test systems and Vision pro-

gram releases, the following components applied:  
 

1.  Testers - Two tester models were available - the Precision Pro/Premier and the Preci-
sion Workstation. Both models had two DB-25 ports to which HVIs could be at-
tached. This allowed multiple amplifiers to be attached. These could be physically 
configured once, and then switched in software.  

 
2.  HVI - A single High-Voltage Interface model was available. This accommodated the 

attachment of High-Voltage Amplifiers of up to ±10,000 Volts. Each HVI had two 
switchable channels allowing up to two HVAs to be connected. The HVAs could be 
physically configured once, then switched in software. With two HVAs connected to 
each of two HVIs connected to a single Precision tester, up to four amplifiers could 
be attached and switched in software with no physical reconfiguration.  

 
3.  HVA - Radiant Technologies, Inc. offered four amplifier models - 500-Volt, 2,000-

Volt, 4,000-Volt and 10,000 Volt. These were Trek amplifier with RTI front panels 
and labeling. Only amplifiers provided by RTI could be used to make high-voltage 
measurements in Vision.  

 
4.  ID Modules - The ID module for a particular amplifier was integral with the amplifi-

er and this was not regarded as a separate component.  
 
5.  Vision Version 2.1.0 or Older - Vision allowed the user to either select the "Inter-

nal" amplifier or specifically indicate "500-Volt", "2,000-Volt", "4,000-Volt" or 
"10,000-Volt" amplifiers. If any amplifier other than "Internal" were selected, the 
HVI Comm Port and HVI Channel controls were enabled and set to default to "1" and 
"1". In this case, either control could take on a value of '1' or '2'. The HVI Comm Port 
control would select the Precision tester rear panel DB-25 port, allowing switching of 
HVIs. HVI Channel would select the amplifier channel on the HVI and switch be-
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tween HVAs. Four different configurations allowed switching between four different 
HVAs. Note that any configuration could be programmed into Vision regardless of 
the hardware configuration actually attached to the system. This allowed the test to be 
configured with the HVI/HVA units powered down. The presence of the HVI(s) and 
appropriate HVA(s) at the specified port(s) and channel(s) would be detected and ver-
ified at runtime.  

  
2. Vision Version 3.x: With the release of Vision Version 3.1.0 in Autumn 2002, a determi-

nation was made that there was a need to allow the customer to use any amplifier with the 
Precision HVI and tester. Using existing amplifiers could reduce the purchase cost or the 
customer may have the need for specific amplifier configurations not met by RTI's four 
models. Two steps were taken to meet these needs. First, in Vision, a fifth high-voltage 
amplifier option was added labeled "Custom". This single control was used to select 
ANY amplifier not provided by RTI, regardless of the amplifier capabilities. RTI-
provided amplifiers were still available and selectable. Second, to maintain existing 
hardware and software structures, the customer was required to provide a complete de-
scription of the amplifier to be used to Radiant. That description was written into a ID 
module, purchased by the customer along with the HVI. The ID module must be connect-
ed to the HVI to operate the custom amplifier in high-voltage mode. In the two years 
since the introduction of the custom amplifier, this has become the most popular ar-
rangement. Very few RTI amplifiers are now sold.  

 
3. Vision 4.1.x: The RTI amplifiers have been abandoned. All amplifiers are considered 

"custom". The user switches only between "Internal" and "High Voltage" selections. All 
amplifiers must be accompanied by an HVA-specific ID Module. The original RTI am-
plifiers incorporate their own ID Module and will continue to work with Vision. The HVI 
Comm Port and HVI Channel controls are maintained to allow software switching of 
HVAs. The "Internal"/"High Voltage" selection and HVI Comm Port and HVI Channel 
controls have been moved to subdialogs to reduce main dialog clutter.  

 
4, Precision LC Test System: The introduction of the Precision LC test system had an effect 

on high-voltage measurements in that only one DB-25 port is available, allowing only a 
single HVI to be connected. Two HVAs may be switched through the two-channel HVIs. 
No change has been made to Vision to reflect this limitation. The user may still program 
HVI Comm Port 2, but the software will cause the Task to fail at runtime. For the LC, 
HVI Comm Port must be set to 1 to operate properly.  

  
5. Precision SC Test System: The Precision Small Capacitor test system is intended specifi-

cally for measurements on very small capacitors at low voltages. No facility for high-
voltage measurements is included and no DB-25 port is available.  

 
6, 4,000-Volt HVI: A second, lower-cost HVI was made available. This HVI can accommo-

date HVAs only to 4,000 Volts. It also is limited to a single channel so that only one 
HVA may be connected. Vision does not detect the HVI at configuration time so that any 
voltage and HVI Channel may be specified. However, errors in configuration will be de-
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tected at run time and will cause Measurement Tasks to fail. For proper operation, HVI 
Channel must be set to '1'.  

 
7. Other NGS Testers: The Precision LC Test System introduced a return to the RT66A-

style tester in which the tester connected to the user's host computer running the tester 
software. The USB-style connection of the tester to the host came to represent a family of 
testers called the NGS testers. These include the LC and SC, already mentioned. Other 
testers are the Premier II, the Multiferroic, the Multiferroic II, the LC II and the RT66C. 
The RT66B is a low-cost model that does not fit into this discussion. It has its own 4 kV 
HVI. This family of testers provides High-Voltage access that varies from no access 
whatsoever to 1-HVI/2-HVA selection.  

  
8. I2C HVI: Recent High Voltage Interface models were designed to fit into a lower profile 

enclosure that will connect to the NGS tester at the I2C port. Both 1-channel 4 kV and 2-
channel 10 kV models were to be available.  

 
9. Precision 10 kV HVI-SC: With the release of this single-channel I2C 10 kV HVI all other 

HVI options were retired from manufacture. All versions of the Radiant HVI continued to 
be supported.  

 
10. Precision 10 kV HVI-SC: As of April 2017, the Precision 10 kV HVI-SC has moved the 

HVA-specific ID Module internal to the HVI and made it user-programmable. A separate 
ID module that represents the amplifier being controlled need no longer be provided to 
the customer. 

 
Tester  HVI  Tester 

Ports  
HVI Chan-

nels  
Total 

Channels  
Port Options  HVI Chan-

nel Options  
Precision Premier 10,000-Volt 2 2 4 '0', '1' or '2' '0', '1' or '2' 

 4,000-Volt 2 1 2 '0', '1' or '2' '0' or '1' 
Precision Workstation 10,000-Volt 2 2 4 '0', '1' or '2' '0', '1' or '2' 
 4,000-Volt 2 1 2 '0', '1' or '2' '0' or '1' 

Precision LC 10,000-Volt 1 2 2 '0' or '1' '0', '1' or '2' 
 4,000-Volt 1 1 1 '0' or '1' '0' or '1' 

Precision SC 10,000-Volt 0 No Connect 0 '0' '0' 
 4,000-Volt 0 No Connect 0 '0' '0' 
Precision Premier II 
Precision Multiferroic 
Precision LC II 
Precision RT66C 
Precision LC Retro 
Fitted with an I2C Port 

10,000-Volt 1 2 2 '0' or '1' '0', '1' or '2' 

 4,000-Volt 1 1 1 '0' or '1' '0' or '1' 
 I2C 10 kV 

SC 
1 1 1 N/A '0' or '1' 

Table 1 - Number of Amplifier Channels Available by Hardware Se-
lection.  
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A.2 - High-Voltage Resolution  
 
Many users will try to use an existing HVA to fill the "gap" between the tester's internal voltage 
limit and the appropriate amplifier range. For example, a 4,000-Volt amplifier may be used to 
make a 150-Volt measurement. This does not pose the problems that it did with earlier families 
of Radiant testers including the RT66A and the RT6000 series. However, it is important for the 
user to understand how the high-voltage signal is generated to appreciate precision limits of such 
a measurement. To generate the high-voltage signal the amplifier accepts a low voltage input 
signal that is a scaled version of the intended high-voltage output. For example, to use a 10,000 
Volt amplifier, with a 1000x gain factor to produce a Hysteresis waveform with a VMax of 7300 
Volts, the Precision test system generates a waveform with a VMax of 7.3 Volts to apply as input. 
All of the voltages that make up that 7.3-Volt waveform are digitally generated using a digital-
to-analog converter (DAC). The DAC has a voltage resolution limit that is given by the DAC's 
voltage range divided by its bit resolution. The voltage resolution can be expressed by:  

 
 Voltage Range / (2bit resolution)  

 
The range and bit resolution vary from tester-to-tester as shown in Table 1 .  
 

Tester  Range  Bits  Voltage Resolution  
Premier  ±20.0 Volts (40.0 Volts)  12  0.00976 Volts  

Workstation  ±10.0 Volts (20.0 Volts)  14  0.00488 Volts  
LC  ±10.0 Volts (20.0 Volts)  14  0.00488 Volts  

Premier II 
Multiferroic 

LC II 

±10.0 Volts (20.0 Volts)  16 0.000305 Volts 

RT66C ±10.0 Volts (20.0 Volts)  12 0.00976 Volts  
Table 2 - Voltage Resolution by Tester Type  

 
As the input drive voltage ( VMax = 7.3 Volts) is scaled by 1000 to produce the actual drive volt-
age ( VMax = 7300 Volts), the voltage resolution is also scaled so that for the Precision Premier, 
the output voltage is a minimum of 9.76 Volts/step and the Workstation and LC provide a mini-
mum 4.88 Volts per step. This is not a severe limitation in a 7300-Volt measurement. In that 
case, the voltage resolution will not be the limiting factor in setting the number of sample points 
in the Hysteresis loop. However, if the same amplifier is applied to a 150-Volt Hysteresis meas-
urement, for the Premier, the rise from zero to VMax will be limited to 150/9.76 truncated = 15 
steps. The total Hysteresis measurement will have a maximum of only 61 points. For the Work-
station and LC, the resolution doubles, but the precision is still relatively poor. Although this 
resolution may be acceptable, it would be better to use a lower-voltage amplifier with a lower 
gain factor. For example, a 500-Volt amplifier with a 100x gain will improve the resolution by a 
factor of 10.  
 
A.3 - Configuration  
 

1.  Sample Hookup - Signals to and from the sample are provided by and to the High-
Voltage Interface at the front panel ( Figures 1 and 2) . One sample electrode is connect-
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ed directly to the HV DRIVE port and the other to the HV RETURN port. Connections 
are made using the high-voltage cables with molded plugs that are provided with the de-
livery of the HVI to the customer.  

 

  
Figure 1 - 4 kV HVI Front Panel.  
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Figure 2 - 10 kV HVI Front Panel.  

 
Sample connection is at the user's discretion. However, Radiant Technologies has availa-
ble a number of High-Voltage Test Fixtures (HVTF). The first of these, in Figure 3 , is 
completely self-contained and provides complete electrical isolation of the sample and all 
high-voltage connectors. Here, the sample is placed into the container with one electrode 
on top of an electrical contact. It may be immersed in oil to prevent arcing. When the top 
is placed on the HVTF a second contact meets the other sample electrode. The contacts 
feed through to high voltage connectors, external to the HVTF. These are connected to 
the HV DRIVE and HV RETURN ports of the HVI using the provided high-voltage ca-
bling. The enclosed HVTF is able to withstand temperatures of up to 200° C, so that the 
unit may be used in thermal modeling within a chamber.  
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Figure 3 - Enclosed Electrically-Isolated High Voltage Test Fixture.  

 
A second version of this HVTF, known as the High-Voltage Displacement Meter 
(HVDM), is available that offers a connection for an MTI-2100 or Philtec displacement 
meter detector wand. Both of these instruments measure displacement through doppler 
changes in sample-reflected light captured at the end of a emitter/detector fiber optic 
bundle. See the HVDM discussion in the Hardware Accessories pages of these help pag-
es.  
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Figure 4 - High-Voltage Displacement Meter (HVDM).  

 
The second type of high-voltage test fixture, constructed from MACORTM and nickel fix-
tures, is the High-Temperature Test Fixture (HTTF). The test fixture is designed to with-
stand temperatures of up to 600° C and small enough to fit into a 4" furnace tube 
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Figure 5 - Type-2 High Voltage Test Fixture.  
 

2.  High-Voltage Amplifier (HVA) Connections - The amplifier will be connected directly 
to the HVI. Connections may be either on the front or rear panel of the amplifier (depend-
ing on the amplifier), but all are made to the HVI rear panel. Figures 6 and 7 show front 
and rear panels and label the connections for a Trek 10 kV amplifier. Table 2 describes 
these connections.  

 
NOTE: The user should read through the amplifier documentation. However, the 
accessory hookup should proceed as described here, not as described in the docu-
mentation.  
 
NOTE: The sample is tested in High Voltage by connecting it to the front panel of 
the HVI as shown in Figures 1 and 2 . It is not tested in High Voltage by connecting 
it to the DRIVE and/or RETURN ports of the Precision tester. Low-Voltage testing 
is done with the sample connected to the tester's DRIVE and RETURN ports.  
 
NOTE: If the High Voltage Amplifier (HVA) is purchase through Radiant Technol-
ogies, Inc., the ID Module will be attached to the HVA rear panel. If the amplifier is 
purchase separately, the ID Module will be delivered as an independent accessory. A 
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sticky back is provided with the independent ID Module to allow it to be attached to 
the HVA by the customer.  

 
NOTE: Modern equipment has replaced the parallel cable in the figures with a tele-
phone-style I2C cable. 
 
NOTE: As of April 2017, the I2C ID Module has been eliminated by moving the 
EEPROM into the HVI chassis.  

 
 

  

Figure 6 - 10,000-Volt HVA Front Panel.  
 

  
Figure 7 - 10,000-Volt HVA Rear Panel and Connections.  
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Label Discussion 
Front Panel  

HV Red LED. Indicates that high voltage is enabled and may be present at the amplifier 
output. Do not enable high voltage until all connections are made as described in this 
document. Do not apply power to the amplifier until you have verified that the input 
line voltage matches the labeled voltage on the amplifier rear panel. 

HV Toggle switch. Sets high voltage output to "ON" (enabled – High voltage may be pre-
sent at the amplifier output) "OFF" (disabled – high voltage is not present at the ampli-
fier output) or "REMOTE". In the latter case, the further enabling of high voltage out-
put is controlled by an external instrument. Do not enable high voltage until all con-
nections are made as described in this document. Do not apply power to the amplifier 
until you have verified that the input line voltage matches the labeled voltage on the 
amplifier rear panel. 

POWER Green LED. Indicates that line power is available to the amplifier. Does not, by itself, 
indicate that high voltage may be present at the amplifier output. Do not apply power 
to the amplifier until all connections are made as described in this document. Do not 
apply power to the amplifier until you have verified that the input line voltage matches 
the labeled voltage on the amplifier rear panel. 

POWER Toggle switch. Sets amplifier line power to "ON" (enabled – line power is present in 
the amplifier) "OFF" (disabled – line power is not present within the amplifier) or 
"REMOTE". In the latter case, the supply of line power to the amplifier is controlled 
by an external instrument. Do not apply power to the amplifier until all connections 
are made as described in this document. Do not apply power to the amplifier until you 
have verified that the input line voltage matches the labeled voltage on the amplifier 
rear panel. 

Rear Panel   
Unlabeled DB-25 connector. Digital logic to and from the HVI, connected to the Amp 1 Comm. 

Or Amp 2 Comm. DB-25 connector on the HVI rear panel. This connection provides 
amplifier identifying information to the Precision LC tester so that the proper amplifier 
may be selected in the Vision software. This is the separately-provided ID Module for 
custom HVAs. 

HV  
OUT 

High Voltage connector attached to the HVI rear panel Amp 1 HIGH VOLTAGE or 
Amp 2 HIGH VOLTAGE connector. This is the high voltage output of the amplifier. 
It is linearly related to the low voltage stimulus by the amplifier gain factor. This sig-
nal is passed through the High Voltage Interface (HVI) to the sample. 

MONITOR BNC. A low-voltage representation of the actual high voltage signal being output by 
the amplifier. This signal is passed to the LC through the HVI so that the Vision soft-
ware can record the actual applied voltage instead of the intended voltage. This signal 
is connected to the Amp 1 Monitor or Amp 2 Monitor BNC on the HVI rear panel. 

Unlabeled 
(Earth Ground 

Symbol) 

Green banana connector. This connector is attached directly to the HVA chassis form-
ing a case ground. This connector must be attached to the ground connectors on the 
HVI and the Precision LC tester before power is applied to the amplifier. It is a good 
practice to connect apparatus in the experimental configuration, such as probe stations, 
optical tables and/or metal benches, to this ground point. 

120 VAC or 
220 VAC 

Standard AC power connection. Ensure that the line power matches the 120V or 220V 
label on the Amplifier rear panel. 

AMP  
INPUT 

Three-pin make TREK connector. A low-voltage amplifier stimulus that is scaled by 
the amplifier gain factor to create the high voltage amplifier output drive profile. This 
connector is attached to the Amp 1 Stimulus or Amp 2 Stimulus ports on the rear panel 
of the HVI. This signal is received by the amplifier from the LC through the HVI. 

EXT  
CONTROL 

Eight-pin female TREK connector. This connector allows an external instrument to be 
attached to the amplifier to control line power and high voltage enabling. See the am-
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plifier manual for more details. This connector is not used by Radiant Technologies, 
Inc. 

Unlabeled 
("To/From 
HVI") (ID 
Module) 

This is the amplifier ID Module. It defines the amplifier properties to the Vision pro-
gram. This connection originally received a parallel logic cable with 25-pin DIN con-
nector. The parallel connector has been replaced with an I2C (telephone-style) con-
nector for several years. As of April 2017, this device is no longer needed. Its func-
tionality has been moved inside the HVI chassis and has been made user-
programmable. 

Table 3 – 2,000-Volt and 10,000 Volt High Voltage Amplifi-
ers Front and Rear Panel Connections and Indicators. 

  
3.  ID Module Connection - ID modules are sold as separate devices that identify the ampli-

fier characteristics to the Vision program. Here, the module has a sticky back that allows 
it to be permanently affixed to the amplifier. The connection is made to the HVI as de-
scribed in Table 2 . The original ID modules connected through a parallel logic cable. In 
more recent years the ID module has had an I2C (telephone-style) connector. In High-
Voltage Interface (HVI) instruments sold from April 2017, the ID module is integral with 
the HVI and is user-programmable. 

 
4.  High-Voltage Interface (HVI) Connections - The High-Voltage Interface serves as the 

central high-voltage instrument, interfacing and distributing signals to and from the Pre-
cision Tester, the High-Voltage Amplifier (HVA), the ID Module and the sample. It 
passes a low voltage stimulus signal from the tester to the HVA, it returns a low voltage 
record of the actual high voltage signal from the HVA back to the tester. It passes the 
high voltage signal from the HVA out to the sample and passes the sample response to 
the tester. It provides the tester and Vision software with identifying data and passes oth-
er identifying data from the HVA to the tester and Vision. It provides a central grounding 
point for all instruments. In the 10 kV model, it allows switching of all these signals, 
through Vision software configuration, to either of two possible connected HVAs. The 4 
kV HVI limits the amplifier signal to 4,000 Volts and only allows a single amplifier to be 
connected, but does provide a lower cost alternative. The 10 kV SC model is the only 
model still sold. It offers a single channel to a single amplifier. (All models are still sup-
ported by Vision.) The primary purpose of the HVI is to provide high-voltage protection 
to equipment and humans. The instrument detects high voltage on the return path, where 
it cannot be tolerated and opens the Return path while disabling the output stimulus volt-
age to the amplifier and instructing Vision to stop measuring. Figure 1 shows the 4 kV 
model connected to a sample at the front panel. The front panel provides connections for 
high voltage out to the sample and the sample response signal. It also provides a power 
switch and indicator (green LED) and a red LED that illuminates when high voltage is 
present on the HV DRIVE port. The 10 kV HVI rear panel is shown in Figure 11, with 
connections indicated. The 4 kV HVI is identical except that it does not have duplicate 
connections for Amp 1 and Amp 2. Only a single amplifier is available. Table 3 presents 
detail on the connections.  
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Figure 8 - 10,000-Volt HVI Rear Panel and Connections.  

 
Label  Discussion  
Power  The Precision HVI power supply is self-switching between 120 V and 220 V. Damage to the HVI 

from an improperly switched power supply is no longer a concern. NOTE: If you have and HVI pur-
chased before 2007, it may have a manual selection window for the supply voltage. Be sure to check 
this selection before applying power to the unit.  

Amp 1 
HIGH 

VOLTAGE  

A high voltage connector carrying the high voltage drive signal from High Voltage Amplifier 1. It is 
connected directly to the high voltage output (HV OUT) on the front or rear panel of the amplifier. 
The signal is passed through the HVI to the HV DRIVE port on the front panel and from there to the 
sample. Selection between the Amp 1 and Amp2 drive signal is made in Vision software and 
switched through logic connections between the Precision tester and the HVI.  

Amp 1 
Comm.  

This was originally a DB-25 connector that transmits digital logic to and from the Amplifier 1 ID 
Module. It is connected to the ID Module shipped with the HVI. For several years this connection 
has used an I2C (telephone-style) connector. From April 2017 HVI models, no logical connection is 
made between the HVI and the ID Module. The functionality of the ID Module has been moved to 
within the HVI and is user-programmable. 

Amp 1 
Stimulus  

This BNC connector provides a low-voltage drive stimulus signal from teh tester to Amplifier 1. It is 
connected to the Stimulus port on the front or rear panel of the amplifier. This stimulus voltage is 
multiplied by the amplifier gain factor to produce the high voltage output signal that is passed back 
to the HVI from the Amp 1 HIGH VOLTAGE port. Amplifier 1 Stimulus is selected in the Vision 
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software and switched by digital logic signal from the Precision tester to the HVI.  
Amp 1 

Monitor  
This is a low voltage signal from High Voltage Amplifier 1 that indicates the actual voltage being 
output by the amplifier divided by the amplifier gain factor. This port is connected to the Monitor 
port on the rear of the amplifier. The reported voltage should be identical, or nearly identical, to the 
Amp 1 Stimulus voltage. This voltage allows Vision to more accurately represent the stimulus on the 
sample. The signal is passed to the Precision tester through the System HV MONITOR port. Ampli-
fier 1 Monitor is selected in the Vision software and switched by digital logic signal from the Preci-
sion tester to the HVI.  

Ground  These are four green banana connectors tied directly to the HVI case forming a case ground. The 
Precision tester, the HVI and the HVA must have their grounding connectors connected together. It 
is also a very good policy to connect experimental apparatus such as probe stations, optical benches, 
etc. to this common point.  

System 
Comm.  

This was originally a DB-25 connector that establishes digital logic communication between the HVI 
and the Precision tester. It was connected to the System Comm. DB-25 connector on the rear panel 
of the tester. In recent years the DB-25 connector has been replaced by an I2C (tele-
phone-style) connector on both the HVI and the tester. 

System 
DRIVE  

This BNC connector receives a low voltage stimulus waveform from the Precision tester. It is con-
nected tot he DRIVE BNC on the tester front or rear (normally rear) panel. The signal is routed to 
Amplifier 1 or Amplifier 2 through Amp 1 Stimulus or Amp 2 Stimulus ports. The target amplifier is 
selected in Vision software and switched by digital logic from the tester to the HVI.  

System RE-
TURN  

This BNC connector passes the sample response current from the HV RETURN port on the HVI 
front panel to the Precision tester. The port is connected to the RETURN BNC on the tester front or 
rear (normally rear) panel. The tester captures and integrates this signal and returns the data to the 
Vision software for display, storage and analysis.  

System HV 
MONITOR  

This BNC returns a low voltage signal from the amplifier to the Precision tester. It is connected to 
the H.V. MON BNC on the tester rear panel. The signal is linearly related to the high voltage signal 
present on the selected high voltage amplifier output by dividing that signal by the amplifier gain. 
This value should be nearly identical to the low voltage stimulus signal provided by the tester. How-
ever, it provides a more accurate representation of the actual signal being applied to the sample. This 
signal is passed through the HVI from either the Amp 1 Monitor or Amp 2 Monitor port. The port is 
selected in Vision software and switched by digital logic signal from the tester to the HVI.  

Amp 2 
HIGH 

VOLTAGE  
(Amp 2 

Connections 
are Not 

Available on 
the 4 kV 

HVI or The 
10 kV HVI 

SC.) 

A high voltage connector carrying the high voltage drive signal from Amplifier 2. It is connected 
directly to the high voltage output (HV OUT) on the front or rear panel of the high voltage amplifier 
#2. The signal is passed through the HVI to the HV DRIVE port on the front panel and from there to 
the sample. Selection between the Amp 1 and Amp2 drive signal is made in Vision software and 
switched through logic connections between the Precision tester and the HVI.  

Amp 2 
Comm.  

This was originally a DB-25 connector that transmits digital logic to and from the Amplifier 2 ID 
Module. It is connected to the ID Module shipped with the HVI. For several years this connection 
has used an I2C (telephone-style) connector. From April 2017 HVI models, no logical connection is 
made between the HVI and the ID Module. The functionality of the ID Module has been moved to 
within the HVI and is user-programmable.  

Amp 2 
Stimulus  

This BNC connector provides a low voltage drive stimulus signal from the tester to Amplifier 2. It is 
connected to the Stimulus port on the rear panel of the amplifier. This stimulus voltage is multiplied 
by the high voltage amplifier gain factor to produce the high voltage output signal that is passed back 
to the HVI at the Amp 2 HIGH VOLTAGE port. Amplifier 2 Stimulus is selected in the Vision 
software and switched by digital logic signal from the Precision tester to the HVI.  

Amp 2 This is a low voltage signal from Amplifier w to the HVI that indicates the actual voltage being out-
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Monitor  put by the amplifier divided by the amplifier gain factor. This port is connected to the Monitor port 
on the rear panel of the amplifier. The reported voltage should be identical, or nearly identical, to the 
Amp 2 Stimulus voltage. This voltage allows Vision to more accurately represent the stimulus on the 
sample. The signal is passed to the Precision tester through the System HV MONITOR port. Ampli-
fier 2 Monitor is selected in the Vision software and switched by digital logic signal from the Preci-
sion tester to the HVI.  

External HV 
Drive  

A high voltage signal can be passed from an external signal generator, through the HVI and directly 
to the sample connected to the HVI front panel HV DRIVE port. Making this connection is initiated 
in Vision software and switched through logic connections between the Precision tester and the HVI. 
Execute the HVI AUX Task to utilize this port. Only the 10 kV HVI has this capability.  

External HV 
Return  

The sample response to a drive signal can be passed through the HV RETURN port at the HVI front 
panel and out this port on the rear panel directly to an external instrument. In this case, the tester 
does not capture the signal. Making this connection is initiated in Vision software and switched 
through logic connections between the Precision tester and the HVI. Execute the HVI AUX Task to 
utilize this port. Only the 10 kV HVI has this capability.  

Safety Inter-
lock  

These two banana connectors must be jumpered together to allow the HVI to operate and to allow 
high voltages to be generated. A jumper is shipped in place with the HVI so that it is immediately 
ready to operate. If the two banana connectors are not shorted during a test, the HVI cannot connect 
high voltage to the HV DRIVE output on the front panel of the HVI. The Safety Interlock can be 
used by the researcher to prevent high voltage generation unless specific safety conditions are met.  

Table 4 – HVI Rear Panel Connections.  
 

Figure 9 shows a complete set of connections between a Precision LC tester, a 4 kV HVI, an 
ID Module and a Trek 609E-6 custom amplifier. Tables 4 and 5 Show the port connections 
and connector/cable types required to connect the HVI to a tester and an HVA.  
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Figure 9 - Full System Connections.  

 
TEST SYSTEM  HVI  CONNECTOR TYPE  

DRIVE  System DRIVE  BNC  
RETURN  System RETURN  BNC  
HV MON  System HV MON  BNC  

System Comm.  System Comm.  DB-25 on Older Models 
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I2C on Later Models 
POWER  POWER  POWER  

GROUND  GROUND  BANANA  

Table 5 – Tester-to-HVI Connections.  
 

HVI  HVA  CONNECTOR TYPE  
Amp 1 Stimulus  Stimulus  BNC  
Amp 1 Monitor  Monitor  BNC  

AMP1 Comm.  Unlabeled  
DB-25 on Older Models 

I2C on Later Models 
Absent from April 2017 

Amp 1 HIGH VOLTAGE  HV OUT  RED HV CABLE  
POWER  POWER  POWER  

GROUND  GROUND  BANANA  

Table 6 – HVI-to-HVA Connections.  
 

A.4 - A Note on High Voltage Cables  
The cables that carry high voltage from the High Voltage Amplifier to the High Voltage Inter-
face and between the HVI and the sample come in two forms. 
 

1) The cables with stiff wire with red insulation and plastic connectors on each end are lim-
ited to 4 kV testing. Lettering on the cable indicates that it is good to 25 kV or 30 kV DC, 
but Radiant de-rates the voltage limit to 4 kV maximum. The reason is that the corners of 
the triangle wave used to stimulate the sample during Hysteresis measurements carry 
high-frequency components that will RF couple out of the cable to grounded metal above 
the 4 kV amplitude. Only use the cable with the red insulation for tests at 4 kV and be-
low.  

 
2) For use above 4 kV, Radiant sheaths the 4 kV cable in natural rubber tubing that looks like 

water tubing. With the rubber tubing as extra insulation, the cable is safe to use up to 50 
kV DC, but Radiant de-rates its voltage limit to 10 kV to prevent RF coupling from the 
cable to ground metal.  

 
There are two types of connectors on the high voltage cable. One type of connector is standard 
on the HVI and HVAs. The other type connects to Radiant's High Voltage Test Fixture. It is a 
high temperature connector that can withstand up to 230 °C. Therefore, high voltage cables for 
use with the HVTF have different connectors at either end. The standard high voltage plug for 
the HVI will not work witk the HVTF.  
 
If you need to go above 230° C, contact Radiant. We offer a test fixture that will go up to almost 
1000° C in a tube furnace. This fixture uses alumina sheathed nickel wire for the cabling inside 
the furnace.  
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B - High-Voltage Operations - Measurement 
 

In order to make a measurement above 500 Volts (200-Volts, 100-Volts or 10-Volts in some 
Precision tester models), a High-Voltage Amplifier (HVA) must be connected to the Precision 
measurements system through an accessory High-Voltage Interface (HVI) as described in the 
preceding Tutorial page. A Measurement Task must then be configured to apply the high-voltage 
signal to the sample and recover the sample response. Any Measurement Task can be configured 
for high-voltage sample stimulus and the hardware need not be present or powered up to perform 
the configuration. Note that although this Tutorial refers to Measurement Tasks, the Hardware 
Tasks Waveform and DC Bias can also be configured to apply high-voltage stimulus to the sam-
ple. 
 
CAUTION: For safety reasons it is recommended that the High Voltage Amplifier (HVA) 
remain in the 'Off' or 'Standby' condition until the measurement is to be made.  
 
This Tutorial will make use of the Hysteresis Task to demonstrate high-voltage measurements. 
The principles are the same for any Measurement Task and you can substitute any Task of your 
choosing into the process described. For simplicity, the Hysteresis Task is called from the Qui-
kLook menu. If you prefer you can program the Task into a Test Definition and run it in a Da-
taSet.  
 
Step 1: Configure the Measurement Hardware  
 

1.  Ensure that an HVA is properly connected to the test system, through an HVI, as de-
scribed in Tutorial VII-A. Ensure that the Precision Tester port that the HVI is connected 
to and the HVI channel that the HVA is connected to are known. Leave the HVA turned 
off. Turn on the HVI. If Vision is already running, select "Tools->Hardware Refresh 
(Alt-W)" or press <Alt-W>. Allow Vision to go through the startup procedure, detecting 
and calibrating the tester. Any time the hardware status changes, Vision must be notified 
by doing a hardware refresh. This will not be the case, below, when the amplifier is 
turned on. By turning on the HVI and connecting it to the ID Module it appears, to Vi-
sion, as though the amplifier is connected and ready to go. 
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Figure 1 - After HVI On, Do a Hardware Refresh. 

 
2.  Attach a high-voltage linear capacitor, or your own sample, to HV DRIVE and HV RE-

TURN ports on the front panel of the HVI. 
 
Step 2: Configure the Task  
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3.  Open the QuikLook Hysteresis configuration dialog.  

 

  
Figure 2. High-Voltage Hysteresis Task QuikLook Configuration.  

 
4.  Click Set Amplifier to open the High-Voltage configuration subdialog.  

 
5.  Select External Amplifier and set HVI Comm Port and HVI Channel to reflect the actual 

HVI and HVA hardware configuration.   
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Figure 2. High-Voltage Configuration Subdialog.  

 
Note that the HVI Channel control setting must match the hardware configuration and the 
intention of the measurement. If Internal Amplifier is selected, the control is forced to '0' 
and disabled. If External High Voltage is selected the control is enabled and preset to a 
default value of '1' in each. The control must be set to '1' or '2', according to the hardware 
configuration. A '2' may be selected for older-model two-channel 10 kV HVIs if the HVA 
is connected to channel 2. Otherwise, and for most configurations, this value must be set 
to '1' for high-voltage measurements.  

 
When the Set Amplifier subdialog is closed a warning will appear to ensure that every 
component in the measurement is firmly connected to earth ground. "High Voltage" 
will appear in the Amplifier control window of the main Task configuration dialog as in 
Figure 3. 

 
6.  Set Max Voltage to the intended sample stimulus voltage. This value cannot be set above 

500.0 until Amplifier shows "High Voltage". Set the intended Hysteresis Period (ms). 
Note that all Internal Reference Elements are disabled. 
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Figure 3. High-Voltage Configuration.  

 
7.  Once the amplifier is selected and the proper port and channel assigned, click the "Qui-

kLook Plot Setup" tab and configure the plot labels and options appropriately. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 422 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 4. Hysteresis QuikLook High-Voltage Plot Configuration.  

 
8.  Double-check the tester/HVI/HVA connections. Connect the sample to the HV DRIVE 

and HV RETURN connectors on the HVI. Turn on the Amplifier. 
 

9.  Click OK to make the measurement. Vision goes through a series of error checks before 
voltage is applied. First it determines if the requested voltage is within the maximum 
voltage of the amplifier at the specified port and channel. This is information taken from 
the HVA's ID Module. However, the measurement may pass this test, even if there is no 
HVA or HVI attached or powered up at the specified port and/or channel if the requested 
voltage is less than the 500-Volt default value specified by Vision. If this test fails, the 
measurement returns a failure flag to Vision and execution halts. If the Task is running in 
a Test Definition, no further Tasks will execute. 

 
If the first test passes, the software then checks for the presence of an HVI. If the HVI is 
not found, a warning is presented after which the Task returns an error flag to Vision and 
execution halts. 
 
If the second test passes, the software looks for an amplifier on the specified HVI channel 
whose voltage limit exceeds Max. Voltage. If the appropriate HVA is not found, the Task 
returns an error flag to Vision and execution halts. Otherwise, the measurement is made. 
Figure 5 shows the various warnings that may appear in the sequence the checks are per-
formed. 
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Figure 5. Warnings Indicating Failed High-Voltage Checks.  

 
Once the QuikLook measurement has been made, the results dialog will appear as normal 
(Figure 6). 
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Figure 6. 2000-Volt, 100 ms Data on a Paralectric Capacitor.  
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VIII - Nesting Branch Loop 
 

A  - General Example 
 

Note that these tutorials refer to common Vision terminology without definition. Terms and con-
cepts used were defined and practiced in earlier tutorials. Please proceed to this tutorial only after 
performing earlier Vision training. 
 
These two tutorials present an introduction to the Nested (or Nesting) Branch Loop Task. The 
Task allows an outer Branch Loop to include one or more inner Branch Loops in its included 
Task sequence. The Nested Branch Task does this by simply allowing standard Branch Tasks to 
be included on its list of Target Tasks and terminates the Target Task either at the beginning of 
the Test Definition or when another Nested Branch Loop Task is encountered. Hardware and Fil-
ter Tasks may adjust their behavior if they are in a Nested Branch Loop as presented in detail in 
these tutorials. To this end they have had a control named Respond to Nesting Branch Reset add-
ed to them. This first tutorial presents an example that is general, but of less practical value. 
However, it can be configured and executed by any user. It also makes use of two existing Tasks 
- Create User Variable and Update User Variable - that may be little understood and under-used. 
The second tutorial presents a more practical Test Definition, but one that operates an external 
thermal controller through the GPIB Set Temperature Task. Users who do not operate an exter-
nal thermal controller may construct, but not exercise the Test Definition.  
 
Step 1 – Add a User Variable - Make Task.  

  
1.  Clear the Editor of any Tasks in it. 
 
2.  In the Library open the "Program Control->User Variable" Folder and Subfolder. 
 
3.  Drag-and-Drop a User Variable - Make Task into the Editor . 
 
4.  Configure the Task as follows: 

 
Task Name:  "Create a Custom Loop Counter"  
Custom Variable Name:  "My Loop Counter"  
Variable Type:  Integer  
Initial Value: Integer  "0"  
Comments:  As Appropriate.  

 
5.  Click OK to add the Custom User Variable Task as the first Task in the Test Definition in 

the Editor 
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Figure 1 - Configuring the User Variable - Make Task.  

 
Discussion:  
This Task creates a Custom User Variable of the type and name specified and adds it to 
the general User Variable list with the initial value specified. The purpose, here, is to 
demonstrate the use of this Task. In the larger context of the tutorial, this is not strictly 
necessary since the Nested Branch Task adds its own "Loop Counter - Nesting" User 
Variable.  

 
•  Custom Variable Name: This is the text value that will be used to represent the Cus-

tom User Variable in the User Variable list.  
•  Variable Type: Specifies the format of the Custom User Variable - Integer, Real, Text 

or Boolean. Depending on the type selected, the appropriate Initial Value control will 
be enabled.  

•  Initial Value - Integer, Real, Text: The value the Custom User Variable is to take on 
when added to the User Variable list. The appropriate control will be enabled based 
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on the selection in Custom Variable Name .  
 

Step 2 – Add a User Variable - Update Task.  
  

1.  From the "Program Control->User Variable" Folder and Subfolder, Drag-and-Drop a Us-
er Variable - Update Task into the Editor. 

 
2.  Configure the Task as follows: 

 
Task Name:  "Update Custom Loop Counter"  
User Variable Type:  Integer  
Comments:  As Appropriate.  

 

  
Figure 2 - Configure the Update User Variable Task General Dialog.  

  
3.  Click Configure Update to open the Integer Update subdialog. 

 
4.  Configure as follows: 

 
User Variable to Update:  "My Loop Counter"  
Constant Operations->Increment by a Constant:  Selected  
Increment/Decrment/Scale Constant:  "1"  
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Figure 3 - Configure the Update User Variable Task Integer Dialog.  

 
Discussion:  
 
The first dialog of Figure 2 is simply used to select the type of the User Variable that is 
to be updated. Depending on the type selected in User Variable Type , the Configure Up-
date button will open the appropriate type-specific subdialog. The Integer configuration 
dialog appears in Figure 3.  

 
•  User Variable to Update: This contains a list of all integer User Variables currently 

registered with Vision. A single entry from this list must be selected. The value in this 
entry will be updated by the Task.  

•  Constant Operations::Increment by a Constant: This specifies the operation to be 
performed by the User Variable Update Task. This is one of many possible selections. 
Making any selection in the Constant Operations list enables the Set to a Con-
stant//Increment/Decrement/Scale by a Constant/Divide by a Constan controls.  

•  Increment/Decrement/Scale Constant: The value by which to adjust (in this case, in-
crement) the selected User Variable.  

•  Unlabeled : The unlabeled control at the bottom of the page indicates, in plain Eng-
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lish, the update operation that will be performed on the selected User Variable.  
 
Things to Note:  
 

1.  The Update User Variable Task operates on any User Variable, not just user-created 
Custom User Variables. If operating on a User Variable inserted by some other Task, 
be aware that that Task may also adjust and update the User Variable.  

2.  This is the Target Task for the Nested Branch Loop Task in this demonstration.  
3.  The Nested Branch Loop Task will use the Custom User Variable "My Loop Coun-

ter" as its Branch Logic User Variable. This is not strictly necessary. The Custom Us-
er Variable "Loop Counter - Nested" is added by the Nested Branch Task and serves 
the same function to the Nested Branch Task as the User Variable "Loop Counter" 
does for the Branch Task. The purpose of including the Custom User Variable Tasks 
(Create and Update) is to demonstrate their use and utility and to provide an appropri-
ate Branch Target for the Nested Branch Task.  

 
Step 3 – Add the First Hysteresis Task.  

 
1.  From the "Hardware"->"Measurement"->"Hysteresis" folder in the Library, move a 

standard Hysteresis Task into the Editor. 
 
2.  Configure as follows: 

 
 

Task Name:  "Multi-Volt/10.0 ms Hysteresis 1 - Reset"  
Max Voltage:  5.0  
Hysteresis Period (ms): 10.0  
Enable Ref. Cap.: Checked  
Respond to Nesting Branch Reset: Checked  
Comments: As Appropriate  
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Figure 4 - First Hysteresis Task Configuration.  

 
Discussion:  
 
This is a conventional Hysteresis Task configuration as seen in the earlier tutorials. The 
Task will be configured to adjust Voltage in a Branch Loop in the next step. In this 
demonstration the 1.0 nF Internal Reference Capacitor is to be measured. The key thing 
to note is that the control labeled Respond to Nesting Branch Reset is checked. When the 
Nesting Branch Task executes, it sets a Boolean "Reset" User Variable to true. When the 
Hysteresis Task detects the variable set to "True" it will reset any parameter that is ad-
justed in a Branch Loop to its original state (here, the Voltage to 5.0-Volts) provided Re-
spond to Nesting Branch Reset is checked. Any subsequent standard Branch Task will set 
the "Reset" User Variable to false, so that the parameter may be adjusted in the inner 
loop.  

 
Step 4 – Configure Parameter Adjustment.  

 
1.  On the Hysteresis Dialog click Adjust Parameters. 
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2.  Configure the subdialog values as follows: 

 
Adjust Hysteresis Volts in a Loop:  Checked  
Adjust by Incrementing:  Checked  
Voltage Increment:  1.0  
Adjust By User Variable: "<<None>>" 

 

  
Figure 5 - Hysteresis Voltage Incrementing Configuration.  

 
Step 5 – Add the Second Hysteresis Task.  

 
3.  From the "Hardware"->"Measurement"->"Hysteresis" folder in the Library, move a stand-

ard Hysteresis Task into the Editor. 
 

4.  Configure as follows: 
 

Task Name:  "Multi-Volt/10.0 ms Hysteresis 2 - No Reset"  
Max Voltage:  5.0  
Hyst. Period:  10.0  
Enable Ref. Cap.:  Checked  
Respond to Nesting Branch Reset:  Unchecked  
Comments  As Appropriate  
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Figure 6 - Second Hysteresis Task Configuration.  

 
Discussion:  
 
When the Task is placed in the Editor it will be pre-configured. Task Name and Com-
ments will need to be updated. The only configuration change is to uncheck Respond to 
Nesting Branch Reset. In this case, the Task will continue to increment the Voltage re-
gardless of the state of the Nesting Branch Task "Reset" User Variable.  

 
Step 6 – Add a Collect/Plot Filter Task.  

  
1.  From the "Filters"->"Collect/Plot" folder in the Library, move a Collect/Plot Filter to Edi-

tor. 
 
2.  Configure the main tab as follows: 
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Task Name:  "Multi-Volt/10.0 ms Hysteresis Data 1 - Reset"  

Data Type:  "Hysteresis" 
Task Selector:  "Multi-Volt/10.0 ms Hysteresis 2 - No Reset" and  

"Multi-Volt/10.0 ms Hysteresis 1 - Reset"  
Add Task:  Click to select Tasks in Task Selector  
Respond to Nesting Branch:  Checked  
Comments  As Appropriate  

 

  
Figure 7 - First Collect/Plot Filter Task.  

 
Discussion:  
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The Task is configured to collect the data from both the preceding Hysteresis Tasks. By 
checking Respond to Nesting Branch, the Task will generate a new plot, even in Append 
Mode, when the Nested Branch Task "Reset" User Variable is "TRUE".  

  
3.  Click the "Collect/Plot Plot Setup" tab and configure as follows:  

 
Plot These Data:  Checked  
Append These Data to Previous Data Taken in a Branch Loop:  Checked  
Labels:  As Appropriate  
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Figure 8 - First Collect/Plot Filter Task Plot Configuration.  

 
Step 7 – Add a Standard Branch Task.  

 
1.  From the "Program Control"->"Branching" folder in the Library, move a Branch Task to 

Editor. 
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2.  Configure the Task as follows: 
 

Task Name:  "Inner Branch Loop 1"  
Parameter to Compare:  "Loop Counter"  
Comparison:  "<="  
Integer:  "3"  
Branch Point Task:  "Multi-Volt/10.0 ms Hysteresis 1 - Reset"  
Select Branch Task:  Click to Select the Branch Point Task  
Comments  As Appropriate  

 

  
Figure 9 - First Inner-Loop Branch Task.  

 
Discussion:  
 
The Branch Task configuration is familiar from several earlier tutorials. The Task will it-
erate the Branch Loop as long as the "Loop Counter" User Variable, added by the Branch 
Task, is less than or equal to three. There will be a total of four iterations. Execution is re-
turned to the first Hysteresis Task in the Test Definition. There are two new things to 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 437 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

note, here. First is that the Branch Task will set the Nested Branch Task "Reset" User 
Variable to "FALSE" for the benefit of the Tasks within its Branch Loop. The second is 
that the Nested Branch Task will reset the "Loop Counter" User Variable to one so that 
the inner loop will completely reexecute.  

 
Step 8 - Add a Second Inner Branch Loop  
 

Repeat Steps 3 through 8. Make the following changes:  
  

1.  Name the Tasks:  
 
1.  "Multi-Volt/10.0 ms Hysteresis 3 - Reset" 
2.  "Multi-Volt/10.0 ms Hysteresis 4 - No Reset" 
3.  "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" 
4.  "Inner Branch Loop 2" 

 
2. In the "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" Collect/Plot Filter, select "Mul-

ti-Volt Hyst 4 - No Reset" and "Multi-Volt Hyst 3 - Reset" in Task Selector. 
 

3.  In the "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" Collect/Plot Filter, uncheck 
Respond to Nesting Branch .  
 

4.  In the "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" Collect/Plot Filter, adjust plot 
labels if necessary to indicate "No Nesting Branch Reset" .  
 

5.  In the "Inner Branch Loop 2" Branch Task, select "Multi-Volt Hyst 3 - Reset" as the 
Branch Point Task. 

 
Step 9 – Add a Nesting Branch Task.  

  
1.  From the "Program Control"->"Branching" folder in the Library, move a Nesting Branch 

Task to Editor. 
 
2.  Configure the Task as follows: 

 
Task Name:  "Multi-Volt Hysteresis Nesting Loop"  
Parameter to Compare:  "My Loop Counter"  
Comparison:  "<"  
Integer:  "3"  
Branch Point Task:  "Update Custom Loop Counter"  
Select Branch Task:  Click to Select the Branch Point Task  
Set "Reset" Flag:  Checked  
Comments:  As Appropriate  
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Figure 10 - Nesting Branch Task.  

 
Discussion:  
 
Configuration of the Nesting Branch Task is nearly identical to that of the Branch Task. 
There are two primary differences. First, the Branch Point Task list includes all previous 
Tasks, including Branch Tasks, allowing inner Branch Loops to be contained within the 
Branch Loop defined by the Nesting Branch Task. The Branch Point Task list stops ei-
ther at the first Task in the Test Definition or at the first earlier occurrence of another 
Nesting Branch Task. The second difference is that the Task configuration includes a Set 
"Reset" Flag control that will cause Nesting Branch Loop "Reset" to be enabled or disa-
bled. This flag should almost always be checked allowing enabling/disabling to be within 
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the purview of the enclosed Tasks.  
 

Step 10 – Create the DataSet.  
 

1.  Using any method open the New DataSet dialog. 
 
2.  Configure the DataSet as follows: 

 
DataSet Name:  "Tutorial #8a - Nesting Branching"  
DataSet Path:  "c:\datasets\tutorial #8a - nesting branching"  
Experimenter Initials:  As Appropriate  
Comments  As Appropriate - Optional - Not Recommended 

 

  
Figure 11 - Nesting Branch DataSet Creation Dialog.  

 
NOTE: The DataSet Path control is automatically updated to assign the DataSet Name 
value as the DataSet File Name, with a *.dst extension.  

 
Step 11 – Execute the Test Definition.  

 
1.  Using any appropriate method, move the Test Definition from the Editor to the CTD.  
 
2.  Name the CTD "General Nesting Branch"  
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Figure 12 - Nesting Branch CTD Name.  

 
3.  Using any appropriate method, execute the Test Definition.  

 
Discussion:  

 
On execution, the Create a Custom Loop Counter Task first creates the "My Loop 
Counter" integer User Variable and adds it to the User Variable list with the initial val-
ue 0. The Update Custom Loop Counter Task then immediately increments the value to 
1. The execution then proceeds as in Table 1. 

 
"My Loop 
Counter"  

"Loop 
Counter"  

Hyst. 1 
Volts  

Hyst 2 
Volts  

Filter 1 New 
Plot  

Hyst 3 
Volts  

Hyst 4 
Volts  

 Filter 2 
New Plot  

1  1  5.0  5.0  Yes  -  -  -  
 2  6.0  6.0  No  -  -  -  
 3  7.0  7.0  No  -  -  -  
 4  8.0  8.0  No  -  -  -  
 1  -  -  -  5.0  5.0  Yes  
 2  -  -  -  6.0  6.0  No  
 3  -  -  -  7.0  7.0  No  
 4  -  -  -  8.0  8.0  No  

2  1  5.0  9.0  Yes  -  -  -  
 2  6.0  10.0  No  -  -  -  
 3  7.0  11.0  No  -  -  -  
 4  8.0  12.0  No  -  -  -  
 1  -  -  -  5.0  9.0  No  
 2  -  -  -  6.0  10.0  No  
 3  -  -  -  7.0  11.0  No  
 4  -  -  -  8.0  12.0  No  

3  1  5.0  13.0  Yes  -  -  -  
 2  6.0  14.0  No  -  -  -  
 3  7.0  15.0  No  -  -  -  
 4  8.0  16.0  No  -  -  -  
 1  -  -  -  5.0  13.0  No  
 2  -  -  -  6.0  14.0  No  
 3  -  -  -  7.0  15.0  No  
 4  -  -  -  8.0  16.0  No  

Table 1 - Voltage and Plot Sequencing. 
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Hysteresis Tasks 1 and 3 range between 5.0 and 8.0 Volts and repeat the range over three 
total (outer branch) iterations. These are configured to respond to the Nested Branch "Re-
set" User Variable flag. Hysteresis Tasks 2 and 4 range between 5.0 and 16.0 Volts over 
the entire experiment. These are configured not to respond the Nested Branch "Reset" 
flag. Collect/Plot Filter 1 produces three plot windows, each with eight traces. Each plot 
is composed of two input Tasks over four inner Branch iterations. The first plot has two 
sets of data that range over 5.0 to 8.0 Volts. The second plot has one set of data that rang-
es over 5.0 to 8.0 Volts and another that ranges over 9.0 to 12.0 Volts (Figure 13). The 
final plot shows 5.0 to 8.0-Volt and 13.0 to 16.0-Volt data. This Task is configured to re-
spond to the Nested Branch Task "Reset" flag. The second Collect/Plot Filter is not con-
figured to respond to the Nested Branch Loop "Reset". This Task produces a single plot 
with 24 total traces. This includes four sets of traces at 5.0 to 8.0 Volts and one set each 
at 9.0 to 12.0 Volts and 13.0 to 16.0 Volts (Figure 14). 

 

  
Figure 13 - Reset Append Data - Outer Loop Two.  
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Figure 14 - No Reset Append Data - Outer Loop Three (Final Plot).  

 
Step 12 – Re-execute the Test Definition and Examine the Data in the DataSet 
Archive as Desired.  
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B -  Practical Example 
 

This tutorial continues the lessons of Tutorial VIII-A by presenting a more practical example of 
Nesting Branch Loop applications. However, this example makes use of the Set Temperature 
Task. Although the Task is available to all users, it is only useful to those who are able to control 
one of the external thermal controllers that have been programmed into the Task. This tutorial is 
very nearly identical to Tutorial VIII-A. It simply replaces the User Variable - Create and User 
Variable - Update Tasks with the Set Temperature Task at the beginning of the Test Definition. 
The Set Temperature Task becomes the Target Task for the Nested Branch Loop Task. 
 
Step 1 – Add a Set Temperature Task.  

 
1.  In the Library open the "Hardware->External Instruments" Folder and Subfolder. 
 
2.  Drag-and-Drop a GPIB Set Temperature Task into the Editor . 
 
3.  Configure the Task as follows: 

 
Task Name:  "Control the XXX Chamber"  
GPIB Address:  As Required  
Thermal Controller Type:  As Required  
Set Temperature:  Checked  
Temperature (°C):  50.0 or some appropriate initial value  
Adjust Temp in a Loop:  This will be checked after additional configuration discussed below.  
Set Ramp Rate:  Checked if available and desired.  
Ramp Rate:  Appropriate Value, if available and desired.  
Use Stability Delay:  Checked if Desired  
Stability Delay (s):  Appropriate value if Use Stability Delay is Checked.  
Tolerance:  Appropriate Non-Zero Value  
Respond to Nesting Branch Reset:  Unchecked  
Comments:  As Appropriate.  

 
4.  Click OK to add the Set Temperature Task as the first Task in the Test Definition in the 

Editor 
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Figure 1 - Configuring the Set Temperature Task.  

 
Discussion:  
 
The configuration of the Set Temperature is highly variable and dependent on the cir-
cumstances of the user. Figure 1 serves as an example. The following list points out the 
controls that are required for this tutorial.  

 
•  GPIB Address: This is a required value for most thermal controllers. Some are con-

trolled directly through a serial connection. This is the GPIB Address (0-31) of the 
thermal controller. By default the address is '5' and, if no other instruments appear on 
the GPIB bus, it is recommended that the thermal controller address be permanently 
set to '5'.  

•  Thermal Controller Type: Select your thermal controller. The appropriate selection is 
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required. The availability of some of the other controls will depend on this selection.  
•  Set Temperature: This control must be checked. For thermal controllers that allow 

ramp rate setting, the execution can be made to just set the ramp rate by unchecking 
this control.  

•  Temperature (°C) : An appropriate initial value must be set in this control. Ensure 
that the value is such that the combination of initial value, Branch Loop adjustment 
and total iterations do not combine to order a temperature that is beyond the capabil-
ity of the thermal controller being used.  

•  Set Adjust Temp/Adjust Temp in a Loop : These are discussed in Step 2 .  
•  Set Ramp Rate : This control is enabled only for certain thermal controller selections 

in Thermal Controller Type . If enable and desired, check this control.  
•  Ramp Rate (°C/min.) : This control is enabled only for certain thermal controller se-

lections in Thermal Controller Type and only if Set Ramp Rate is checked. Set an ap-
propriate ramp rate if desired.  

•  Set Adjust Ramp/Adjust Ramp Rate in a Loop. This control is enabled only for certain 
thermal controller selections in Thermal Controller Type and only if Set Ramp Rate is 
checked. If desired and available exercise the ramp rate adjustment subdialog to allow 
the ramp rate to be adjusted in the loop. Note that temperature will also be adjusted in 
this tutorial and it is not good programming practice to allow multiple parameters to 
change from one iteration to another.  

•  Use Stability Delay : If checked, once the currently detected temperature is within the 
programmed Tolerance (°C) of the target Temperature (°C) , the Task will start a 
timer. Each time that the current temperature falls outside the tolerance, the timer re-
starts. If the timer continues for the programmed Stability Delay (s) , the temperature 
is considered stable and Task execution stops. If this control is unchecked, Task exe-
cution stops immediately when the current temperature is within the tolerance of the 
target temperature. Checking this control enables Stability Delay (s) .  

•  Stability Delay (s) : This control is enabled if Use Stability Delay is checked. This is 
the period of time during which the detected temperature must remain within the Tol-
erance (ºC) of the target Temperature (°C) for the temperature to be considered sta-
ble.  

•  Tolerance (°C) : A value that specifies an error bar around the target Temperature 
(°C) . If the detect current temperature is within the error bar the temperature is either 
considered stable (if Use Stability Delay is not checked) or the stability timer is start-
ed. It is recommended that a non-zero value be used.  

•  Respond to Nesting Branch Reset : This control must be unchecked for this tutorial. If 
checked, the temperature (and possibly ramp rate) will be reset to their initial values 
if the Nested Branch "Reset" User Variable is "TRUE".  

 
Step 2 – Configure Branch Loop Temperature Adjustment.  

  
1.  On the Set Temperature configuration dialog, click Set Adjust Temp.  
 
2.  Configure the subdialog as follows: 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 446 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

Adjust Temperature:  Checked  
Adjust by Incrementing:  Checked  
Temperature Increment:  10.0 or appropriate value  

 

  
Figure 2 - Configure the Temperature Branch Loop Adjustment.  

 
Discussion:  
 
This step configures the previous Branch Loop set temperature to be incremented by 10° 
C at each Branch Loop iteration. This configuration is at the user's discretion, but some 
adjustment must be made for the purpose of this tutorial. Note that a negative increment 
(or fractional scale factor) should only be used if a cooling gas is available to the thermal 
device.  

 
Step 3 – Add the First Hysteresis Task.  
 

1.  Steps 3 through 8 are identical to Tutorial VIII-B  
 

2.  From the "Hardware"->"Measurement"->"Hysteresis" folder in the Library, move a 
standard Hysteresis Task into the Editor. 
 

3.  Configure as follows: 
 

Task Name:  "Multi-Volt/10.0 ms Hysteresis 1 - Reset"  
Max Voltage:  5.0  
Hysteresis Period (ms): 10.0  
Enable Ref. Cap.:  Checked  
Respond to Nesting Branch Reset:  Checked  
Comments:  As Appropriate  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 447 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 3 - First Hysteresis Task Configuration.  

 
Discussion:  
 
This is a conventional Hysteresis Task configuration as seen in the earlier tutorials. The 
Task will be configured to adjust Voltage in a Branch Loop in the next step. In this 
demonstration the 1.0 nF Internal Reference Capacitor is to be measured. The key thing 
to note is that the control labeled Respond to Nesting Branch Reset is checked. When the 
Nesting Branch Task executes, it sets a Boolean "Reset" User Variable to true. When the 
Hysteresis Task detects the variable set to "True" it will reset any parameter that is ad-
justed in a Branch Loop to its original state (here, the Voltage to 5.0-Volts) provided Re-
spond to Nesting Branch Reset is checked. Any subsequent standard Branch Task will set 
the "Reset" User Variable to false, so that the parameter may be adjusted in the inner 
loop.  

 
Step 4 – Configure Parameter Adjustment.  

 
1.  On the Hysteresis Dialog click Adjust Parameters. 
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2.  Configure the subdialog values as follows: 

 
Adjust Hysteresis Volts in a Loop:  Checked  
Adjust by Incrementing:  Checked  
Voltage Increment:  1.0  
Adjust By User Variable "<<None>>" 

 

  
Figure 4 - Hysteresis Voltage Incrementing Configuration.  

 
Step 5 – Add the Second Hysteresis Task.  

 
1.  From the "Hardware"->"Measurement"->"Hysteresis" folder in the Library, move a 

standard Hysteresis Task into the Editor. 
 
2.  Configure as follows: 

 
Task Name:  "Multi-Volt/10.0 ms Hysteresis 2 - No Reset"  
Max Voltage:  5.0  
Hysteresis Period:  10.0  
Enable Ref. Cap.:  Checked  
Respond to Nesting Branch Reset:  Unchecked  
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Comments  As Appropriate  
 

  
Figure 5 - Second Hysteresis Task Configuration.  

 
Discussion:  
 
When the Task is placed in the Editor it will be pre-configured. Task Name and Com-
ments will need to be updated. The only configuration change is to uncheck Respond to 
Nesting Branch Reset . In this case, the Task will continue to increment the Voltage re-
gardless of the state of the Nesting Branch Task "Reset" User Variable.  
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Step 6 – Add a Collect/Plot Filter Task.  
  
1.  From the "Filters"->"Collect/Plot" folder in the Library, move a Collect/Plot Filter 
to Editor. 

 
2.  Configure the main tab as follows: 

 
Task Name:  "Multi-Volt/10.0 ms Hysteresis Data 1 - Reset"  
Data Type:  "Hysteresis  
Task Selector:  "Multi-Volt/10.0 ms Hysteresis 1 - Reset" and  

"Multi-Volt/10.0 ms Hysteresis 2 - No Reset"  
Add Task:  Click to select Tasks in Task Selector  
Respond to Nesting Branch:  Checked  
Comments  As Appropriate  

 

  
Figure 6 - First Collect/Plot Filter Task.  
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Discussion:  
 
The Task is configured to collect the data from both the preceding Hysteresis Tasks. By 
checking Respond to Nesting Branch , the Task will generate a new plot, even in Append 
Mode, when the Nested Branch Task "Reset" User Variable is "TRUE".  

  
3.  Click the "Collect/Plot Plot Setup" tab and configure as follows:  

 
Plot These Data:  Checked  
Append These Data to Previous Data Taken in a Branch Loop:  Checked  
Labels:  As Appropriate  

 

  
Figure 7 - First Collect/Plot Filter Task Plot Configuration.  

 
Step 7 – Add a Standard Branch Task.  
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1.  From the "Program Control"->"Branching" folder in the Library, move a Branch 
Task to Editor. 

 
2.  Configure the Task as follows: 

 
Task Name:  "Inner Branch Loop 1"  
Parameter to Compare:  "Loop Counter"  
Comparison:  "<="  
Integer:  "3"  
Branch Point Task:  "Multi-Volt/10.0 ms Hysteresis 1 - Reset"  
Select Branch Task:  Click to Select the Branch Point Task  
User Tolerance: Unchecked 
User Variable Limit Selection: "<<None>>" 
Comments  As Appropriate  

 

  
Figure 8 - First Inner-Loop Branch Task.  

 
Discussion:  
 
The Branch Task configuration is familiar from several earlier tutorials. The Task will it-
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erate the Branch Loop as long as the "Loop Counter" User Variable, added by the Branch 
Task, is less than or equal to three. There will be a total of four iterations. Execution is re-
turned to the first Hysteresis Task in the Test Definition. There are two new things to 
note, here. First is that the Branch Task will set the Nested Branch Task "Reset" User 
Variable to "FALSE" for the benefit of the Tasks within its Branch Loop. The second is 
that the Nested Branch Task will reset the "Loop Counter" User Variable to one so that 
the inner loop will completely reexecute.  

 
Step 8 - Add a Second Inner Branch Loop  
 
Repeat Steps 3 through 8. Make the following changes:  

  
1.  Name the Tasks:  

 
1.  "Multi-Volt/10.0 ms Hysteresis 3 - Reset" 
2.  "Multi-Volt/10.0 ms Hysteresis 4 - No Reset" 
3.  "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" 
4.  "Inner Branch Loop 2" 

 
2. In the "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" Collect/Plot Filter, select "Multi-

Volt Hyst 4 - No Reset" and "Multi-Volt Hyst 3 - Reset" in Task Selector. 
 
3. In the "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" Collect/Plot Filter, uncheck Re-

spond to Nesting Branch .  
 
4. In the "Multi-Volt/10.0 ms Hysteresis Data 2 - No Reset" Collect/Plot Filter, adjust plot 

labels if necessary to indicate "No Nesting Branch Reset" .  
 
5. In the "Inner Branch Loop 2" Branch Task, select "Multi-Volt Hyst 3 - Reset" as the 

Branch Point Task. 
 

Step 9 – Add a Nesting Branch Task.  
  
2.  From the "Program Control"->"Branching" folder in the Library, move a Nesting 
Branch Task to Editor. 
 
3.  Configure the Task as follows: 

 
Task Name:  "Multi-Volt/Multi-Temp Hysteresis Nesting Loop"  
Parameter to Compare:  "Set Temperature: Current Temperature"  
Comparison:  "<"  
Integer:  "100" or Appropriate Upper Limit.  
Use Tolerance: Unchecked 
User Variable Limit Selection: "<<None>>" 
Branch Point Task:  "Control the xxx Chamber"  
Select Branch Task:  Click to Select the Branch Point Task  
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Set "Reset" Flag:  Checked  
Comments:  As Appropriate  

 

  
Figure 9 - Nesting Branch Task.  

 
Discussion:  
 
Configuration of the Nesting Branch Task is nearly identical to that of the Branch Task. 
There are two primary differences. First, the Branch Point Task list includes all previous 
Tasks, including Branch Tasks, allowing inner Branch Loops to be contained within the 
Branch Loop defined by the Nesting Branch Task. The Branch Point Task list stops ei-
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ther at the first Task in the Test Definition or at the first earlier occurrence of another 
Nesting Branch Task. The second difference is that the Task configuration includes a Set 
"Reset" Flag control that will cause Nesting Branch Loop "Reset" to be enabled or disa-
bled. This flag should almost always be checked allowing enabling/disabling to be within 
the purview of the enclosed Tasks.  

  
Step 10 – Open the Tutorial #8a - Nesting Branching DataSet.  

 
1.  If the tutorial is not already open, go to the Tutorials folder in the DataSet Archive 
and double-click the "Tutorial #8a - Nesting Branching" DataSet icon to open the Da-
taSet. 

 
Step 11 – Execute the Test Definition.  

  
1.  Using any appropriate method, move the Test Definition from the Editor to the 
CTD.  
 
2.  Name the CTD "Practical Multi-Temperature/Multi-Voltage Nesting Branch TD"  

 

  
Figure 10 - Nesting Branch CTD Name.  

 
 
3.  Using any appropriate method execute the Test Definition.  

 
Discussion:  
 
On execution, the Control XXX Chamber Task first set the Current Temperature to 50° C 
and writes the "GPIB ST: Current Temperature" User Variable. The execution then pro-
ceeds as in Table 1. 

 
 

"Set Temperature: Cur-
rent Temperature"  

"Loop 
Counter"  

Hyst. 1 
Volts  

Hyst 2 
Volts  

Filter 1 
New Plot  

Hyst 3 
Volts  

Hyst 4 
Volts  

 Filter 2 
New 
Plot  

50° C  1  5.0  5.0  Yes  -  -  -  
 2  6.0  6.0  No  -  -  -  
 3  7.0  7.0  No  -  -  -  
 4  8.0  8.0  No  -  -  -  
 1  -  -  -  5.0  5.0  Yes  
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 2  -  -  -  6.0  6.0  No  
 3  -  -  -  7.0  7.0  No  
 4  -  -  -  8.0  8.0  No  

60° C  1  5.0  9.0  Yes  -  -  -  
 2  6.0  10.0  No  -  -  -  
 3  7.0  11.0  No  -  -  -  
 4  8.0  12.0  No  -  -  -  
 1  -  -  -  5.0  9.0  No  
 2  -  -  -  6.0  10.0  No  
 3  -  -  -  7.0  11.0  No  
 4  -  -  -  8.0  12.0  No  

... ~ ~ ~ ~ ~ ~ ~ 
100° C  1  5.0  13.0  Yes  -  -  -  

 2  6.0  14.0  No  -  -  -  
 3  7.0  15.0  No  -  -  -  
 4  8.0  16.0  No  -  -  -  
 1  -  -  -  5.0  13.0  No  
 2  -  -  -  6.0  14.0  No  
 3  -  -  -  7.0  15.0  No  
 4  -  -  -  8.0  16.0  No  

 
Hysteresis Tasks 1 and 3 range between 5.0 and 8.0 Volts and repeat the range over three to-
tal (outer branch) iterations. These are configured to respond to the Nested Branch "Reset" 
User Variable flag. Hysteresis Tasks 2 and 4 range between 5.0 and 16.0 Volts over the en-
tire experiment. These are configured not to respond the Nested Branch "Reset" flag. Col-
lect/Plot Filter 1 produces three plot windows, each with eight traces. Each plot is composed 
of two input Tasks over four inner Branch iterations. The first plot has two sets of data that 
range over 5.0 to 8.0 Volts. The second plot has one set of data that ranges over 5.0 to 8.0 
Volts and another that ranges over 9.0 to 12.0 Volts (Figure 11). The final plot shows 5.0 to 
8.0-Volt and 13.0 to 16.0-Volt data. This Task is configured to respond to the Nested Branch 
Task "Reset" flag. The second Collect/Plot Filter is not configured to respond to the Nested 
Branch Loop "Reset". This Task produces a single plot with 24 total traces. This includes 
four sets of traces at 5.0 to 8.0 Volts and one set each at 9.0 to 12.0 Volts and 13.0 to 16.0 
Volts (Figure 12). 
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Figure 11 - Reset Append Data - Outer Loop Two.  

 

  
Figure 12 - No Reset Append Data - Outer Loop Three (Final Plot).  

 
Step 12 – Re-execute the Test Definition and Examine the Data in the DataSet 
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Archive as Desired.  
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IX - Test Definition Graphing 
 

Test Definition Graphing 
 

A graphical representation of any Test Definition in Vision can be made and then edited, printed 
and exported. Recall that a Test Definition refers to a linear sequence of Vision Tasks that, taken 
together, form an experiment. There is usually a Test Definition under construction in the Editor 
window. All DataSets contain a single Test Definition, called the Current Test Definition (CTD), 
that is the experiment that is ready for execution within the DataSet. The DataSet may also con-
tain any number of archived Executed Test Definitions (ETDs) that represent previous experi-
ment executions in the DataSet. Figure 1 highlights various Test Definitions in an execution of 
Vision. In the Figure, Editor and CTD show the Test Definition from Tutorial 8-B. The ETD 
shows the Tutorial 8-A Test Definition. For the purpose of this tutorial, the examples will be tak-
en from these Test Definitions. 

 

  
Figure 1 - Test Definitions in Vision.  

 
Step 1 - Ensure that the Editor Contains a Test Definition  

 
1.  Using any available means, ensure that Editor contains one or more Tasks form-
ing a Test Definition.  

 
Step 2 - Create a Graph of the Test Definition in the Editor.  

 
1.  Right-click in the Editor Window.  
 
2.  From the Popup Menu, select "Graph Editor Test Definition".  
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Figure 2 - Initiate Editor Test Definition Graphing.  

  
3.  The Graph will appear in the User Area.  
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Figure 3 - Editor Test Definition Graph.  

 
Discussion:  
 
The Test Definition Graph consists of two panes, similar to a Filter or Long-Duration 
Task plot window. To the right is a boxed area labeled Mini-Graph. It includes a list of 
icons representing the Tasks in the Test Definition. It also presents brown lines showing 
the relationship between Filter Tasks and the Tasks that provide their input data. Blue 
lines link Branch Tasks to their Target Tasks. The black line does the same for the Nest-
ing Branch Task.  

 
To the left, the main presentation presents a boxed area for each Task in the Test Defini-
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tion. The box is of a color that represents its Task type. The Task Type icon is also shown 
to the upper right in the box. The top line, in italics, presents the Task version number, 
the date of most-recent update and the Task type. Task Types, box colors and icons are 
presented in Table 1 .  
 
The text within the remainder of the box is added by the Task itself and, in the "Standard" 
text mode, presents sufficient Task configuration information to recreate the Task. It is 
possible that the Task may provide text that overruns the limits of the box.  
 
Tasks that are Branch Targets add a blue dot to the center right of the box and label the 
dot "Branch Target". Tasks that provide data to Filters add a brown rectangle to the low-
er-right. The rectangle is labeled "Filter Target". As with the Mini-Graph, brown and blue 
lines indicate links between Filter and Branch Tasks and their associated preceding 
Tasks.  

 
Task Family Type  Box Color  Icon  

Program Control  Blue    
Hardware  Dark Green    

Measurement  Light Green    
External Instru-

ment 
Orange    

Filter  Dark Brown    
Long-Duration  Light Brown    

Branch  Blue    
Nesting Branch  Blue    

Table 1 - Icons and Box Colors by Task Type.  
 

Step 3 - Resize and Scroll the Test Definition Graph as Desired.  
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Figure 4 - Resized/Scrolled Test Definition Graph.  

 
Step 4 - Add Graph Comments  

 
1.  Right-click in the Graph window and select "Graph Comments" from the Popup 
Menu. 
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Figure 5 - Initiate Graph Comments.  

 
  
2.  In the dialog that appears, insert any desired text. 

 

  
Figure 6 - Edit the Comments.  

  
3.  Click OK. The Comments will appear in a black box in the right Graph pane, just under 

the Mini-Graph box. The window may need to be resized to show the entire Comments 
box. 
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Figure 7 - Comments in the Graph.  

 
Step 5 - Edit the Comments  

  
1.  Right-click in the Graph window and select "Graph Comments" from the popup 
menu. 
 
2.  The Comments dialog will appear and will contain the existing comments. These 
will be highlighted. 

 
3.  Edit the comments as desired, then click OK to update them in the Graph right pane. If 

all text is deleted from the Comments dialog, the black Comments box will be removed 
from the Graph window. 
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Figure 8 - Editing Graph Comments.  

 
Step 6 - Change a Task's Box Color  
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1.  Left-click within the box limits for any Task in the Graph. 

 
2.  The box color will change to pink to highlight the Task and indicate that it has 
been selected. 

 

  
Figure 9 - Highlight (Select) the Task.  

  
3.  Right-click and select "Change Task Box Color" from the popup menu. 

 

  
Figure 10 - Selected Task Popup Menu.  

 
4.  In the standard Windows Color Picker dialog that appears, click Define Custom 
Colors to expand the dialog, if desired. 
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Figure 11 - Standard Windows Color Picker Dialog.  

 
5.  Choose a color and click OK. The Task box appears in the new color. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 469 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

  
Figure 12 - Updated Task Box Color.  

  
6.  Note that a Task's box color may always be returned to the default value by se-
lecting the Task, right-clicking and selecting "Reset Task Color to Default" in the popup 
menu. 

 
Step 7 - Add Additional Text to a Task.  
 

Text within a Task box is added by the specific Task. This text can be extended with com-
ments by the experimenter. 

 
1.  Select (highlight) the Task by left-clicking within its box. 

 
2.  Right-click and select "Append to Task Text" in the popup menu. 

 
3.  In the dialog that appears, add the desired text, then click OK. 
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4.  The additional text is appended to the bottom of the text in the Task box and the 
box is extended. Note that the text can overrun the box limits as in Figure 13. 

 
5.  Note that the Task text can be cleared of this additional text by selecting the Task, 
right-clicking and selecting "Reset Task Text to Default" in the popup menu. 

 

  
Figure 13 - Appending User Text to the Task Text.  

 
Step 8 - Print Preview the Graph.  
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1.  Right-click in the Graph window and select "Print Preview..." 

  
2.  A paged preview of the Graph, as it will be sent to the printer is presented. The 
first page is the Mini-Graph and comments. The remaining pages are the left graph pane, 
broken to the appropriate number of pages. 

 
3.  Note that the bit mapped Graph Icons will normally not be properly positioned in 
the Print Preview. However, these will be properly positioned on the actual printout. 

 

  
Figure 14 - Graph Print Preview.  

 
Step 9 - Print the Graph  

  
1.  Right-click in the Graph window and select "Print" 

 
2.  Retrieve the Graph from the printer. The Graph will be properly printed with the 
right Graph pane as the first page. Bitmapped icons should appear properly placed. 
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Figure 15 - Select the Print Option.  

 
Step 10 - Copy the Graph and Paste into a Target Program.  

  
1.  Right-click in the Graph window and select "Copy to Clipboard" 

 
2.  Open any program such as Microsoft Word or Excel and select "Edit->Paste" or 
press <Ctrl-V>. 

 
3.  The buffered image of the Graph will appear in the document. 
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Figure 16 - Clipboard Graph Pasted into Microsoft Word.  

  
Note that the Graph is pasted as a single object. In a paged program such as Microsoft 
Word, the Graph may be clipped until the object is resized and resizing the Graph may 
produce an object that has too low a resolution. This will not be an issue in a non-paged 
program such as Microsoft Excel. If the object must be pasted into a paged document, it 
is recommended that the Test Definition be constructed for Graph purposes in smaller 
sections of fewer Tasks. The Graph can also be pasted into a program such as Microsoft 
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Paint, in which it can be subdivided into images that present a better appearance in the 
paged program. 

 
Step 11 - Save the Graph to a file.  
 

The graph may be saved to a file in its current condition. The file may then be reopened in 
Vision or distributed to others for opening in Vision. When the graph is closed, you will be 
prompted to save it. (Pressing <Ctrl-G> closes all Graphs and does not prompt for saving.) 

  
1.  Right-Click and select "Save As..." from the popup menu. 

 
2.  A standard Windows File Browser dialog will appear. Navigate to an appropriate 
folder and assign an appropriate file name. 

 
3.  Click Save and the Graph will be written to the file. 

 

  
Figure 17 - Saving the Graph to File.  

 
Step 12 - Recall the Graph from a File.  
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A Graph may be recalled from its file by selecting "File->Open a Test Definition Graph" 
from the main Vision menu. It may also be opened from within an existing Graph by right-
clicking and selecting "Open". In that case, the file Graph will replace the existing Graph. 

  
1.  Select "File->Open a Test Definition Graph", or... 

 
2.  ...alternatively, right-click in an existing Graph and select "Open". 

 
3.  A standard Windows File Browser dialog will appear. Navigate to the folder 
where the graph is located and select the appropriate file name. 

 
4.  Click Save. 

 
5.  In 1., the Graph will be opened in a new Graph window. For 2. the Graph will re-
place the existing Graph in the existing window. 
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Figure 18 - Recall a Graph from a File.  

 
Step 13 - Adjust the Task Text Displayed.  
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Once a Graph is created, its appearance is fixed except for the operations that can be per-
formed as presented in the earlier steps. However, before a graph is created, the text display 
for the Tasks can be adjusted. The images above show the "Standard" text display that is the 
default. "Minimized" and "Full" text display are also available. The display can be adjusted 
by right-clicking in the Editor window, on the CTD entry or on and ETD entry and selecting 
either "Minimize Graph Text" or "Full Graph Text". The options can also be adjusted in the 
main Vision "File" menu. 

  
1.  Right-click in the Editor window and select "Minimize Graph Text" from the 
popup menu. 

 
2.  Right-click in the Editor window and select "Graph Editor Test Definition". 

 
3.  The new Graph will appear with minimized Task text. All Tasks indicate only Version, 

Compilation Date, Family Type, Type Icon, Task Type and Task Name. Branch and Fil-
ter Target Icons and connecting lines are eliminated. (These still appear in the Mini-
graph. This presentation may be most useful for exporting to a paged document such as 
Microsoft Word. 

 

 
Figure 19 - Minimized Text Presentation.  

 
 
4.  Right-click in the Editor window and select "Full Graph Text" from the popup 
menu. 
 
5.  Right-click in the Editor window and select "Graph Editor Test Definition". 

 
6.  The new Graph will appear with a Full Text presentation. Some Tasks may add signifi-

cant additional detail. All Tasks add, at a minimum, configuration and (if applicable) ex-
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ecution date and time. Branch and Filter Target Icons and connecting lines are shown. 
 

  
Figure 20 - Full Text Presentation.  

 
7.  Note that the text presentation selection is persistent, even between Vision execu-
tions, until changed. 
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 X - Documents Window 
 

Documents Window 
 

Vision offers a program window with a direct link to documents of a variety of specific types. By 
default the Document Library window appears at the bottom-right of the main Vision display. 
The Task Library is moved up to appear between the Editor and Documents windows. The doc-
uments window first lists all Adobe Reader (*.PDF) files located in C:\DataSets\User-Printable 
Help. The installer writes the *.PDF versions of the help page documents to this location. These 
files are listed in a folder named "User-Printable Help". Next Vision loads all Help (*.chm) files 
found at C:\Program Files (x86)\Radiant Technologies\Vision\Help into a folder named "CHM 
Files". These are the help pages opened by going to the "Help->Help Topics (Ctrl + H)" menu 
option or by clicking the Click For Task Instructions button in any Task dialog. The files are also 
written during Vision installation. Finally, the file path C:\DataSets\Documents is searched for 
files of a variety of types. Any files of these types are loaded into the Documents Library win-
dow under a folder as specified in Table 1. Several demo files of various types are written to this 
location by the installer and any file placed in that location, by the user, before Vision execution, 
will appear in the Documents Library. The Library window, as configured by the installer, is 
shown in Figure 1. Double-clicking on any document will open the document in its particular 
program provided the program is installed on the host computer. 

 
File Type  Extension  Folder Name  

Adobe Reader  *.PDF  PDF Files  
Text  *.TXT  Text Files  

Microsoft Word  *.DOC/*.DOC
X  

Word Files 
(*.DOC/*.DOCX)  

Microsoft Excel  *.XLS/*.XLSX  Excel Files 
(*.XLS/*.XLSX)  

Microsoft PowerPoint  *.PPT/*.PPTX  PowerPoint Files 
(*.PPT/*.PPTX)  

JPEG (Images)  *.JPG  JPEG Images  
Microsoft VISIO (Drawings)  *.VSD  Visio Files  

Bitmap Files (Images)  *.BMP  Bitmap Files  
Web Files  *.HTML  HTML Files  

Table 1 - Document Library File Types, Extensions and Folders.  
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Figure 1 - The Document Library Window in Vision.  

 
Step 1 - Open a User-Printable Help Adobe Reader File  

 
1.  In the Document Library open the "User-Printable Help Files" folder. 

 
2.  Double-click the "Nested Branch Loop Reset" document (or any other document). 
This document was added by the installer and should appear. 

 
3.  The Adobe Reader program starts (if installed on the Vision host computer) and 
the document appears. 
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Figure 2 - Opening the "Nested Branch Loop Reset" PDF File.  
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Note that the duplication of the Vision Help and Task Instructions projects into User-
Printable PDF Files is no longer being maintained. These files remain part of the pro-
gram distribution, and are available from the Documents window, but are not generally 
up-to-date. 
 

Step 2 - Open the Main Vision Help Pages  
  
1.  In the Document Library open the "CHM Files" folder. 

 
2.  Double-click the "Main_Vision_Help" document (or any other document). This 
document was added by the installer and should appear. 

 
3.  The Windows help window opens and shows the main Vision help document. 

 

  
Figure 3 - Opening the "Main_Vision_Help" File.  

 
Step 3 - Open the JPEG "demo" Image  
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1.  In the Document Library open the "JPEG Images" folder. 
 

2.  Double-click the "demo" image. This file was added by the installer to demon-
strate the JPEG listing in the Document Library and should appear. 

 
3.  The default JPEG viewer will open and the demo image will appear. 

 

  
Figure 4 - Opening the "demo" JPEG Image File.  

 
Step 4 - Access Custom Files  

  
1.  Stop Vision. 
 
2.  Copy any files of any type from the list of Table 1 to C:\DataSets\Documents. 
 
3.  Start Vision. 
 
4.  Open the folder(s) of the type(s) of the copied file(s). 

 
5.  Double-click the file to open in the appropriate program. 
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XI - Data Mining, ETD Transfer and Simple Measure 
 

A - Data Mining 
 
A.1 - Discussion 
 
Vision collects data and archives them in diverse DataSets that are registered to the DataSet Ex-
plorer window. An important tool is to be able to gather data from these diverse locations for di-
rect and immediate comparison. This problem was originally resolved by including the ability to 
export data to a Vision Data File (*.vis). The data could then be imported, on Task execution, by 
a Task of identical type. This remains a valid technique and is serviceable for moving data from 
one or two Measurement and Filter Tasks. However the process is tedious for large-scale data 
gathering. A more-recent solution is the addition of Data Mining. 
 
Data Mining is the process of gathering a selected number of archived Tasks of a specific type 
from any number of  DataSets into a single Executed Test Definition (ETD) in the Archive of a 
single DataSet. Along with the collected Tasks, the user may append a single Filter Task that is 
appropriate for the data mined Task type and apply it to the mined data.  
 
Although the mechanics of Data Mining are much more automatic than transferring data through 
Vision Data Files, the process still requires effort and planning on the user's part. The user must 
identify the location of the data to be mined before starting the operation. The matter is compli-
cated by the fact that many of the Tasks may have the same name. This is particularly true if the 
Tasks include those taken in a Branch Loop. The Data Mining operation allows Tasks to have 
their names changed to better segregate them during Data Mining configuration. 
 
A.2 - Operation 
 

Step 1 - Identify the Tasks to Data Mine: 
 
For this example I will use the initial Hysteresis Tasks of Tutorial #1 and Hysteresis meas-
urements taken in a Branch Loop from Tutorial #3. 
 
1.  Review the source DataSets to identify the Tasks to mine for data. 
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Figure 1 - Choose the Tasks to Data Mine. 

 
Step 2 - Initiate Data Mining  
 
1.  Select "DataSet->Data Mining" or click the "DM" toolbar button. 
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Figure 2 - Initiate Data Mining. 

 
2.  The Data Mining Wizard will open. The first tab shows a discussion of the procedure. 

Review and then click Next >. (Note that the Click For Dialog Instructions does not have 
a help project associated with it as of this writing.) 

 
Step 3 - Select Target DataSet  
 
In this step, a single target DataSet, to which to write the mined data, is selected. All Da-
taSets registered to Vision are listed in the list box. Any existing DataSet may be selected as 
the target. Or a new DataSet may be created. In any case, the DataSet will be opened in the 
DataSet Explorer. Note that if a closed DataSet is opened, the DataSet will be closed at the 
end of the operation. For this example, a new DataSet will be created. To use an existing Da-
taSet, select the DataSet from the list and click Select Target DataSet. Note that Next > will 
be disabled until a target DataSet is selected. 
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Figure 3 - Target DataSet Selection Tab. 

 
1.  Click New DataSet to open the New DataSet Dialog. 

 
2.  Configure the DataSet as follows: 

 
DataSet Name:  Tutorial #11b - Data Mining 
DataSet Path: c:\datasets\tutorials\tutorial #11b - data mining.dst 
Experimenter Initials: As appropriate 
Comments: As appropriate - optional - not recommended 
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Figure 4 - New Target DataSet. 

 
3.  Click OK to create and open the target DataSet. Next > is enabled. Select Target DataSet 

is disabled. The created DataSet is identified as the selected DataSet. Click Next >. (The 
selected DataSet may still be changed in the list box. If it is changed Select Target Da-
taSet is enabled and Next > is disabled. Clicking Select Target DataSet disables Select 
Target DataSet and enables Next >.)  

 
Step 3 - Select the Source DataSet(s) 
 
The next wizard tab again lists all DataSets registered to Vision. It is used to select the Da-

taSets from which to mine data. 
 
1.  Select "Tutorial #1b" and "Tutorial #3b". 

 
2.  Click Select Source DataSets. The selected DataSet name(s) will appear in the unlabeled 

text box. Next > will be enabled. Click Next >. "Tutorial #1b" and "Tutorial #3b" will 
open if they were not already open. This may take some time depending on the size of the 
DataSets. (Sequence 1. and 2. may be repeated to change the selection before clicking 
Next >.)  
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Figure 5 - Select Source DataSet. 

 
3.  Any selected DataSet that is not opened will be opened. The selected DataSets will be 

searched for all Measurement and Filter Task types that can be mined. This may take 
some time and delay switching to the next wizard tab. 

 
Step 4 - Select the Task Type to Mine for Data  
 
1.  The next wizard tab will list all the Task types found in the selected source DataSets that 

may have their data mined. Select the "Hysteresis" Task type in the list. 
 

2.  Click Select Task Type. Next > is enabled. 
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Figure 6 - Select Task Type. 

 
3.  Click Next >. The source DataSets will be polled for all Tasks of the type selected before 

displaying the next tab. This can take some time. 
 
Step 5 - Select the Tasks to be Data Mined  
 
The next tab shows a tree structure. At the root are the DataSets. Below each DataSet is a list 
of Executed Test Definitions (ETDs) that contain examples of the selected Task type. Below 
each ETD is a list of all of the Tasks in the ETD of the selected type. All Tasks in a DataSet 
can be selected for data mining by checking the DataSet box. Otherwise all Tasks in any giv-
en ETD can be selected by checking the ETD box. Otherwise, individual Tasks may be se-
lected by checking them. 
 

1.  Expand the tree and check individual Task boxes or ETD boxes, as appropriate to 
select the Tasks identified in Step 1 (Figure 1). 

 
2.  Click Select Tasks. The Tasks will be registered for Data Mining. Next > will be 
enabled. 
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Figure 7 - Select Tasks to be Mined for Data (Identified in Figure 1). 

 
3.  Click Next >. 
 
Step 6 - Rename Selected Tasks 
 
The tab that appears lists, by <DataSet Name> <ETD Name> Task Name, all Tasks marked 
for data mining. This dialog allows the Tasks to be assigned new names. This is strictly op-
tional. However, as show in Figure 8, many Tasks may have the same name, especially if 
they executed in a Branch Loop.  
 

1.  In the list box, select the Task to be renamed. Its current name will appear in New 
Task Name. 

 
2.  Type the new name in New Task Name. The name will be simultaneously updated in the 

list box. Note that, if your target DataSet is very old, you should keep the Task Name to a 
maximum of 30 characters. Otherwise the limit is 60 character. 
 

3.  Repeat for all appropriate Tasks. 
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Figure 8 - Rename Tasks. 

 
4.  Click Next >. 
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Step 7 - Add a Filter Task  
 
The tab will display a list of Filter Tasks that pertain to the selected Tasks type. No selection 
will be made in the list. No Filter need be associated with the Tasks, but a selection must be 
made in the list. If no Filter is to be associated, Select "<<None>>". 
 
1.  Select "Hysteresis Filter". 
 
2.  Click Select a Filter. Next > is enabled. 
 

 
Figure 9 - Select the Hysteresis Filter. 

 
3.  Click Next >. 
 
Step 8 - Assign an ETD Name.  
 
This tab displays a simple text box. It is used to assign the Executed Test Definition (ETD) 
name. This is the name that the "experiment" will appear under in the target DataSet Archive. 
 
1.  In Enter an Executed Test Definition (ETD) Name type "Hysteresis Data Mining Demon-

stration". As soon as characters appear in the text box Finish will be enabled. Note that if 
your target DataSet is very old this text string is limited to 28 characters. Otherwise the 
limit is 58 characters. 
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Figure 10 - Name the ETD. 

 
2.  Click Finish.  
 
Step 9 - Configure and Add the Hysteresis Filter Task.  
 
The Hysteresis Filter Task configuration dialog will appear. The Filter must be configured to 
be included with the data in the data-mined ETD. At a minimum, the Filter to be applied and 
the Tasks to filter must be selected and registered.  
 
1.  Configure the Task as follows: 
 

Hysteresis Filter Task Name: "Data-Mined Hysteresis Data" 
Filter: "Centering" (or Other as Desired) 
Task Selector: Select all Tasks in the List. 
Add Task: Click after Selecting Tasks in Task Selector. 
Comments: As Appropriate 
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Figure 11 - Configure the Hysteresis Filter Task. 

 
2.  Click the "Plot Setup" tab. 
 
3.  Configure the Task as follows: 
 

Plot These Data: Checked 
X-Axis Plot Options: Plot Volts (or Other as Desired) 
Labels: As Appropriate 
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Figure 12 - Configure the Hysteresis Filter Task Plot. 

 
4.  Click OK. A number of things will happen: 
 

•  The Hysteresis Filter dialog will close. 
•  The Filtered data plot will appear. 
•  Any DataSets that were originally closed will close. 

•  The Target DataSet will be updated with the mined Hysteresis Data and the Hystere-
sis Filter Task in an ETD in the DataSet Archive. Note that the ETD will have a spe-
cial  icon. 
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Figure 13 - Mined Data in the DataSet Archive. Hysteresis Filter 

Data Plot. 
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B - ETD Transfer 
 
B.1 - Discussion 
ETD Transfer is a similar process to Data Mining. In this case, any number of complete ETDs 
are transferred, without regard for the Task types contained in them, from any number of source 
DataSets to the single target DataSet. 
 
This tool is in its beta release. It is available to all Vision users. However it is not completely de-
veloped. There is a significant issue with the tool in its current state as discussed at the end of 
this tutorial. 
 
B.2 - Operation 
 

Step 1 - Initiate ETD Transfer 
 

1.  Identify the source DataSet and ETD(s) to transfer. 
 
2.  Select "DataSet->ETD Transfer" or click the ETD XFR button on the toolbar. 

 

 
Figure 1 - Initiate ETD Transfer. 

 
3.  The first ETD Transfer Wizard tab appears. The tab presents some discussion of 
the transfer process. Click Next >. 
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Figure 2 - First  ETD Transfer Wizard Tab. Process Information. 

 
Step 2 - Select Target DataSet  
 
This step is identical to the target DataSet selection in Data Mining. Once again, this tutorial 
will create a new DataSet. 
 

 
Figure 3 - Target DataSet Selection Tab. 
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1.  Click New DataSet to open the New DataSet Dialog. 

 
2.  Configure the DataSet as follows: 

 
DataSet Name:  Tutorial #11b - ETD Transfer 
DataSet Path: c:\datasets\tutorials\tutorial #11b - etd transfer.dst 
Experimenter Initials: As appropriate 
Comments: As appropriate - optional - not recommended 

 

 
Figure 4 - New Target DataSet. 

 
3.  Click OK to create and open the target DataSet. Next > is enabled. Select Target DataSet 

is disabled. The created DataSet is identified as the selected DataSet. Click Next >. (The 
selected DataSet may still be changed in the list box. If it is changed Select Target Da-
taSet is enabled and Next > is disabled. Clicking Select Target DataSet disables Select 
Target DataSet and enables Next >.)  

 
Step 3 - Select the Source DataSet(s) 
 
The next wizard tab again lists all DataSets registered to Vision. It is used to select the Da-
taSets from which to mine data. 
 
1.  Select "Tutorial #1b" and "Tutorial #3b". 

 
2.  Click Select Source DataSets. Next > will be enabled. Click Next >. "Tutorial #1b" and 

"Tutorial #3b" will open if they were not already open. This may take some time depend-
ing on the size of the DataSets. (Sequence 1. and 2. may be repeated to change the selec-
tion before clicking Next >.)  
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Figure 5 - Select Source DataSet. 

 
3.  Any selected DataSet that is not opened will be opened. The selected DataSets will be 

searched for all Measurement and Filter Task types that can be mined. This may take 
some time and delay switching to the next wizard tab. 

 
Step 4 - Select ETDs to Transfer 
 
The final wizard tab shows a tree structure with the selected DataSet. Under the DataSet are 
all archived ETDs. All ETDs can be selected for transfer by checking the DataSet box. Oth-
erwise a subset of the available ETDs can be individually selected by checking their boxes. 
 
1.  Checked the desired DataSets and/or ETDs. 

 
2.  Click Select ETDs. Finish will be enabled. 
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Figure 6 - Select the ETDs to Transfer. 

 
3.  Click Finish. The selected ETDs will be transferred to the target DataSet with the issues 

noted below. 
 

B.3 - Beta Release Issues. 
 
There are two primary issues with the ETD Transfer. Neither prevents the tool from being used 
effectively: 
 

•  Only one ETD is transferred in this process, even though multiple ETDs in multiple Da-
taSets may be selected. This is minor since it can be remedied by repeated operations. 
This may be the situation for the foreseeable future. 
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Figure 7 - Only Single ETDs Transfer. 
 
•  If the ETD includes Tasks iterated in a Branch Loop, the "Experiment Design" will have 

copies of all executions of the Tasks. For example, if the original Test Definition design 
included a Hysteresis Task and a Branch Task and the archived Hysteresis executed over 
six iterations, the source ETD "Experiment Data" folder will have six copies of the Hys-
teresis-Branch sequence, but the "Experiment Design" folder will contain only one such 
sequence. However, the target "Experiment Design" folder will have all six sequences.  If 
the transferred ETD Test Definition is moved back into the Editor, the Editor Test Defini-
tion will have all six sequences. Tasks would then need to be removed to return the ex-
periment to the original design. 
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Figure 8 - Multiple Branch Loop Sequences Transferred to Target 

"Experiment Design". 
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This problem will be addressed before the "beta" designation is removed from the tool. 
However, it is only apparent in Test Definitions that include a Branch Loop and there is a 
remedy. Since this is a difficult problem, this tool may remain in beta release for quite 
some time. 
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C - Simple Measure 
 
C.1 - Discussion  
 
The Simple Measure allows basic low-voltage Hysteresis measurements to be quickly config-
ured, executed and stored, as a Task, to an Executed Test Definition (ETD) in a DataSet. The 
configuration and execution are independent of any other Tasks in Vision, so the process can be 
initiated immediately without accessing a Task in QuikLook or configuring a Test Definition in 
the Editor. 
 
Any number of Hysteresis measurements may be made and stored to the DataSet. Configuration 
parameters may be changed and new measurements may be appended to existing data. Or data 
may be cleared between measurements. The user has a limited number of parameters to config-
ure, including: 
 

•  Task Name: (60 characters maximum). Since the Simple Measure data are stored to the 
DataSet as a Task, a standard Task Name must be provided under which the data will be 
stored. 

•  Volts: (±500.0) The voltage to be applied to the sample during the Hysteresis measure-
ment. This is limited to the capability of the tester's internal amplifier and depends on the 
model purchase. Limits of ±10.0 Volts, ±30.0 Volts, ±100.0 Volts, ±200.0 Volts or 
±500.0 Volts may apply. 

•  Period (ms): (0.0002 to 30,000.0 ms) The duration, in milliseconds, of the Hysteresis 
measurement. This is equivalent to 1000.0 / Frequency (Hz). The actual limits will de-
pend on the tester model being used. 

•  Area (cm2): (Strictly greater than 0.0) This is the area (cm2) of the smallest sample elec-
trode connected to the Precision tester DRIVE or RETURN port. (Note that, if the elec-
trodes are not the same area, DRIVE is normally connected to the larger electrode. For 
example, if an array of capacitors on a wafer have a common bottom electrode, DRIVE 
should be connected to the bottom electrode. Theoretical discussion of the reasons for the 
are beyond the scope of this document.) The tester captures charge that is moving onto or 
off of the sample RETURN electrode as the result of the application of the DRIVE volt-
age. However, Vision reports the data in units of Polarization. Polarization is given as 
Charge (µC)/Area (cm2). Area (cm2) must be correctly entered to produce accurate data. 

•  Thickness (µm): (Strictly greater than 0.0) This is the third dimension in the sample ge-
ometry. It is the distance through the ferroelectric material, between sample electrodes. 
This value is recorded simply for complete documentation of the measurement. 

•  Preset: As in a standard Hysteresis Task, with this option checked an unmeasured 
DRIVE profile voltage will be applied to the sample. This is to preset the sample into a 
polarization state opposite the state that will be switched by the application of Volts. This 
ensures that the polarization is switching throughout the bipolar measurement. With this 
option unchecked, the polarization behavior of the first half of the measurement will de-
pend on the state of the sample before the Simple Measure process is initiated. When this 
control is checked, Preset Delay (ms) will be enabled. 

•  Preset Delay (ms): when Preset is checked, this control is used to specify the delay be-
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tween the application of the unmeasured Preset DRIVE voltage waveform and the meas-
urement waveform. Sufficient delay should be applied to allow any charge movement in 
the sample that results from the preset waveform to settle so that the measurement begins 
in a quiescent state. 

 
To maintain simplicity, a large number of options available to the standard Hysteresis measure-
ment are predetermined for the Simple Measure process and are not under user control. Some of 
the more important options that are fixed include: 
 

•  DRIVE profile is standard bipolar triangular. 
•  High-voltage measurements are not available. 
•  Auto Amp and User Last Amp Value are enabled. 
•  Internal reference elements are not available. 

 

C2 - Operation  
 

Step 1 - Connect a Sample Between the Tester's DRIVE and RETURN Port 
 
The figures in this example will use an RTI Type A/B White ferroelectric capacitor. This is a 
0.0001 cm2 4/20 undoped PZT sample.  
 
Step 2 - Initiate Simple Measure  
 

1.  Select "DataSet->Simple Measurement" or click the  icon on the Vision 
toolbar. 

 
2.  The "Select Target DataSet" dialog appears. 
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Figure 1 - Initiate Simple Measure. 

 
Step 3 - Select the Target DataSet  
 
As with Data Mining and ETD Transfer, a DataSet that will collect the Simple Measure data 
must be selected. As with those tools, a new DataSet may be created from within the dialog. 
Otherwise an existing DataSet may be selected and opened. In this tutorial a new DataSet 
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will be created. 
 
1.  Click New DataSet. The New DataSet dialog appears. 
 
2.  Configure the Dataset as follows: 
 

DataSet Name: "Tutorial #11c - Simple Measure" 
DataSet Path: "c:\datasets\tutorials\tutorial #11c - simple measure" 
Initials: As Appropriate (Required) 
Comments: As Appropriate (Optional - Not Recommended) 

 

 
Figure 2 -  Create the Simple Measure DataSet. 

 
3.  Click OK to create and open the DataSet. 

 
4.  Click Select Target DataSet to register the selection. 

 
5.  Click OK. The Target DataSet Selection dialog closes and the Simple Measure 
Control dialog opens. 
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Figure 3 -  Select the Simple Measure DataSet and Close the Selec-

tion Dialog. 
 
Step 4 - Configure the First Measurement  
 
1.  Click Configure to open the measurement configuration dialog. 
 
2.  Configure the measurement as follows (or as you prefer): 
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Task Name: 4.0-Volt/10.0 ms Simple Measurement 
Volts: 4.0 
Period (ms): 10.0 
Preset: Checked 

Preset Delay: 1000.0 (in milliseconds) 
Area (cm2): 0.0001 

Thickness (µm): 0.3 
 

3.  Click OK to close the configuration dialog. Measure will be enabled on the Sim-
ple Measure Control dialog. 
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Figure 4 -  Configure the First (4.0-Volt) Measurement. 
 
Step 5 - Make the 4.0-Volt Measurement.  
 

1.  Click Measure to open the Measurement dialog. 
 

2.  Click Measure to make the measurement. The data are plotted in the main dialog 
window. Configuration and derived Single-Point values are displayed in the list boxes. 

 
3.  Click Measure again to repeat the measurement. Existing measurement data may 
be cleared by clicking Clear Data. 
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Figure 5 -  4.0-Volt/10.0 ms Measurement - Repeated. 

 
Step 6 - Close the Dialog to Store Data and Return to the Simple Measure Control dia-
log. 
 
1.  Click OK to close the dialog. 
 
2.  The Rename CTD dialog appears. Name the CTD "4.0-Volt/10.0 ms Simple Measure".    
 
3.  Click OK to close the Rename CTD dialog. The DataSet is updated with the 4.0-Volt 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 514 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

measurement in the CTD and in the DataSet Archive. The Simple Measure Control dia-
log appears. Clear Data is enabled. 

 

 
Figure 6 -  Store Data and Return to Idle. 

 
Step 7 - Configure the Second (5.0-Volt) Measurement  
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1.  Click Configure to open the measurement configuration dialog. 
 
2.  Configure the measurement as follows (or as you prefer): 
 

Task Name: 5.0-Volt/10.0 ms Simple Measurement 
Volts: 5.0 
Period (ms): 10.0 
Preset: Checked 
Preset Delay: 1000.0 (in milliseconds) 
Area (cm2): 0.0001 
Thickness (µm): 0.3 

 
3.  Click OK to close the configuration dialog.  
 

 
Figure 7 -  Configure the Second (5.0-Volt) Measurement. 
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Step 7 - Make the 5.0-Volt Measurement.  
 

1.  Click Measure to open the Measurement dialog. The dialog will appear as in Fig-
ure 6. 

 
2.  Click Measure to make the measurement. The data are again plotted in the main dialog 

window. Configuration and derived Single-Point values are appended to values in the list 
boxes. 

 
3.  Click Measure again to repeat the measurement. Existing measurement data may 
be cleared by clicking Clear Data. 

 

 
Figure 8 -  5.0-Volt Measurement. 

 
Step 8 - Close the Dialog to Store Data and Return to the Simple Measure Control dia-
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log. 
 
1.  Click OK to close the dialog. 
 
2.  Name the CTD "4.0-Volt & 5.0-Volt/10.0 ms Simple Measure".    
 
3.  Click OK to close the Rename CTD dialog. The DataSet is updated with the 4.0-Volt and 

5.0-Volt measurements in the CTD and in the DataSet Archive.  
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Figure 9 -  Stored 4.0-Volt and 5.0-Volt Data - Idle State. 

 
Step 9 - Repeat the Configure/Measure/Store Procedure to 9.0-Volts (or as Desired)  
 
You can also clear all data in either the Simple Measure Control dialog or in the Measure-
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ment Dialog at any time. 
 

 
Figure 10 -  4.0-Volt through 9.0-Volt Data. 

 
Step 10 - Review the Data  
 
1.  Click OK to close the Measurement dialog if it is still open. 
 
2.  Assign a CTD Name and save the data if necessary. 
 
3.  Click Done to close the Simple Measure Control dialog. 
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4.  Open the DataSet Archive. 
 
5.  Select an ETD and open it. 
 
6.  Open the "Experiment Data" Folder. 
 
7.  Double-click the stored Simple Measure Task. 
 
8.  The archived data reappear in the Measurement dialog.  
 

 
Figure 11 -  Recover the Archived Simple Measure Data. 

 
Step 11 - Export the Data. 
 
Note that Vision tools to export the data are not available. The export tool from the data plot-
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ting library must be used to export the data. 
 
1.  Right-click on the plotted data and select "Export Dialog..." from the popup menu. 
 

 
Figure 12 -  Initiate the Export Dialog. 

 
2.  In the Dialog that appears, select Text/Data and File, then click Browse. 
 
3.  Navigate to an appropriate output file location and assign an appropriate *.txt file name. 
 
4.  Click Save. The file path and file name will appear in the export configuration dialog. 
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Figure 13 -  Configure the Export. 

 
5.  Click Export to open the second export dialog. 
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6.  Check the following: Select Subsets and Points::All Data, Export What::Data and Labels, 
Export Style::List, Delimited::Tab and Numeric Precision::Maximum Precision. 
 

 
Figure 14 -  Configure the Export Details. 

 
7.  Click Export. 
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8.  Using a Windows Explorer, navigate to the exported file and double-click to open 
for review. 

 

 
Figure 15 -  Review the Exported File. 

 
9.  Right-click on the plotted data and select "Export Dialog..." from the popup menu. 
 
10.  In the Dialog that appears, select Text/Data and ClipBoard. 
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Figure 16 -  Configure Clipboard Export. 

 
11.  Click Export. Configure the second dialog as in Figure 14. 
 
12.  Click Export. 
 
13.  Open a Microsoft Word© document and paste the data. 
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Figure 17 -  Simple Measure Data Exported to Microsoft Word©. 
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XII - Editor Aide 
 
Discussion  
 
The single largest drawback in Vision is that the Editor is not a completely general tool for in-
serting and removing Tasks. This is because of the complex dependencies between Branch and 
Filter Tasks and their targets. Here are the things that can be done in the Editor: 
 

•  Clear the Editor of all Tasks. 
•  Append a Task or series of Tasks to existing Tasks in the Editor. 
•  Remove the last Task from the Editor.  

•  Prepend a Task or series of Tasks to the top of the Test Definition Task list in the Editor. 
This is done by copying the existing Test Definition to a temporary location (DataSet 
CTD or Customized Test), writing the Task(s) to be prepended to the Editor and then re-
storing the original list of Tasks from the temporary location. 

 
Here are examples of things that cannot be done in the Editor: 
 

•  Remove any Tasks from the interior of the Test Definition in the Editor. Only the 
last Task may be removed. This may be done repeatedly to remove a series of Tasks, but 
a Task cannot be removed that is not the last (bottom-most) Task. Tasks may be disabled 
by checking No Execute. This is functionally equivalent to removing them from the Test 
Definition. 
•  Insert any Task into the interior of the Test Definition. Tasks may only be ap-
pended or prepended. Tasks are prepended by copying the existing Test Definition to a 
temporary location (DataSet CTD or Customized Test), writing the Task(s) to be pre-
pended to the Editor and then restoring the original list of Tasks from the temporary loca-
tion. 
•  Move a Task's position in the Test Definition up or down. 

 
For example, in Step 4 of Tutorial III.B you added an Automatic Branch Abort Task to an exist-
ing Test Definition. The Automatic Branch Abort Task must be inserted before the Branch Task. 
To do this you had to remove the Branch Task, insert the Automatic Branch Abort Task and then 
reinsert the Branch Task. A completely general Editor would allow the Automatic Branch Abort 
Task to be inserted without removing the Branch Task. 
 
The Editor Aide tool is provided as a method for making the process of modifying complex Test 
Definitions simpler. The tools can be used to build complete Test Definitions from scratch. It can 
also move the Test Definition from the Editor into the Test Definition under construction in the 
tool. Tasks can only be appended to the end of the Test Definition under development, but then 
may be easily moved up or down in the list. Any Task may be immediately removed from the 
list. The Test Definition in the Editor may be completely cleared of Tasks from without the Edi-
tor Aide tool. Whether or not the Editor is cleared of Tasks, all Tasks in the Editor Aide list can 
be moved to the Editor, appending them to any existing Tasks. 
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This solution is still not completely general. Tasks are not actually constructed in the Editor Aide 
and dependencies between Tasks are not established. As Tasks are moved from the Editor Aide 
to the Editor, they must be configured. A few general parameters including Task Name, Max. 
Voltage, Sample Area (cm2), Sample Thickness (µm) and Comments can be assigned in the Edi-
tor Aide tool.  
 
This tutorial will work with the Tutorial VIII.A Nesting Branch Loop tutorial Test Definition. 
This tutorial will perform several basic operations. For a complete details discussion, see the Edi-
tor List Dialog Instructions. 
 
Operation 
 

Step 1 - Ensure the Proper Test Definition is in the Editor  
 

1.  Close any open DataSets 
 

2.  Press <Ctrl-A> to remove all Tasks, if any, from the Editor. 
 

3.  In the DataSet Explorer, double-click the datasets->tutorials->Tutorial #8a - Nest-
ing Branch explorer tree entry to open the DataSet. 

 

 
Figure 1 - Open the Original DataSet. 

 
4.  Open the DataSet Archive 
 
5.  Right-Click on the "General Nesting Branch:0 ETD and select "ETD to Editor" on the 
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popup menu. The original Nesting Branch Loop Test Definition will appear in the Editor. 
The reason this tutorial uses that Test Definition is that it is complex and shows the Editor 
List to its best advantage. 

 

 
Figure 2 - Recover the Archived Test Definition. 

 
Step 2 - Initiate the Editor Aide Tool  
 
1.  Right-click in the Editor Window and select "Editor Aide" from the popup menu. The 
Editor Aide dialog will open. 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 530 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 

 
Figure 3 - Launch the Editor Aide Tool. 

 
Step 3 - Insert a General Information Task.  
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1.  In the Program Control Tasks list box select "General Information". 
 
2.  Click Add Selected Task to Editor List. The General Information Task is added as the first 
Task in Editor List. 
 

 
Figure 4 - Insert General Information Task. 

 
3.  With the General Information Task selected in Task List, click in Task Name and type 

"Nesting Branch Loop Discussion". Comments could also be edited here. However, the 
Task will be configured when it is sent to the Editor. The General Information Task 
Comments field in the Task configuration dialog is much larger than the field, here, and, 
so, easier to work with. 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 532 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 

 
Figure 5 - Assign the General Information Task Task Name. 

 
Step 4 - Move the Editor Test Definition into the Editor Aide.  
 
1.  Click Load Editor Tasks to Editor List. The Tasks in the Editor Test Definition will be 
copied to, and identified by Task type in, Editor List. 
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Figure 6 - Copy the Editor Test Definition to Editor List. 

 
2.  Select the first "Hysteresis" Task in Editor List. Note that Task Name, Max Voltage, 
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Sample Area (cm2), Sample Thickness (µm) and Comments are preserved from the con-
figuration in the Editor.  Any of these parameters can be adjusted, for the selected Task, 
in the Editor Aide tool. For example, changing Max. Voltage to 4.0 would change the ini-
tial parameter to 4.0 Volts for this Task only. Parameters that are not set in the Editor 
Aide will be set when the Test Definition in Editor List is moved into the Editor window. 

 
 

 
Figure 7 - Copied Tasks Maintain Basic Parameter Configuration. 

 
Step 5 - Insert an Automatic Branch Abort Task before the First Branch Task.  
 
There is no real need for an Automatic Branch Abort Task in this Test Definition. However, 
it is included, here, for the purpose of illustration. 
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1.  Select "Auto Branch Abort" Program Control Tasks. 
 

2.  Click Add Selected Task to Editor List to put the Auto Branch Abort Task at the 
bottom of the Editor List. 

 
3.  Click the "Auto Branch Abort" Task in Editor List and set Task Name to "Ensure 
No More than Ten Loops". 

 
4.  Set Comments to "Tutorial #12 - Abort the first Branch Task if "Loop Counter" = 
'10'.". 

 
5.  Click  repeatedly until "Auto Branch Abort" is above the first instance of 
"Branch" in Editor List. 
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Figure 8 - Insert and Auto Branch Abort Task. 

 
Step 7 - Remove the Second Hysteresis Task  
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Every aspect of the original Nesting Branch Test Definition configuration was important in 
demonstrating the various aspects of Nesting Branching. For the purpose of the Editor Aide 
tool, the actual composition of the Test Definition in Editor List is less important. This step 
removes one of the Hysteresis measurements. 
 
1.  Select the second "Hysteresis" in Editor List. 
 
2.  Click Delete Selected. The "Hysteresis" entry will be removed from the Editor List con-
trol. 
 

 
Figure 9 - Remove the Second Hysteresis Task from Editor List. 
 
Step 8 - Save the Test Definition to a File  
 
The Test Definition, as currently configured, with the Editor List sequence and preserved 
Task Names Max Voltage, Sample Area (cm2), Sample Thickness (µm) and Comments, can 
be saved to a file with a *.elx extension. The file can then be read to reload the Editor List at 
any time. 
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1.  Click Browse to File. 
 

2.  In the standard Windows File browser dialog that appears, navigate to an appro-
priate location and assign an appropriate file name. 

 
3.  Click Save. The Windows browser will close and the file path and file name will appear 

in the unlabeled test box under Browse to File. Since the file specified in the unlabeled 
text box does not exist, Save Editor List to File is enabled and Load Editor List From File 
is disabled. 

 
4.  Click Save Editor List to File. The file will be written. Since the file specified in the un-

labeled text box now exists, Save Editor List to File is disabled and Load Editor List 
From File is enabled. 

 

 
Figure 10 - Save the Test Definition to a File. 

 
Step 9 - Load the Test Definition from a File  
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1.  Click Browse to File. 
 

2.  In the standard Windows File Explorer that opens, navigate to and select an existing *.elx 
file. 
 

3.  Click Save. The file path and file name will appear in the unlabeled text box. Save Editor 
List to File will be disabled because the file exists. Load Editor List From File will be 
enabled for the same reason. These first three steps are not strictly necessary, since the 
file is already identified in the unlabeled text box. 
 

4.  Click Load Editor List From File. The file will be opened, read and closed. The Test Def-
inition in the file will be appended to any Tasks already listed in Editor List. Preconfig-
ured parameters are preserved. 
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Figure 11 - Recover a Test Definition from a File. 

 
Step 10 - Clear Editor List and Reload from the File  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 541 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

 
1.  Click Clear All to remove all Tasks from the Editor List control. Clear All, Delete Select-

ed and Save Editor List to File are all disabled. (Note that there are some inconsistencies 
in the Editor Aide tools. Most are evident here. Although there are no Tasks in Editor 
List, Move Editor List to Editor is still enabled. Also Comments remains enabled and all 
preconfiguration controls - Task Name, Comments, etc - continue to show the values of 
the last-selected Task. All of these are minor issues that will be corrected in future releas-
es - perhaps the release that  you are currently working with.) 
 

2.  Since the Test Definition file exists and is already selected, click Load Editor List From 
File to reload the Test Definition. 
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Figure 12 - Clear Editor List and Reload the Test Definition from the 

File. 
 
Step 11 - Clear the Editor Window and Move the Editor List Test Definition to the Edi-

tor  
 
If the Test Definition configured in the Editor Aide Tool were transferred into the Editor 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 543 

Copyright Radiant Technologies, Inc. 2020 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-
sa/2.5/ 

window, it would be appended to the Tasks already in the Editor Window. For this demon-
stration, that is not the purpose of the process. The intent is to replace the Test Definition in 
the Editor. Therefore, the Editor must first be cleared of all Tasks. 
 
1.  Click Remove Last Editor Task. The "Multi-Volt Hysteresis Nesting Loop" Task will be 

removed from the Test Definition in the Editor window. This step is provided only to 
demonstrate the tool. The next step will remove all Tasks from the Editor window, mak-
ing this step unnecessary. 
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Figure 13 - Remove the Last Task from the Editor Test Definition. 

 
2.  Click Clear Editor. All Tasks will be removed from the Editor window. Clear Editor and 
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Remove Last Editor Task will be disabled. 
 

 
Figure 14 - Remove the Last Task from the Editor Test Definition. 

 
3.  Click Move Editor List to Editor. Each Task will be moved, in order and one-by-one, into 

the Editor. As each Task is moved, it will open its configuration dialog. Each Task must 
be individually configured. Once in the Editor and with the Editor Aide closed, Tasks 
may be reopened to validate and correct configuration per usual. Note that, because of the 
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persistence of parameters, many Tasks will be preconfigured, or mostly preconfigured, 
making the configuration process simpler. However, This same persistence will make 
some Tasks incorrectly preconfigured so that care must be taken to ensure that all Tasks 
are properly configured. 

 

 
Figure 15 - Move the Editor List into the Editor. 
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